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Amplifier Test Application

About the Application
About the Application

The Amplifier Test applications for the 86140-series optical spectrum analyzers 
allow quick, accurate characterization of optical amplifiers with a minimum of 
user inputs. All specifications and characteristics are derived from the 86140-
series specifications.

The applications measure the channel wavelengths, source power, gain, and 
noise figure of an amplifier using Interpolation Source Subtraction (ISS) or 
Time Domain Extinction (TDE) methods.

The ISS method is composed of one sweep to measure source signal 
wavelength, power, and spontaneous emission, and a second set of sweeps to 
measure the amplifier signal power and amplified spontaneous emission. 
These measured parameters are used to calculate the gain and noise figure for 
the amplifier. This method is suitable for all amplifier types.

The application calculates the following data and displays the results in the 
display table:
• Channel wavelength
• Source Power
• Gain
• Noise figure
• Source mean wavelength
• Sum of source signal power
• Amplifier mean wavelength
• Sum of amplifier signal power

The Time Domain Extinction (TDE) method, available only on the 86146B, 
measures the same parameters but uses time-domain extinction technique. It 
requires that laser sources to be synchronously modulated. This method is 
suitable only for amplifier types with slow time dynamics, for example, erbium-
doped devices.
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Amplifier Test Application

About the Application
The Amplifier Test Application Menus
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Amplifier Test Application

Performing Measurements
Performing Measurements

This section explains how to start and use the Amplifier Test applications. The 
applications measure the channel wavelengths, source power, gain, and noise 
figure of an amplifier using Interpolation Source Subtraction (ISS) and Time 
Domain Extinction (TDE) methods.

Starting the Amplifier Test Application

1 Press the front-panel APPL’S key or, on the Applications menu, select Launch an 
Installed Application.

The following screen is displayed:
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Amplifier Test Application

Performing Measurements
Applications Panel and Menu 

The panel and the menu change whenever an application is installed or un-
installed. Each installed application has an icon on the panel and a 
corresponding softkey. 

2 Press AMPLIFIER TEST to bring up a second menu with a choice of amplifier tests.
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Amplifier Test Application

Performing Measurements
Amplifier Test Menu

3 Select either INTERPOLATION (ISS) TEST OR TIME DOMAIN EXTINCTION TEST (TDE). 

Note: Time Domain Extinction Test is available only on the 86146B.

When the test is launched, the corresponding test menu is displayed.
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Amplifier Test Application

Performing Measurements
Status Panel

The status panel is always visible at the top of the screen when the application 
is running and consists of two lines of information. The top line contains the 
current Device ID on the left and the current date and time on the right. The 
second line contains a user-entered comment on the left and the measurement 
status on the right. Note that Optimal Delay Search is available only in the TDE 
measurement mode for the 86146B.

The above example indicates the application status is “Idle”.
1-7



Amplifier Test Application

Performing Measurements
Setting Up a Measurement

The Measurement Setup dialog box allows you to define the parameters for the 
measurement.

Amplifier Test Measurement Setup 

The MEASUREMENT SETUP... softkey is enabled whenever the system is not 
actively measuring. Selecting this key opens the Measurement Setup dialog 
box.
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Amplifier Test Application

Performing Measurements
Navigating the Measurement Setup Window

The softkeys allow you to navigate through the measurement setup dialog box.

The arrow softkeys allow you to navigate from field to field in the dialog box. 
The highlighted parameter can be changed.

Select selects the highlighted parameter.

Defaults resets the parameters to their default condition.

Close Panel... saves the current setup and returns you to the previous menu.

The front-panel number keys, step keys, and knob on the OSA allow you to 
enter a numeric value in the highlighted field. 
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Amplifier Test Application

Performing Measurements
Measurement setup parameters

Under manual operation, all measurement parameters are set to default by 
pressing the DEFAULTS softkey. Otherwise, they retain the previous setting from 
the last time the application was started. These settings are retained when 
PRESET is pressed. Values are entered from the keypad or incremented using 
the knob or step keys.

Start Wavelength

Default: 1530 nm

Sets the start wavelength for the measurement span. Units are fixed in nm.

Stop Wavelength

Default: 1570 nm

Sets the stop wavelength for the measurement span. Units are fixed in nm.

Wavelength Units

Default: nm

Selects the wavelength units, either nm or THz. These units are used in the 
Display Table only.

Peak Excursion

Default: 10 dB

Sets the peak excursion value in dB. This is the amount of amplitude the trace 
must rise and fall to be considered a peak. Lower values lead to more signals 
being discerned, but if peak excursion is set too low, peaks in the noise floor 
may be discerned as signals. If peak excursion is set too high, legitimate peaks 
may not be discerned as signals.

Peak Threshold

Default: -55 dBm
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Amplifier Test Application

Performing Measurements
Sets the peak threshold value in dBm. Power levels below this threshold are 
not considered for peak search.

Interpolation Offset

Default: Auto

The offset can be entered manually, or calculated automatically. Auto mode, 
uses (0.5×RBW+0.5nm)for the offset. Either Interpolation Method (that is, 
Linear or Quadratic) can be used.

Interpolation Method

Default: Linear

Linear sets the noise marker ‘noise offset’ interval to the left and right of the 
channel when making a noise power measurement. The noise power at the 
channel wavelength is the interpolation value of the noise markers to the left 
and right of the channel. The offset can be entered manually, or calculated 
automatically using (0.5×RBW+0.5nm). 

The system measures half the distance between channels and compares this 
amount to the entered offset. If the half distance figure is closer to the channel, 
the system will override the manually entered offset value with the half 
distance value. This prevents adjacent channels from interfering with noise 
measurements. 

Quadratic uses four measured points. Two points are used on each side of the 
channel to interpolate the noise floor at channel wavelength. The user 
specifies the offset value for the two measured points closest to the channel 
wavelength. The offsets for the outer two points are determined internally by 
the application.

Resolution Bandwidth

Default: 0.2 nm

Sets the resolution bandwidth value to be used during peak sweep. This 
determines the analyzer’s ability to display two closely spaced signals as two 
distinct responses. Decreasing the resolution bandwidth provides a more 
detailed sweep but increases the scan time. 
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Amplifier Test Application

Performing Measurements
The resolution bandwidth can be set to one of the following values: 

• For 86140B Option 025, 86143B option 025, 86141B: 
0.07 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86140B, 86142B, 86143B, 86145B: 
0.06 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86144B, 86146B internal path: 
0.06 nm, 0.07 nm, 0.1 nm, 0.14 nm, 0.2 nm, 0.33 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86144B, 86146B external path: 
0.04 nm, 0.05 nm, 0.07 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

Video Bandwidth

Default: 100 Hz

Reduces noise and thus improves measurement repeatability. However, the 
measurement time increases as the video bandwidth setting is decreased.

For the source and amplifier initial sweeps, the video bandwidth is fixed at 
3 kHz. The default for source and amplifier noise and peak sweeps is 100 Hz. 
The allowable input range is from 100 mHz to 3 kHz. 

Trace Averaging

Default: Off

Improves measurement repeatability by smoothing out the noise. For 
measurements involving slow polarization scrambling, trace averaging is 
generally faster than video averaging.

When trace averaging is on, the initial default average count is 5. The allowable 
input range is 1 to 1000 average counts.

ADC - Trigger Delay

Default: 10 ms.

Sets the trigger delay for the amplified spontaneous emission (ASE) 
measurement for TDE. The sources are square-wave modulated. The trigger 
delay should be set to 25% of the square-wave period plus 0.8 ms. The Optimal 
Delay Search function will automatically calculate trigger delay.
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Amplifier Test Application

Performing Measurements
Source Path Trace Offset

Default: 0.000 dB

Sets an offset to compensate for any losses caused by cables and connections 
in the source path.

Amplifier Path Trace Offset

Default: 0.000 dB

Sets an offset to compensate for any losses caused by cables and connections 
in the amplifier path.

Display Connection Prompts

Default: Yes

Displays equipment setup prompts when Measure Source or Measure 
Amplifier are selected.

Include Shot Noise

Default: No

Sets a flag to include or exclude the 1/Gain term in noise figure calculations. 

Continuous Amplifier Measurement

Default: Single

Allows you to select either single sweep measurement or continuous sweep 
measurement mode.
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Amplifier Test Application

Performing Measurements
Linear and Quadratic Interpolation

The setup panel and remote commands are provided for selecting the linear or 
quadratic interpolation and the corresponding offset. For the linear method, the 
offset is the distance of the two measured points from the channel wavelength. 
For the quadratic method (four measurement points are used), the offset refers 
to the two measured points closest to the channel wavelength. The offsets for 
the outer two points are determined internally by the application. 

To derive the value of amplified spontaneous emission (ASE) to calculate noise 
figure, interpolation around each signal is used. Linear interpolation is best 
when channel spacing is narrow. When channel spacing is wider, it is possible 
to measure ASE at two points on either side of each signal (that is, quadratic 
interpolation). The quadratic interpolation method will more accurately 
estimate the ASE at the channel wavelengths in the gain region with high 
curvature. 

For narrow channel spacing, an inner point in the quadratic (four points) set 
may become too close to an adjacent channel. The interpolation offset is 
clipped to half the distance between the adjacent channels. When an outer 
point in the 4-point set falls too close to an adjacent channel, the point is put 
on the far side of the adjacent channel.

For the two boundary channels (at the low and high end of the span), any 
shortage of data points on a boundary may cause the two points on the same 
side of a boundary channel to become too close to each other. The program 
automatically reverts to using a linear interpolation on a channel by channel 
basis.

Linear sets the noise marker ‘noise offset’ interval to the left and right of the 
channel when making a noise power measurement. The noise power at the 
channel wavelength is the interpolation value of the noise markers to the left 
and right of the channel. The offset can be entered manually, or calculated 
automatically using (0.5×RBW+0.5nm). 

The system measures half the distance between channels and compares this 
amount to the entered offset. If the half distance figure is closer to the channel, 
the system will override the manually entered offset value with the half 
distance value. This prevents adjacent channels from interfering with noise 
measurements. 
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Amplifier Test Application

Performing Measurements
Quadratic uses four measured points. Two points are used on each side of the 
channel to interpolate the noise floor at channel wavelength. The user 
specifies the offset value for the two measured points closest to the channel 
wavelength. The offsets for the outer two points are determined internally by 
the application.
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Amplifier Test Application

ISS Test
ISS Test

There are two possible equipment configurations. Figure 1 uses a patchcord to 
bypass the DUT for source calibraton while Figure 2 uses optical switches to 
bypass the DUT.

Figure 1 Patch cord used to bypass the DUT

Figure 2 Optical Switches to bypass the DUT
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Amplifier Test Application

ISS Test
Calibrating the Signal Path Offsets

To compensate for any losses caused by the cables and connections in the 
signal paths, it is necessary to determine the path offsets using a power meter, 
such as the 8163A lightwave multi-meter with an 81634A power sensor 
module.

The objective of measuring and calculating the offsets is to transfer the 
amplitude accuracy of the power meter to the application at it’s reference 
plane.

Refer to “Measuring the Source” on page 22 and to “Measuring the Amplifier” 
on page 1-24 for information on how to use the application to obtain source 
and amplifier path wavelength and power values. These values are used in 
calculating the path offsets.

To ensure accurate measurements, the system must be properly warmed up 
and calibrated. All OSA specifications apply when the instrument’s internal 
temperature has been stabilized after 1- hour of continuous operation, the auto 
align routine has been run.

N O T E As in all optical measurements, it is critical to follow good connector care practices. 
Always clean the connector interfaces before connecting. Refer to “Cleaning 
Connections for Accurate Measurements” in the optical spectrum analyzer user’s 
guide.

C A U T I O N Limit the power applied to the OSA to a maximum of +30 dBm total, +12 dBm 
per channel. To avoid exceeding the total safe input power, an attenuator should 
be installed at the OSA input. A 10 dB optical attenuator is available as option 
030 for your OSA. Following this calibration procedure insures that this 
attenuation value will be subtracted from the measurement.

To perform an Auto Align

Before entering the Amplifier Test application, connect a reference signal to 
the instrument, then press AUTO ALIGN. This starts an automatic alignment 
procedure that should be performed whenever the instrument has been moved, 
subjected to large temperature changes, or warmed up at the start of each day.
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Amplifier Test Application

ISS Test
To calculate offsets in a standard measurement setup

Figure 3 Reference Measurement

1 Connect the equipment as in Figure 3. Connect the source output and OSA input 
fibers at the reference plane.

2 Measure the source path using the OSA Amplifier Test application Measure Source 
function.

3 Without changing the setup, perform the Measure Amplifier function in the Amplifier 
Test application. This step is necessary to have the source data appear in the Display 
Table.

4 Record the source mean wavelength and sum of source signal power values from the 
Display Table.
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Amplifier Test Application

ISS Test
Figure 4 Power Meter Measurement

5 Connect the source to the power meter as in Figure 4. Set the power meter 
wavelength parameter to the source mean wavelength value.

6 Measure the power and record the value.

7 Calculate the difference between the power meter reading and the application 
reading using: 

Offset = Power Meter Reading – Application Sum of Source Signal Power.

8 Enter the calculated value into the Measurement Setup dialog box as Source Path 
Trace Offset and Amplifier Path Trace Offset. For a standard measurement setup, the 
offsets in the source and amplifier paths will be the same.

9 To verify the offset is correct, repeat Measure Source and Measure Amplifier. The 
source total power should read the same as measured by the power meter in Step 6. 
The gain should be 0.0 dB for each channel.

10 After measuring and verifying the path offsets, you can connect the amplifier under 
test as in Figure 1.
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Amplifier Test Application

ISS Test
To calculate offsets in a measurement setup with optical switches

More complex measurement setups can provide an alternative path for 
measuring the source. When this is the case, the offsets in the source and 
amplifier paths will be different. This second procedure accounts for these 
additional losses in a sample test configuration using switches.

Figure 5 Source Path Measurement

1 Connect the source output and receiver input fibers as shown in Figure 5. 

2 Set switches to the source path (S) positions.

3 Measure the source path with the Measure Source function. 

4 Without changing the setup, measure the source path with the Measure Amplifier 
function.

5 From the Display Table, record the Source Mean Wavelength and Sum of Source 
Signal Power.

6 Set the switches to the amplifier path (A) positions.

7 Measure the amplifier path with the Measure Amplifier function.

8 From the Display Table, record the Sum of Amplifier Signal Power.

9 Connect the power meter to the adapter at the reference plane as shown in Figure 5. 
Set the power meter wavelength parameter to the source mean wavelength value.
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Amplifier Test Application

ISS Test
10 Measure the power and record the value.

11 Calculate the difference between the power meter reading and the application 
source reading using: 

Offset = Power Meter Reading – Application Sum of Source Signal Power.

12 Enter the calculated value into the Measurement Setup dialog box as the Source 
Path Trace Offset.

13 Calculate the difference between the power meter reading and the application 
amplifier reading using: 

Offset = Power Meter Reading – Application Sum of Amplifier Signal Power.

14 Enter the calculated value into the Measurement Setup dialog box as the Amplifier 
Path Trace Offset.

15 To verify the offsets are correct, repeat Measure Source and Measure Amplifier. The 
source and amplifier total power should read the same as measured by the power 
meter in Step 10. The gain should be approximately 
0.0 dB for each channel.

Figure 6 Amplifier Measurement

16 After measuring and verifying the path offsets, you can connect the amplifier under 
test as in Figure 2.
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Amplifier Test Application

ISS Test
Measuring the Source

After the offsets are calculated as described in the previous section, you can 
proceed with the amplifier measurement. The first step of the two-step ISS 
method is a set of sweeps that measure signal wavelength, power, and 
spontaneous emission of the source. A second set of sweeps will measure the 
amplifier signal power and amplified spontaneous emission.

The Measure Source step must be repeated if there is any change in the 
measurement parameters or the source wavelength and power. Source data 
will be lost when exiting the application and must be remeasured.

Measuring the Source
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ISS Test
1 From the Interpolation ISS Test menu, select MEASURE SOURCE....

Note that the MEASURE AMPLIFIER... softkey is disabled until the source 
measurement is completed.

Source Measurement Prompts

2 The system prompts you to connect the source to the OSA. 

The display connection prompts can be turned off in the measurement setup 
dialog box, in which case MEASURE SOURCE... will immediately initiate the 
measurement.

3 Press CONTINUE to initiate the measurement. 

MEASURE SOURCE... is replaced with STOP SOURCE MEASUREMENT... while the 
measurement is in progress.

4 The progress of the measurement is noted on the status panel:

a An initial sweep is taken to set references, indicated by “Source Initial Sweep...”.

b A second sweep measures the peak of the signal, indicated by “Source Peak 
Sweep...”.
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ISS Test
c A third sweep measures the noise level, indicated by “Source Noise Sweep...”.

5 When the measurement is complete, the MEASURE AMPLIFIER... softkey is enabled. The 
progress status label reads “Idle”.

Measuring the Amplifier

In the second step of the two-step process the amplifier is connected between 
the source and the OSA. The system measures the peak and noise power for 
the wavelengths measured in Measuring the Source and creates/updates the 
Display Table.
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ISS Test
Amplifier Measurement Prompts

1 Press MEASURE AMPLIFIER... to begin the process.

2 The system prompts you to install the device to be tested. 

The display connection prompts can be turned off in the measurement setup 
dialog box, in which case MEASURE AMPLIFIER... will immediately initiate the 
measurement.

3 Press CONTINUE to initiate the measurement. 

The MEASURE SOURCE... softkey is disabled. MEASURE AMPLIFIER... is replaced 
with STOP AMP MEASUREMENT... while the measurement is in progress. 

4 The progress of the measurement is noted on the status panel:

a An initial sweep is taken to set references, indicated by “Amplifier Initial 
Sweep...”.

b A second sweep measures the peak of the signal, indicated by “Amplifier Peak 
Sweep...”.

c A third sweep measures the noise level, indicated by “Amplifier Noise Sweep...”.
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ISS Test
d After all the data is received, the application calculates the measurement results. 
The progress label reads “Calculating Results...”.

5 When the measurement is complete, the progress status label reads “Idle”. 

Amplifier Measurement Results

6 The measurement results will be displayed graphically. The points indicating the 
amplifier gain and noise figure are displayed relative to the dB scale on the right side 
of the graph. 
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ISS Test
N O T E If Continuous Amplifier Measurement mode is selected in the measurement setup 
dialog box, the measurement will continue to update the points on the display and in the 
Display Table at the end of each measurement.

Viewing the Display Table

The DISPLAY TABLE... softkey is enabled when an amplifier measurement is 
complete and valid data is available. The results are displayed in a table similar 
to the one shown below. The Page Up and Page Down keys display previous 
and next pages of data if available.

When in continuous sweep mode the Interpolation ISS Test application 
continues to sweep and update the tabular data at the end of each 
measurement. 
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ISS Test
At the end of the table, after all channels present have been measured, the 
table will display values of source mean wavelength, sum of source signal 
power, amplifier mean wavelength, and sum of amplifier signal power.

For a description of mathematical calculations refer to “Theory of Operation” 
on page 49.
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TDE Test
TDE Test

As with ISS, there are two possible equipment configurations as in Figure 1 
and Figure 2. The main difference is the trigger signal from the synchronously 
modulated source is required for the OSA. Figure 7 is the TDE setup for the 
patchcord configuration for source measurement.

Figure 7 TDE setup for the patchcord configuration

Setting up the Source Modulation

To use TDE, it is necessary to setup synchronous source modulation on the 
8166B lightwave multi-channel system and plug-in modules, or the 8164B 
lightwave measurement system and plug-in modules. Any of the plug-in 
modules including DFB lasers, tunable lasers, or compact tunables can be 
configured for synchronous square-wave modulation. The internal modulation 
source from one of the lasers is used to trigger all of the lasers from 
synchronous modulation.

The modulation frequency may be from 20 kHz to 200 kHz. The 81662A and 
81663A DFB modules may be modulated up to 100 kHz. A setting of 65 kHz is a 
good initial setting for most erbium-doped fiber amplifiers.
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TDE Test
For synchronized modulation of two or more laser modules in the same 
mainframe, the setup is as follows:

1 Choose the “master” laser and set as follows:

a Menu > Modulation Source > Internal

b Menu > Modulation frequency > desired value

c Menu > Output trigger mode > Modulation

2 Set all “slave” modules:

a Menu > Modulation Source > Backplane (DFB modules require firmware version 
4.0 or higher)

b Menu > Output trigger mode > disabled (important)

3 To pass the master trigger to the slaves, set up the mainframe through the Config 
button under the screen:

Config > Trigger > Feedback (or Loopback)

Note: The master laser must always be turned on, if one or more slaves are on. 
Otherwise, it causes an error due to the missing trigger.

If an additional mainframe is used, a BNC cable can connect its input trigger to 
the master mainframe. Then this mainframe’s trigger configuration should be 
left on default and all modules set to modulate on the backplane. A BNC cable 
is required from the slave mainframe Input Trigger to the Output Trigger of the 
Master mainframe. Finally, as indicated on Figure 7, a BNC cable is required 
from the Source Trigger Out to the OSA ADC Trigger.
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Calibrating the Signal Path Offsets

Refer to “Calibrating the Signal Path Offsets” on page 17.

Measuring the Source

After the offsets are calculated as described in the previous section, we can 
proceed with the amplifier measurement. The first step of the two-step TDE 
method is a set of sweeps that measure signal wavelength and power of the 
source. A second set of sweeps will measure the amplifier signal power and 
amplified spontaneous emission.

The Measure Source step must be repeated if there is any change in the 
measurement parameters or the source wavelength and power. Source data 
will be lost when exiting the application and must be remeasured.

Measuring the Source
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1 From the TDE Test menu, select MEASURE SOURCE....

Note that the MEASURE AMPLIFIER... softkey is disabled until the source 
measurement is completed.

Source Measurement Prompts

2 The system prompts you to connect the source to the OSA. 

The display connection prompts can be turned off in the measurement setup 
dialog box, in which case MEASURE SOURCE... will immediately initiate the 
measurement.

3 Press CONTINUE to initiate the measurement. 

MEASURE SOURCE... is replaced with STOP SOURCE MEASUREMENT... while the 
measurement is in progress.

4 The progress of the measurement is noted on the status panel:

a An initial sweep is taken to set references, indicated by “Source Initial Sweep...”.

b A second sweep measures the peak of the signal, indicated by “Source Peak 
Sweep...”.
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5 When the measurement is complete, the MEASURE AMPLIFIER... softkey is enabled. The 
progress status label reads “Idle”.

Using the Optimal Delay Search

1 Connect the amplifier as shown in Figure 7. 

2 Press Optimal Delay Search on the TDE application menu. 

This routine will search for the optimal trigger delay for the source modulation 
rate. The optimal delay sets the ASE measurement point to the midpoint of the 
source Off period.

Occasionally, the Optimal Delay Search will not be able to find an optimal 
setting. In this case, enter the trigger delay manually. The value should be 25% 
of the modulation period plus 0.8 ms. 

For a 65 kHz modulation rate, the period is 15.4 ms. The appropriate trigger 
delay is 0.25 x 15.4 ms + 0.8 ms = 4.6 ms.
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Measuring the Amplifier

In the second step of the two-step process the amplifier is connected between 
the source and the OSA. The system measures the peak and noise power for 
the wavelengths measured in Measuring the Source and creates/updates the 
Display Table.

Amplifier Measurement Prompts

1 Press MEASURE AMPLIFIER... to begin the process.

2 The system prompts you to connect the device to be tested. 

The display connection prompts can be turned off in the measurement setup 
dialog box, in which case MEASURE AMPLIFIER... will immediately initiate the 
measurement.

3 Press CONTINUE to initiate the measurement. 

The MEASURE SOURCE... softkey is disabled. MEASURE AMPLIFIER... is replaced 
with STOP AMP MEASUREMENT... while the measurement is in progress. 
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4 The progress of the measurement is noted on the status panel:

a An initial sweep is taken to set references, indicated by “Amplifier Initial 
Sweep...”.

b A second sweep measures the peak of the signal, indicated by “Amplifier Peak 
Sweep...”.

c A third sweep measures the noise level, indicated by “Amplifier Noise Sweep...”.

d After all the data is received, the application calculates the measurement results. 
The progress label reads “Calculating Results...”.

5 When the measurement is complete, the progress status label reads “Idle”. 

Amplifier Measurement Results

6 The measurement results will be displayed graphically. The points indicating the 
amplifier gain and noise figure are displayed relative to the dB scale on the right side 
of the graph. Negative noise figure values will not be displayed.
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N O T E If Continuous Amplifier Measurement mode is selected in the measurement setup 
dialog box, the measurement will continue to update the points on the display and in the 
Display Table at the end of each measurement.

Viewing the Display Table

The DISPLAY TABLE... softkey is enabled when an amplifier measurement is 
complete and valid data is available. The results are displayed in a table similar 
to the one shown below. The Page Up and Page Down keys display previous 
and next pages of data if available.

When in continuous sweep mode the TDE Test application continues to sweep 
and update the tabular data at the end of each measurement. 

At the end of the table, after all channels present have been measured, the 
table will display values of source mean wavelength, sum of source signal 
power, amplifier mean wavelength, and sum of amplifier signal power.
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For a description of mathematical calculations refer to “Theory of Operation” 
on page 49.

Documenting the Results 

There are two ways to document results in the Amplifier Test application. You 
can either print them to a printer (specified under Printer Setup) or save them 
to a floppy disk.

After the source and amplifier measurements are complete and valid 
measurement data exists, the DOCUMENT RESULTS... softkey will be enabled. 

Press DOCUMENT RESULTS... to display the Document Results selections.

Document Results Menu
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Saving the results to a floppy disk

Press the SAVE RESULTS TO FLOPPY softkey to save the current results to a file on 
the floppy drive. 

If a device ID has been entered, the name of the file is defaulted to the last 8 
characters of the device ID.

If no ID exists, a message prompts you to “Enter a Device ID as Filename”. Press 
CLOSE PANEL... to return to the Document Results menu and select ENTER ID... .
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If the ID already exists, the warning “Overwrite File?” is displayed. Press 
OVERWRITE FILE to overwrite the existing file or CANCEL to return to the Enter ID 
screen. 

A successful save operation is confirmed by a progress message displayed on 
the bottom left of the OSA display.

The current file is saved in ASCII (.csv) spreadsheet format. Graphics data is 
stored in Computer Graphics Metafile (.cgm) graphics format. This is a vector 
graphics format that describes pictures and graphical elements in geometric 
terms.
1-39



Amplifier Test Application

TDE Test
Using the alphanumeric panel 

Alphanumeric panels, such as the Device ID panel, allow you to enter 
identification and comment labels for the devices you test.

An example of an alphanumeric panel
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Select selects the highlighted character.

The arrow softkeys allow you to navigate from character to character in the 
dialog box.

Backspace removes a previously selected character.

Continue saves the current entry and returns you to the previous menu.
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To enter a device ID

Press ENTER ID... to access the Device Identification panel. Use the arrow and 
Select softkeys to enter the device ID. A maximum of 20 characters can be 
entered in this field.

Device Identification panel

To enter comments

Press ENTER COMMENTS... to access the Enter Comments panel. Use the arrow 
and Select softkeys to enter a comment. A maximum of 50 characters can be 
entered in this field.

Enter Comments panel
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Printing the results

1 Press PRINT RESULTS to print the results to the target printer. 

The default setting is the internal printer and the default printout type is table 
only. 

2 Press PRINTER SETUP... to access the Printer Setup dialog box. 

3 Use the arrow and Select softkeys to select the target printer, and the printout type. 
This setting is reset when the front-panel PRESET key is pressed, otherwise the 
previous setting from the last time the application was started is retained.

Printer Setup panel 

The print operation is confirmed by a progress message displayed on the 
bottom left of the OSA display. 

4 CLOSE PANEL... returns to the Document Results Menu.

The four possible print formats are shown in the following four figures:
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Graphics and Table, Internal Printer
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Graphics and Table, External Printer
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Table Only, Internal Printer
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Table Only, External Printer
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Viewing Errors

Error Menu

Any errors generated in the course of the test or result documentation will 
generate error codes. These codes can be accessed by pressing the VIEW 
ERRORS... softkey. If any errors exist, the appropriate selection on the error 
menu will be enabled.
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Theory of Operation

Interpolation Source Subtraction

The Amplifier Test application uses the Interpolation Source Subtraction (ISS) 
measurement technique to determine the noise figure of an amplifier. This 
method determines the amplified spontaneous emission (ASE) of the amplifier 
at the signal wavelength by measuring the noise power levels at wavelengths 
just above and below the signal and then interpolating to determine the noise 
level at the signal wavelength.

First, the spontaneous emission of the source is determined by measuring it’s 
level at a specified offset (typically 1nm) above and below the signal 
wavelength and then taking the average of the measurements. This offset can 
be specified in the Measurement Setup dialog box, or calculated automatically 
using (0.5×RBW+0.5nm). 

The same procedure is then used to determine the spontaneous emission at 
the output of the amplifier. The ASE and noise figure of the amplifier can then 
be determined using its calculated gain and these two spontaneous emission 
values.

Gain and Spontaneous Emission

The purpose of an amplifier is to provide gain, which is defined as the ratio of 
output signal power to input signal power. These measured powers are 
actually the sum of the signal power and the small amount of spontaneous 
emission at the signal wavelength. This additional measured power can be a 
factor when high spontaneous emission levels are present.
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Amplified Spontaneous Emission (ASE)

Ideally, an amplifier would amplify the input signal by it’s gain and produce no 
additional output. However, amplifiers also produce ASE, which adds to the 
spontaneous emission of the source. This ASE is calculated as the difference 
between the output spontaneous emission power and the equivalent source 
spontaneous emission power measured at the amplifier output.

Interpolating Noise

In order to correctly determine the noise figure, the ASE level must be 
determined at the signal wavelength. This cannot be directly measured 
because the ASE is masked by the signal power level. The ISS method uses 
filter characteristics of the OSA to reject the signal and measure the 
spontaneous emission levels at wavelengths near each signal.

To determine the noise level at the signal wavelength, several measurement 
sweeps are taken. The initial sweep adjusts the reference level to peak. The 
second sweep measures the power level and channel wavelength for each 
channel present, as well as the maximum noise value. The third and final 
sweep sets the reference level to the maximum noise level measured in the 
second sweep. It then measures the noise power for each channel by taking 
measurements above and below the channel wavelength at the predetermined 
offset value. These values are interpolated to determine the noise value at the 
channel wavelength. The linear interpolation method takes two 
measurements, one on each side of the channel. The noise at the channel 
wavelength is interpolated based on these two measurements.

The quadratic interpolation method takes four measurements, two on each 
side of the channel. This method approximates the curvature to account for 
curvature of the noise spectrum profile. In the vicinity of each channel, the 
noise generally assumes a Gaussian profile which can be modeled as a 
quadratic curve in dB. The noise at the channel wavelength is estimated based 
on the four measurements.
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The noise figure of the amplifier is calculated from the measurements of the 
signal and ASE power levels using the following equations:

Where:
• P

out
 = amplifier output power

• P
in
 = amplifier input power

• Nout = interpolated output noise power
• N

in 
= interpolated source noise power

• G = amplifier gain 
• 1/G = the optional shot noise component
• B

w
 = optical spectrum analyzer’s noise bandwidth in Hertz

• h = Plank’s constant (6.626 × 10-34 Watt seconds2)
• v = signal frequency in Hertz

Gain
Pout Nout–

Pin Nin–
---------------------------=

Gain dB( ) 10 Gain( )log=

NoiseFactor
Nout NinG( )–

hvBwG
----------------------------------- 1

G
---

NoiseFigure 10 NoiseFactor( )log=
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Time Domain Extinction Technique

Erbium-Doped Fiber Recovery from Saturation

The core of an optical amplifier, for wavelengths around 1550 nm, is a single-
mode fiber doped with erbium. The erbium ions are shifted to higher energy 
levels by some pump lasers. The activated electrons remain in a meta stable 
level for some time. Without any signal at the amplifiers input, these electrons 
eventually fall down and emit some light randomly. However, if an input signal 
is applied, then the incoming wave stimulates the electrons to fall down and 
thus emit their energy coherently with the incoming wave. This is the main 
effect of the optical amplification. The amplification applies to randomly 
emitted photons as well, so the output spectrum of an optical amplifier 
consists of an amplified input spectrum (if applied) and the amplified 
spontaneous emission (ASE, which represents the noise from the amplifier.)

The more electrons used for stimulated emission, the fewer remain for random 
emission (and vice versa). Without an input signal, the ASE is much higher 
than with an input signal. Therefore, the ASE has to be measured when the 
amplifier is driven into saturation by an input signal.

The time domain extinction technique (TDE) takes advantage of the fact that 
the meta stable energy level of the erbium ion has a time constant of several 
hundreds of microseconds. Immediately after the input signal is turned off, the 
ASE power remains at the same level it was in the presence of the input signal. 
Then it starts to rise in an exponential fashion until it reaches the level of an 
undriven condition.
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Figure 8 ASE time domain characteristics

The time characteristics can be tested using a laser source being modulated at 
a low frequency. Before the falling edge of the modulated laser, the amplifier 
noise (ASE) has stabilized at a saturated level. This power is the sum of the 
amplified input signal and the ASE which is very small due to the saturation of 
the amplifier. Immediately after the falling edge, the output signal consists of 
only ASE from the amplifier; that is, it does not contain the amplified signal any 
more, nor has it any sidemodes or spontaneous emission from the source. This 
fact allows accurate characterization of the ASE even at the wavelength of the 
saturating signal.
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Because the power after the edge is up to a thousand times smaller than the 
power before, the measurement equipment must recover from the large signal 
in a very short time. The next figure shows typical recovery performance of the 
Agilent 8614XB family of optical spectrum analyzers. Within ten microseconds 
after the large signal has disappeared, the OSA can measure a 30 dB weaker 
signal with an accuracy of better than ±0.2 dB.

Figure 9 OSA recovery performance
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Amplifier Test Application Remote Commands

The Agilent 86140B Series Optical Spectrum Analyzer Programming Guide for 
the mainframe provides detailed information on remote programming of the 
instrument. Only commands unique to the Amplifier Test application are 
included in this section.

The Amplifier Test application remote command set is comprised of two types 
of commands:

General Application support commands 

These are part of the base firmware and support applications in general. They 
allow you to get a list of installed applications, load/unload an application, and 
so on. These commands are grouped under:

• INSTrument Subsystem Commands

Amplifier Test application specific commands 

These remote commands are specific to the Amplifier Test application and 
allow you to control the application remotely. They are grouped under the 
following subsystems:

• CALCulate Subsystem Commands

• FORMat Subsystem Commands

• INITiate Subsystem Commands

• SENSe Subsystem Commands

For more information, refer to the Remote Operation section in the Agilent 
86140B Series Optical Spectrum Analyzer Programming Guide, or to the 
following book:

SCPI Consortium. SCPI–Standard Commands for Programming Instruments, 1997
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Command Conventions

CALCulate Subsystem Commands 

The CALCulate subsystem performs post-acquisition data processing. The 
CALCulate subsystem operates on data acquired by a SENSe function. 

Table 1

Convention  Description 

< > Angle brackets indicate text strings entered by the developer.

[ ] Square brackets indicate that the keyword DEFAULT can be used instead 
of a value or a variable for that parameter. Refer to the actual command 
description for the behavior when the DEFAULT keyword is used for a 
parameter.

| Indicates a choice of one element from a list.

{ } Braces indicate a group of constants to select from. Each constant is 
separated by the | character.

name Indicates the variable for which you provide a descriptive name. Any letter 
(Aa-Zz) followed by letters, digits (0-9) and underscore (_). Only the first 32 
characters are significant.

spec_min –infinity. The parameter spec_min cannot be a variable, only a constant or 
DEFAULT.

spec_max +infinity. The parameter spec_max cannot be a variable, only a constant or 
DEFAULT.

from  Start wavelength or frequency of trace in nm (default) or THz.

to  Stop wavelength or frequency of trace in nm (default) or THz.

excursion +excursion: means excursion dBs up (for example, from a pit). 
-excursion: means excursion dBs down (for example, from a peak).

ref_pt The reference point to be used for a measurement keyword.
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CALCulate:DATA:CPOWers?

Downloads the array of source channel powers measured. The data is returned 
in either an ASCII or binary form as determined by the FORMat:DATA 
command. The number of data points in this array is determined by the 
CALCulate:DATA:NCHannels? query.

CALCulate:DATA:CGAin?

Downloads the array of channel gain values measured. The data is returned in 
either an ASCII or binary form as determined by the FORMat:DATA command. 
The number of data points in this array is determined by the 
CALCulate:DATA:NCHannels? query.

CALCulate:DATA:CNF?

Downloads the array of channel noise figure values measured. The data is 
returned in either an ASCII or binary form as determined by the FORMat:DATA 
command. The number of data points in this array is determined by the 
CALCulate:DATA:NCHannels? query.

CALCulate:DATA:CSTats?

Downloads the following statistics using a single query:
• Source mean wavelength
• Sum of source signal power
• Amplifier mean wavelength
• Sum of amplifier signal power

The data is returned in either an ASCII or binary form as determined by the 
FORMAT:DATA command. 

CALCulate:DATA:CWAVelengths?

Downloads the array of channel wavelengths measured. The data is returned in 
either an ASCII or binary form as determined by the FORMat:DATA command. 
The number of data points in this array is determined by the 
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CALCulate:DATA:NCHannels? query. The units are either nanometers or 
terahertz and can be changed using the CALCulate:DATA:TABLe:WAVe 
command.

CALCulate:DATA:NCHannels?

Queries the number of channels detected in the last measurement. The data is 
returned as an ASCII integer. 

CALCulate:DATA:TABLe:WAVe NM|THZ

CALCulate:DATA:TABLe:WAVe?

Sets the wavelength units used for the tabular display and for the 
CALCulate:DATA:CWAVelengths remote query. Default units are NM. 

The instrument x-axis display always displays wavelength in nanometers and is 
not affected by this command.

Example CALC:DATA:TABL:WAV NM ! Assign table units to nm

CALCulate:OFFSet:AMPLifier <numeric_value>

CALCulate:OFFSet:AMPLifier?

Sets the trace level offset or power correction factor in dB for the amplifier 
path. The “dB” terminator is not required in the command.

Example CALC:OFFS:AMPL 11 ! Assign an amp offset
CALC:OFFS:AMPL? ! Read offset
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CALCulate:OFFSet:SOURce <numeric value>

CALCulate:OFFSet:SOURce?

Sets the trace level offset or power correction factor in dB for the source path. 
The “dB” terminator is not required in the command.

Example CALC:OFFS:SOUR 13 ! Assign a source offset
CALC:OFFS:SOUR? ! Read offset

CALCulate:PEXCursion[:PEAK] <numeric_value> 

CALCulate:PEXCursion[:PEAK]? 

Sets the peak excursion value for the marker search routines. The peak 
excursion value is used to determine whether or not a local maximum in the 
trace is to be considered a peak. To qualify as a peak, both sides of the local 
maximum must fall by at least the peak excursion value.

Example CALC:PEX 5 ! Assign peak excursion
CALC:PEX? ! Read peak excursion

CALCulate:THReshold <numeric_value> [DBM]

CALCulate:THReshold? 

Specifies the value for the peak search threshold. Peaks with amplitudes below 
this value will not be included in the channel count. 

Units are DBM.

Example CALC:THR -40 DBM ! Assign a peak threshold
CALC:THR? ! Read peak threshold

CALCulate:SNOise [ON|OFF|0|1]

CALCulate:SNOise? 

Sets the shot noise term included/excluded in noise figure calculations. 
Default value is false. By default the shot noise term will not be added to the 
noise figure.
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Example CALC:SNO OFF ! Turn off shot noise term
CALC:SNO? ! Read shot noise

CALibration Subsystem Commands

This subsystem has the function of performing system calibration. 

CALibration Alignment

Performs an automatic alignment of the instrument at the wavelength of the 
largest signal found in full span. This aligns the monochromator output with 
the photodetector for improved amplitude accuracy.

Syntax CAL:ALIG

Related Key Auto Align

DISPlay Subsystem Commands

The DISPlay subsystem controls the selection and presentation of textual, 
graphical, and TRACe information.

DISPlay[:WINDow]:DUT:COMMent<string>

Enters a new comment string for the device under test.

DISPlay[:WINDow]:DUT:COMMent?

Returns the comment string for the device under test. 

DISPlay[:WINDow]:DUT[:ID]<string>

Enters a new identification string for the device under test.
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DISPlay[:WINDow]:DUT[:ID]?

Returns the identification string for the device under test.

FORMat Subsystem Commands

The FORMat subsystem sets a data format for transferring numeric and array 
information.

FORMat[:DATA] REAL[32,64]|ASCII

FORMat[:DATA]?

Specifies the format used during data transfer via GPIB. This command affects 
data transfers for the CALCulate[:DATA] subsystem.

The ASCII format is a comma-separated list of numbers.

The REAL format is a definite-length block of either 32-bit or 64-bit floating-
point binary numbers. The definite-length block is defined by IEEE 488.2: a "#" 
character, followed by one digit (in ASCII) specifying the number of length 
bytes to follow, followed by the length (in ASCII), followed by length bytes of 
binary data. The binary data is a sequence of 8-byte floating point numbers, 
default to 64-bit and selectable to 32-bit.

INITiate Subsystem Commands

The INITiate subsystem is used to control the initiation of the TRIGger 
subsystem.

INITiate:IMMediate[:SEQuence [1|2]]

Initiates the source measurement (sequence 1) or amplifier measurement 
(sequence 2) based on the sequence number. Default is sequence 2.
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INSTrument Subsystem Commands

The INSTrument subsystem provides a mechanism to identify and select 
logical instruments by either name or number. Arguments and responses are 
case sensitive.

INSTrument:CATalog?

{Filter1,PowerMeter, OSA,PassiveComponent,WDM_AutoScan,Amp_ISS_Test, Amp_TDE_Test,<null>}

Comma-separated list of strings representing the modes and applications 
supported in the instrument.

INSTrument:CATalog:FULL?

{OSA,0,Filter1,1,PowerMeter,2,PassiveComponent,3,WDM_AutoScan,4,Amp_ISS_Test,5,
Amp_TDE_Test,6}

Comma-separated list of string-numeric pairs representing the modes and 
applications supported in the instrument.

INSTrument:SELect <identifier> identifier - string

INSTrument:NSELect <numeric_value>

INSTrument:NSELect?

Loads the application or instrument mode specified. Use the CATalog:FULL? 

command to obtain the number. Firmware revisions will add additional 
applications and the order may vary.

Example INST:SEL ‘Amp_ISS_Test’ !Select amplifier interpolated source
subtraction test

INST:NSEL5 !Select amplifier test by number
INST:SEL? !Read ‘Amp_ISS_Test’

INST:SEL ‘Amp_TDE_Test’ !Select amplifier time domain extinction
test

INST:NSEL6 !Select amplifier test by number
INST:SEL? !Read ‘Amp_TDE_Test’
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SENSe Subsystem Commands

The SENSe setup commands control the specific settings of the device.

SENSe:AVERage:COUNt <integer>

SENSe:AVERage:COUNt? 

Sets and queries the number of sweeps that will be averaged. Range is 1-1000. 
Command will also turn on trace averaging if it is not already on.

Example SENS:AVER:COUN <INT> ! Sets count for trace averaging
SENS:AVER:COUN? ! Gets count for trace averaging

SENSe:AVERage:[STATe] <ON|OFF|1|0>

SENSe:AVERage:[STATe]? 

Turns trace averaging on or off and queries trace averaging state.

Example SENS:AVER[:STAT] <on|off.> ! Turns trace averaging on/off
SENS:AVER[:STAT] ! Gets trace averaging on/off

SENSe:BANDwidth|BWIDth[:RESolution]: <numeric_value> [M|NM|UM|A]

SENSe:BANDwidth|BWIDth[:RESolution]? 

Sets the resolution bandwidth value to be used. Resolution bandwidth 
determines the instrument’s ability to display two closely spaced signals as 
two distinct responses. 

The resolution bandwidth can be set to one of the following values: 

• For 86140B Option 025, 86143B option 025, 86141B: 
0.07 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86140B, 86142B, 86143B, 86145B: 
0.06 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86144B, 86146B internal path: 
0.06 nm, 0.07 nm, 0.1 nm, 0.14 nm, 0.2 nm, 0.33 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

• For 86144B, 86146B external path: 
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0.04 nm, 0.05 nm, 0.07 nm, 0.1 nm, 0.2 nm, 0.3 nm, 0.5 nm, 1 nm, 2 nm, 5 nm, 10 nm.

For the greatest measurement range and signal to noise ratio performance, a 
resolution bandwidth of 10 nm is recommended. Narrower bandwidths can be 
used if greater wavelength resolution is required.

Example SENS:BWID .5 NM ! Select a RBW for measurement
SENS:BWID? ! Read bandwidth

SENSe:BANDwidth|BWIDth: VIDeo <real>

SENSe:BANDwidth|BWIDth:VIDeo? 

Permits setting video bandwidth via remote interface with the SCPI command.

Example SENS:BAND:VID <param> ! Sets video bandwidth
SENS:BAND |BWID:VID ?  ! Gets video bandwidth

SENSe:INTerpolation:METHod <LINear|QUADratic>

SENSe:INTerpolation:METHod? 

Allows selection and query of the interpolation method (linear or quadratic).

Example SENS:INT:METH <LIN|QUAD> ! Sets interpolation method, linear or 4 
pt 

quad
SENS:INT:METH? ! Gets current interpolation 
method

SENSe:INTerpolation:OFFSet:VALue? 

SENSe:INTerpolation:OFFSet:AUTO [ON|OFF|0|1]

SENSe:INTerpolation:OFFSet:AUTO? 

Specifies the noise measurement locations for interpolation. If auto is set to 
true, then the application will calculate the best offset value. Default units are 
NM.
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SENSe:[WAVelength:]STARt <numeric_value> [M|NM|UM|A|HZ|KHZ|MHZ|GHZ]

SENSe:[WAVelength:]STARt?

Specifies the start wavelength for the Amplifier Test Application. Default units 
are NM. 

Example SENS:STAR 1500 NM ! Select the start wavelength
SENS:STAR? ! Read wavelength

SENSe:[WAVelength:]STOP <numeric_value> [M|NM|UM|A|HZ|KHZ|MHZ|GHZ] 

SENSe:[WAVelength:]STOP?

Specifies the stop wavelength for the Amplifier Test application. Default units 
are NM. 

Example SENS:STOP 1540 NM ! Select the stop wavelength
SENS:STOP? ! Read wavelength

TRIGger Subsystem Commands

TRIGger[:SEQuence]:DELay:AUTO

For 86146B only

Initiates a routine to automatically find the optimum trigger delay. TDE uses the 
source external trigger output to trigger the OSA to sample when the source is 
off. The OSA will measure the ASE associated with the amplifier. 

TRIGger[:SEQuence]:DELay<time>

TRIGger[:SEQuence]:DELay?

For 86146B only

Sets the trigger delay used for the TDE measurement. TDE uses the source 
external trigger output to trigger the OSA to sample when the source is off. The 
OSA will measure the ASE associated with the amplifier.
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ISS Measurement Method Example Program

Program 10  !***************************** Select Amplifier ISS Test *****************************
20   !
30   ASSIGN @Osa TO 723;EOL CHR$(10) END     ! Use LF and EOI as command 
terminators
40   !
50   OUTPUT @Osa;"inst:sel 'Amp_ISS_Test'"   ! Select Amp ISS test
60   !
70 !***************************** Measurement Setup **********************************
80 !
90   OUTPUT @Osa;"sens:int:meth quad"    ! Select 4 pt quad int
100    !
110 !***************************** Measure the Source *********************************
120    !
130    INPUT "Connect source and press Enter to continue",A$
140    OUTPUT @Osa;"init:imm:seq 1"        ! Take a source measurement
150    !
160 !***************************** Measure the Amplifier *******************************
170    !
180    INPUT "Connect amplifier and press Enter to continue",A$
190    OUTPUT @Osa;"init:imm:seq 2"        ! Take an amplifier measurement
200    !
210 !***************************** Read the Results ************************************
220    !
230    OUTPUT @Osa;"calc:data:nch?"      ! Find number of channels measured
240    ENTER @Osa;Nchannels
250    PRINT "Number of channels"
260    PRINT Nchannels
270    PRINT
280    !
290    ALLOCATE Datarray(1:Nchannels)
300    !
310    OUTPUT @Osa;"calc:data:cwav?"       ! Read in the channel wavelengths
320    ENTER @Osa;Datarray(*)
330    PRINT "Channel wavelengths"
340    PRINT Datarray(*)
350    PRINT
360    !
370    OUTPUT @Osa;"calc:data:cpow?"        ! Read in the channel powers
380    ENTER @Osa;Datarray(*)
390    PRINT "Channel powers"
400    PRINT Datarray(*)
410    PRINT
420    !
430    OUTPUT @Osa;"calc:data:cga?"         ! Read in the channel gains
440    ENTER @Osa;Datarray(*)
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450    PRINT "Channel gains"
460    PRINT Datarray(*)
470    PRINT
480    !
490    OUTPUT @Osa;"calc:data:cnf?"     ! Read in the channel noise figures
500    ENTER @Osa;Datarray(*)
510    PRINT "Channel noise figures"
520    PRINT Datarray(*)
530    PRINT
540    !
550 !***************************** Read the Test Results ********************************
560    !
570    OUTPUT @Osa;"calc:data:cst?"     ! Query statistics table Results
580    ENTER @Osa;Sourmwl;Sumsrcpwr;Ampmwl;Sumsamppwr
590    PRINT "Source Mean WL"
600    PRINT Sourmwl
610    PRINT
620    !
630    PRINT "Sum of Src Sig Pwr"
640    PRINT Sumsrcpwr
650    PRINT
660    !
670    PRINT "Amplifier Mean WL"
680    PRINT Ampmwl
690    PRINT
700    !
710    PRINT "Sum of Amp Sig Pwr"
720    PRINT Sumsamppwr
730    PRINT
740    !
750 !***************************** Exit the Application *********************************
760    !
770    OUTPUT @Osa;"*RST"                  ! Exit amplifier ISS application
780    LOCAL @Osa
790    END

===========================================================
Number of channels
+3

Channel wavelengths
+1.55385770E-006,+1.55485825E-006,+1.55594775E-006

Channel powers
-3.14317435E+000,-5.22143262E+000,-2.93054801E+000

Channel gains
+7.97910584E-003,-2.28063112E-003,-8.10500742E-003

Channel noise figures
+9.91000000E+037,+9.91000000E+037,+9.91000000E+037

Source Mean WL
+1.55492086E-006
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Sum of Src Sig Pwr
1.12172171E+000

Amplifier Mean WL
+1.55491862E-006

Sum of Amp Sig Pwr
+1.12099868E+000
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TDE Measurement Method Example Program

Program 10 !*****************************Select Amplifier TDE Test ******************************
20   !
30   ASSIGN @Osa TO 723;EOL CHR$(10) END   ! Use LF and EOI as command 
terminators
40   !
50   OUTPUT @Osa;"inst:sel 'Amp_TDE_Test'"  ! Select Amp TDE test
60   !
70 !*****************************Measurement Setup **********************************
80   !
90   !
100    OUTPUT @Osa;"sens:int:meth quad"   ! Select 4 pt quad int
110    !
120 !***************************** Measure the Source ********************************
130    !
140    INPUT "Connect source and press Enter to continue",A$
150    OUTPUT @Osa;"init:imm:seq 1"       ! Take a source measurement
160    OUTPUT @Osa;"trig:seq:del:auto"   ! Determine trigger delay
170    !
180    !***** Measure the Amplifier *****************************************************
190    !
200    INPUT "Connect amplifier and press Enter to continue",A$
210    OUTPUT @Osa;"init:imm:seq 2"     ! Take an amplifier measurement
220    !
230 !*****************************Read the Results ***********************************
240    !
250    OUTPUT @Osa;"trig:seq:del?"      ! Find trigger delay
260    ENTER @Osa;Trigdelay
270    PRINT "Trigger delay"
280    PRINT Trigdelay
290    PRINT
300    !
310    OUTPUT @Osa;"calc:data:nch?"   ! Find number of channels measured
320    ENTER @Osa;Nchannels
330    PRINT "Number of channels"
340    PRINT Nchannels
350    PRINT
360    !
370    ALLOCATE Datarray(1:Nchannels)
380    !
390    OUTPUT @Osa;"calc:data:cwav?"    ! Read in the channel wavelengths
400    ENTER @Osa;Datarray(*)
410    PRINT "Channel wavelengths"
420    PRINT Datarray(*)
430    PRINT
440    !
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450    OUTPUT @Osa;"calc:data:cpow?"    ! Read in the channel powers
460    ENTER @Osa;Datarray(*)
470    PRINT "Channel powers"
480    PRINT Datarray(*)
490    PRINT
500    ! 
510    OUTPUT @Osa;"calc:data:cga?"  ! Read in the channel gains
520    ENTER @Osa;Datarray(*)
530    PRINT "Channel gains"
540    PRINT Datarray(*)
550    PRINT
560    !
570    OUTPUT @Osa;"calc:data:cnf?"    ! Read in the channel noise figures
580    ENTER @Osa;Datarray(*)
590    PRINT "Channel noise figures"
600    PRINT Datarray(*)
610    PRINT
620    !
630 !***************************** Read the Test Results ********************************
640    !
650    OUTPUT @Osa;"calc:data:cst?"   ! Query statistics table results
660    ENTER @Osa;Sourmwl;Sumsrcpwr;Ampmwl;Sumsamppwr
670    PRINT "Source Mean WL"
680    PRINT Sourmwl
690    PRINT
700    !
710    PRINT "Sum of Src Sig Pwr"
720    PRINT Sumsrcpwr
730    PRINT
740    !
750    PRINT "Amplifier Mean WL"
760    PRINT Ampmwl
770    PRINT
780    !
790    PRINT "Sum of Amp Sig Pwr"
800    PRINT Sumsamppwr
810    PRINT
820    !
830    !***************************** Exit the Application*********************************
840    !
850    OUTPUT @Osa;"*RST"             ! Exit amplifier tde application
860    LOCAL @Osa
870    END

===========================================================
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Test Results Trigger delay
+4.65435560E-006

Number of channels
+3

Channel wavelengths
+1.55385770E-006,+1.55485825E-006,+1.55596998E-006

Channel powers
-6.17120296E+000,-8.13289990E+000,-5.85822828E+000

Channel gains
+6.64604087E-003,+3.22791498E-002,-1.66935339E-002

Channel noise figures
+4.64523752E+000,+4.87264832E+000,+4.88462994E+000

Source Mean WL
+1.55492714E-006

Sum of Src Sig Pwr
-1.83947201E+000

Amplifier Mean WL
+1.55492862E-006

Sum of Amp Sig Pwr
-1.83601805E+000
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About the Application
About the Application

The Source Test application is implemented in the Agilent 86140B series 
optical spectrum analyzer (OSA). All specifications and characteristics are 
derived from the 86140 series specifications.

The application quickly and accurately measures peak wavelength, power, full 
width at half maximum (FWHM) and other source characteristics for 
distributed feedback (DFB) lasers, Fabry-Perot (FP) lasers, and light emitting 
diodes (LEDs).

When the Source Test application is launched, the selected source test (DFB, 
FP, or LED) main softkey menu is displayed and changes are made to the 
standard OSA screen. The Marker Display panel is overlaid with the selected 
Source Test Results panel.

When in the Source Test application, all standard OSA functions are available. 
You may leave the Source Test menu by selecting any desired OSA function. 
Pressing the Appl’s key will always bring you back to the source test menu. 
Pressing EXIT SOURCE TESTS will turn off source tests or pressing PRESET will reset 
the source test settings to their default values and turn off source tests.
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Performing Measurements

This section explains how to start and use the Source Test application. The 
application quickly and accurately measures peak wavelength, power, full 
width at half maximum (FWHM) and other source characteristics for 
distributed feedback (DFB) lasers, Fabry-Perot (FP) lasers, and light emitting 
diodes (LEDs).

Starting the Source Test Application

1 Press the front-panel APPL’S key or, on the APPLICATIONS menu, select LAUNCH AN 
INSTALLED APPLICATION. The following screen is displayed:
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Each installed application has an icon on the panel and a corresponding 
softkey. 

2 Press SOURCE TESTS to bring up the source test display, menu, and results panel 
shown below.

The Source Test results panel appears in the marker area at the top of the 
screen. Measurement results (attributes) for all source tests are displayed in 
this panel. The currently selected source test and trace names are displayed in 
the upper left corner of the results panel. Once a source test is initiated on a 
given trace, it remains associated with that trace even though another trace 
may be made active.

Tip: To change the selected source test trace, select the new trace (press 
TRACES > ACTIVE TRACE), switch to another source test momentarily using the 
Source Test softkey, and then reselect the original source test.

In addition to the source test results panel, the source test softkey menu is 
also displayed with the following softkeys:
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Source Test is used to select the desired source test. The DFB source test is the 
default test.

Bandwidth Selection is active only during the DFB source test and allows you to 
change the vertical offset from the peak for the bandwidth measurement 
attribute.

Measurement Setup brings up the Source Test Measurement Setup Panel.

Repeat Sweep turns continuous sweep mode on or off.

Single Sweep initiates a single sweep or turns single sweep mode on.

Exit Source Test exits the application.

All normal OSA functionality is available while in the Source Test application. 
Simply select the desired function and press the APPL’S key when ready to 
return to the source test application.
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Setting Up a Measurement

Performing a source measurement is a two step process: First you must select 
the source test type for measurement (by pressing SOURCE TEST and selecting 
the desired test). Next, you can specify the parameters used for the 
measurement (by pressing Measurement Setup to access the Source Test 
Measurement Setup panel). The most common source measurement settings 
can be accessed via the setup panel. Remember that all standard OSA 
functions are also available while using the Source Test application.

N O T E Changing any of the source test measurement settings will affect the corresponding 
settings in Auto Meas and Marker Setup Panels. These settings are grouped here for 
convenience.

Auto Measure (Auto Meas) Span selects the wavelength span for viewing the 
signal located by the auto measure function. If Auto is specified, the span is set 
wide enough to display most of the signal. If a particular span is desired, clear 
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Auto and enter the desired span in the nm text box. The recommended 
selection for Auto Meas Span is Auto for FP and LED source testing and the 
recommended setting for DFB source testing is 10 nm.

Auto Meas Sensitivity sets the sensitivity of the Auto Measure function so the 
resulting measurement has a minimal amount of noise. It is determined by 
finding the minimum in the measurement trace and comparing this value to the 
known sensitivity of the instrument at that wavelength. Sensitivity is then 
reduced until the signal is close to this minimum sensitivity or the sweep time 
becomes too long. This function is useful when viewing high dynamic range 
signals. The drawback to having this function on is that it generally requires a 
longer sweep time to get better sensitivity. The default selection is off. on is 
recommended for DFB lasers.

Peak Excursion (in dB) determines which side modes are included in the DFB 
source test measurements. To qualify as a peak, the peak’s sides must rise and 
fall by at least the peak excursion. Setting the value too high may result in not 
identifying a peak. Setting the value too low may cause unwanted responses, 
including noise spikes, to be identified. The default value is 3 dB. Peak 
excursion is not used for the FP or LED source tests.

Peak (Pk) Density/Noise Marker Reference (Ref) Bandwidth (BW) (0.1 nm or 1.0 
nm) determines whether the power spectral density is normalized to 0.1 nm or 
1.0 nm. This setting is the same as the base OSA Noise Marker Reference 
Bandwidth. Default value is 0.1 nm.
2-7



Source Test Application

Performing Measurements
Navigating the Source Test Measurement Setup Window

The softkeys allow you to navigate through the measurement setup panel. The 
front-panel number keys, step keys, and knob on the OSA allow you to enter a 
numeric value in the highlighted field.

.

The arrow softkeys allow you to navigate from field to field in the panel. The 
highlighted parameter can be changed.

Select selects the highlighted parameter.

Defaults resets the parameters to their default condition.

Close Panel... saves the current setup and returns you to the previous menu.
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Characterizing DFB Lasers

The DFB source test performs a series of automatic measurements on 
distributed feedback lasers. All measurement results are displayed in the 
Source Test Results panel across the top of the screen.

C A U T I O N When you use improper cleaning and handling techniques, you risk expensive 
system repairs, damaged connectors, and compromised measurements. Clean 
all connectors properly before making connections. Refer to “Cleaning 
Connections for Accurate Measurements” on page 5-4.

Measurement Attributes

The following is a list of attributes measured for the DFB laser source test. The 
measurement attributes are displayed across the top of the display at the end 
of the initial sweep. For Repeat Sweeps, the attributes are automatically 
updated at the end of each sweep. In Single Sweep mode, a sweep must be 
initiated in order for any setting changes to take effect and for the source test 
attributes to be updated.

Peak wavelength is the wavelength at which peak amplitude occurs. Peak 
wavelength is found by searching the trace from left to right across the 
wavelength span looking for the highest trace point.
Mode Offset is the wavelength separation (in nanometers) between the main spectral 
component and the next highest mode within the current trace span. Negative values 
indicate the next highest mode lies to the left of the main mode and positive values in-
dicate the next highest mode lies to the right of the main mode.

Stop Band is the wavelength spacing between the upper and lower side modes 
adjacent to the main mode.
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N O T E If peak excursion is set too high, the Stop Band measurement will display dash lines.

Center Offset indicates how well the main mode is centered in the stop band. 
This value is the difference between the wavelength of the main spectral 
component and the mean of the upper and lower stop band component 
wavelengths.

N O T E If peak excursion is set too high, the Center Offset measurement will display dashed 
lines.

SMSR (side mode suppression ratio) is the amplitude ratio (in dB) of the main 
spectral component and the largest side mode (not necessarily the first side 
mode) within the current trace. This is affected by both the wavelength span 
and the peak excursion.

Peak Amplitude is the power level of the laser’s main spectral component.

Bandwidth is the bandwidth of the main spectral component of the DFB laser. 
Due to the narrow line width of most DFB lasers, the result of this 
measurement for an unmodulated laser is limited by the resolution bandwidth 
of the optical spectrum analyzer.
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To characterize a DFB laser

The following procedure is an example of a typical DFB laser measurement.

1 Press APPL’S > SOURCE TESTS > SOURCE TEST > SELECT DFB TEST to measure the 
distributed feedback laser’s characteristics.

2 Press MEASUREMENT SETUP  to open the Source Test Measurement Setup panel.

3 Clear the Auto Meas Span check box and enter a span of 10 nm or desired span.

4 Select ON for Auto Meas Sensitivity.

5 From the softkey menu, press CLOSE PANEL.

Tip: For turning the time and date on, press SYSTEM > MORE SYSTEM FUNCTIONS > 
SET TIME/DATE. Use the navigation keys to set the date, time, and time zone that 
are correct for your location. Press SET TIME/DATE when you are satisfied with 
your selections. The time and date will be included on the printout.
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6 Press AUTO MEAS to locate and display the laser’s response automatically.

Auto Meas locates the largest signal in the full 600 nm to 1700 nm wavelength 
range, then reduces the span to display the signal properly. The reference level 
is set automatically to the signal’s peak and the sensitivity is adjusted as 
needed. 

The source tests provide the highest level of measurement automation 
possible thereby minimizing user interaction for batch source testing. For the 
first device under test (DUT), Auto Meas is used to locate and display the 
largest input signal, and automatically adjust all parameters (center 
wavelength, reference level, display span, and sensitivity) as required by the 
test. Auto Meas functionality is modified during the source tests to not turn the 
marker on at the end of the Auto Meas operation. Repeat Sweep may be 
disabled and Single Sweep may be selected to test subsequent devices.

At the end of the sweep, the Source Test Results panel (located at the top of 
the display) displays the measurement results. For Repeat Sweeps, the results 
are automatically updated at the end of each sweep. In Single Sweep mode, a 
sweep must be initiated in order for any setting changes to take effect and for 
the source test results to be updated.

N O T E When you change a DFB laser source, you need to ensure that the trace is centered on 
the screen. Press MARKERS > PEAK SEARCH > MARKER TO CENTER > MARKER TO REF 
LEVEL. Press APPL’S to return to the source test.

7 Press PRINT to print the results to the target printer.
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Tip: To select either the internal or an external printer as the target destination, 
press SYSTEM > PRINTER SETUP.

8 To save the measurement and trace data, press SAVE/RECALL > SAVE MENU to open 
the Save Setup panel.

Select the desired Save options and then press CLOSE PANEL.

For more information on saving and printing results, refer to the Agilent 86140B 
Series Optical Spectrum Analyzer User’s Guide section on Save/Recall and 
System menus.

N O T E To properly characterize a DFB laser, the Sensitivity must be sufficient to resolve the 
DFB’s side modes. Using Auto Meas with Auto Meas Sensitivity on ensures this. When 
not using Auto Meas, be sure to use a Sensitivity setting that is sufficient to resolve side 
modes of interest.
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DFB Laser Measurement Techniques

This section explains how to customize and use some of the OSA functions to 
assist you in accurately characterizing DFB lasers.

Setting the desired vertical offset for bandwidth measurement

One of the DFB measurements is the bandwidth of the main spectral 
component. By default, the bandwidth is measured 3 dB below the peak 
wavelength. To change the bandwidth, press BANDWIDTH SELECTION...from the 
Source Test application’s softkey menu. At the next sweep, bandwidth will be 
calculated using the new value.
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The accuracy of the bandwidth measurement is affected by the following 
instrument settings:

• Wavelength span
• Trace length
• Resolution bandwidth

If the wavelength span is too wide (or the bandwidth is too narrow), there may 
not be enough trace points to calculate bandwidth accurately. Reducing the 
span increases the accuracy of the bandwidth calculated. Increasing the trace 
length also increases bandwidth accuracy.

Due to the narrow line width of most DFB lasers, the bandwidth measurement 
for an unmodulated laser is the chosen resolution bandwidth of the OSA. With 
modulation applied, lasers will chirp causing a spectral broadening. The 
resultant displayed waveform is the composite of the OSA’s resolution 
bandwidth and the modulated laser’s spectrum. When measuring the extent of 
chirp on the modulated laser, choose the narrowest resolution bandwidth 
available.

Using peak excursion to determine side modes

Peak Excursion (in dB) determines which side modes are included in the 
measurements. To qualify as a peak, the peak’s sides must rise and fall by at 
least the peak excursion. Setting the value too high may result in not 
identifying a peak. Setting the value too low may cause unwanted responses, 
including noise spikes, to be identified. The default value is 3 dB.

Using line markers to determine side modes

When Line Markers are enabled and the Integrate Limit is on, the source test 
calculations are performed within the Line Marker limits. Note that Search 
Limit and Sweep Limit do not limit the source test calculation to within the Line 
Marker limits. The Line Marker limits may be adjusted to exclude modes from 
the source test calculations. The Line Marker limit range is shared with total 
power integration. Trace Integration need not be on to use source test with 
Line Marker limits. To use Line Marker limits:

1 Press MARKERS > MORE MARKER FUNCTIONS > LINE MARKER MENU.
2 Press WAVELENGTH LINE MKR 1 and WAVELENGTH LINE MKR 2 to adjust the Line Marker 

Limits.
3 Press ADVANCED LINE MKR FUNCTIONS > INTEGRATE LIMIT ON.
4 Press APPL’S to return to the Source Test.
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Characterizing Fabry-Perot Lasers

The FP source test performs a series of automatic measurements on Fabry-
Perot lasers. All measurement results are displayed in the Source Test Results 
panel across the top of the screen.

C A U T I O N When you use improper cleaning and handling techniques, you risk expensive 
system repairs, damaged connectors, and compromised measurements. Clean 
all connectors properly before making connections. Refer to “Cleaning 
Connections for Accurate Measurements” on page 5-4.

Measurement Attributes

The following is a list of attributes measured for the Fabry-Perot laser source 
test. The measurement attributes are displayed across the top of the display at 
the end of the initial sweep. For Repeat Sweeps, the attributes are 
automatically updated at the end of each sweep. In Single Sweep mode, a 
sweep must be initiated in order for any setting changes to take effect and for 
the source test attributes to be updated.

Measurement attributes are calculated using the entire set of trace points in 
order to provide more repeatable results. This is particularly useful for devices 
that exhibit significant levels of fluctuation in the distribution of optical energy 
among the spectral modes.
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Mean Wavelength represents the center of mass of the trace points, normalized 
by the ratio of the trace point spacing and the resolution bandwidth. The power 
and wavelength of each trace point are used to calculate the mean (FWHM) 
wavelength.

where:

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined below

Peak Wavelength is the wavelength of the laser’s peak spectral component.

Mode Spacing (in nm) is the average wavelength spacing between the 
individual spectral components of the FP laser.

Mode Spacing (in GHz) is the average frequency between the individual spectral 
components of the FP laser.

FWHM (Full Width at Half Maximum) describes the spectral width of the half-
power points of the FP laser, assuming a continuous, Gaussian power 
distribution. The half-power points are those where the power spectral density 
is one-half that of the peak amplitude of the computed Gaussian curve.

where:

 is sigma as defined below

Peak Amplitude is the power level of the peak spectral component of the FP 
laser.

Total Power is the summation of the power at each trace point, normalized by 
the ratio of the trace point spacing and the resolution bandwidth.

where:

 is the power of a single trace point
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Sigma  is the rms value of the spectral width of the trace points based on a 
Gaussian distribution. The power and wavelength of each spectral component 
is used to calculate mean wavelength.

where:

 is mean wavelength (FWHM) as defined above

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined above
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To characterize a Fabry-Perot laser

The following procedure is an example of a typical FP laser measurement.

1 Press APPL’S > SOURCE TESTS > SOURCE TEST > SELECT FP TEST to measure the Fabry-
Perot laser’s characteristics.

2 Press MEASURE SETUP to open the Source Test Measurement Setup panel.

3 Verify that Auto Meas Span is set to Auto.

4 Press SYSTEM > MORE SYSTEM FUNCTIONS > AUTO MEASURE SETUP to verify that 
Optimize Sensitivity is set to OFF.

5 From the softkey menu, press CLOSE PANEL.

Tip: For turning the time and date on, press SYSTEM > MORE SYSTEM FUNCTIONS > 
SET TIME/DATE. Use the navigation keys to set the date, time, and time zone that 
are correct for your location. Press SET TIME/DATE when you are satisfied with 
your selections. The time and date will be included on the printout.
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6 Press AUTO MEAS to locate and display the laser’s response automatically.

Auto Meas locates the largest signal in the full 600 nm to 1700 nm wavelength 
range, then reduces the span to display the signal properly. The reference level 
is set automatically to the signal’s peak.

7 After Auto Meas, verify that the Sensitivity value (labeled “Sens” on the Settings 
panel located at the bottom of the OSA display) is at least 27 dB below the current 
signal reference level. This helps assure that accurate FP measurement attributes are 
being displayed. If the sensitivity is not at least 
27 dB less than the reference level, adjust the Sensitivity (press AMPLITUDE > 
SENSITIVITY) to the desired level.

Tip: Sensitivity can be reduced (improving measurement quality) by either 
adjusting Sensitivity directly or by using Video Bandwidth (BANDWIDTH/SWEEP 
> VIDEO BW > MAN). Using Video Bandwidth has the advantage of minimizing 
sweep time and averaging laser modal noise.

The source tests provide the highest level of measurement automation 
possible thereby minimizing user interaction for batch source testing. For the 
first device under test (DUT), Auto Meas is used to locate and display the 
largest input signal, and automatically adjusts parameters (center wavelength, 
reference level, and display span) as required by the test. Auto Meas 
functionality is modified during source tests to not turn the marker on at the 
end of the Auto Meas operation. Normally, the Marker automatically marks the 
peak wavelength. Repeat Sweep may be disabled and Single Sweep may be 
selected to test subsequent devices.

At the end of the sweep, the Source Test Results panel (located at the top of 
the display) displays the measurement results. For Repeat Sweeps, the results 
are automatically updated at the end of each sweep. In Single Sweep mode, a 
sweep must be initiated in order for any setting changes to take effect and for 
the source test results to be updated.

N O T E When you change an FP laser source, you need to ensure that the trace is centered on 
the screen. Press MARKERS > PEAK SEARCH > MARKER TO CENTER > MARKER TO REF 
LEVEL. Press APPL’S to return to the source test.
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8 Press PRINT to print the results to the target printer.

Tip: To select either the internal or an external printer as the target destination, 
press SYSTEM > PRINTER SETUP.

9 To save the measurement and trace data, press SAVE/RECALL > SAVE MENU to open 
the Save Setup panel.

Select the desired Save options and then press CLOSE PANEL.

For more information on saving and printing results, refer to the Agilent 86140B 
Series Optical Spectrum Analyzer User’s Guide sections on Save/Recall and 
System menus.
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Fabry-Perot Laser Measurement Techniques

This section explains how to customize and use some of the OSA functions to 
assist you in accurately characterizing Fabry-Perot lasers.

Using line markers to select spectral modes

When Line Markers are enabled and the Integrate Limit is on, the source test 
calculations are performed within the Line Marker limits. Note that Search 
Limit and Sweep Limit do not limit the source test calculation to within the Line 
Marker limits. The Line Marker limits may be adjusted to exclude modes from 
the source test calculations. The Line Marker limit range is shared with total 
power integration. Trace Integration need not be on to use source test with 
Line Marker limits. To use Line Marker limits:

1 Press MARKERS > MORE MARKER FUNCTIONS > LINE MARKER MENU.

2 Press WAVELENGTH LINE MKR 1 and WAVELENGTH LINE MKR 2 to adjust the Line Marker 
Limits.

3 Press ADVANCED LINE MKR FUNCTIONS > INTEGRATE LIMIT ON.
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4 Press APPL’S to return to the Source Test application.
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Characterizing LEDs

The LED source test performs a series of automatic measurements on light 
emitting diodes. All measurement results are displayed in the Source Test 
Results panel at the top of the screen. The LED measurement calculations 
compensate for the expected change in resolution bandwidth versus 
wavelength.

C A U T I O N When you use improper cleaning and handling techniques, you risk expensive 
system repairs, damaged connectors, and compromised measurements. Clean 
all connectors properly before making connections. Refer to “Cleaning 
Connections for Accurate Measurements” on page 5-4.
2-24



Source Test Application

Characterizing LEDs
Measurement Attributes

The following is a list of attributes measured for the LED source test. The 
measurement attributes are displayed across the top of the display at the end 
of the initial sweep. For Repeat Sweeps, the attributes are automatically 
updated at the end of each sweep. In Single Sweep mode, a sweep must be 
initiated in order for any setting changes to take effect and for the source test 
attributes to be updated.

Mean (FWHM) represents the center of mass of the trace points, normalized by 
the ratio of the trace point spacing and the resolution bandwidth. The power 
and wavelength of each trace point are used to calculate the mean (FWHM) 
wavelength.

where:

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined below

Mean (3dB) is the average of the two wavelengths that are 3 dB (half-power) 
below the peak wavelength.

Peak Wavelength is the wavelength at which the peak of the LED spectrum 
occurs.

Mean FWHM( )
Pi

Po
------

trace point spacing

resolution bandwidth
----------------------------------------------------------------------
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Sigma is the rms value of the spectral width of the LED based on a Gaussian 
distribution. The power and wavelength of each spectral component are used 
to calculate sigma.

where:

 is mean wavelength (FWHM) as defined below

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined below

FWHM (Full Width at Half Maximum) describes the spectral width of the half-
power (-3 dB) points of the LED, assuming a continuous, Gaussian power 
distribution. The half-power points are those where the power spectral density 
is one-half that of the peak amplitude of the computed Gaussian curve.

where:

 is sigma as defined above

3 dB Width describes the spectral width of the LED based on the separation of 
two wavelengths. Each wavelength has a power spectral density equal to one-
half the peak power spectral density. The 3 dB width is determined by finding 
the peak of the LED spectrum, and dropping 3 dB on each side.

sigma
Pi

Po
------

trace point spacing

resolution bandwidth
----------------------------------------------------------------------
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Total Power is the summation of the power at each trace point, normalized by 
the ratio of the trace point spacing and the resolution bandwidth. This 
normalization is required because the spectrum of the LED is continuous, 
rather than containing discrete spectral components (as a laser does).

where:

 is the power of a single trace point

Pk Density (0.1 nm or 1.0 nm) is the power spectral density (normalized to a 
0.1 nm or 1.0 nm bandwidth) of the LED at the peak wavelength.

Total Power Pi

trace point spacing

resolution bandwidth
----------------------------------------------------------------------
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To characterize an LED laser

The following procedure is an example of a typical LED laser measurement.

1 Press APPL’S > SOURCE TESTS > SOURCE TEST > SELECT LED TEST to measure the light 
emitting diode’s characteristics.

2 Press MEASURE SETUP to open the Source Test Measurement Setup panel.

3 Verify the Auto Meas Span is set to Auto.

4 Verify the Optimize Sensitivity is set to OFF.

5 From the softkey menu, press CLOSE PANEL.

Tip: For turning the time and date on, press SYSTEM > MORE SYSTEM FUNCTIONS > 
SET TIME/DATE. Use the navigation keys to set the date, time, and time zone that 
are correct for your location. Press SET TIME/DATE when you are satisfied with 
your selections. The time and date will be included on the printout.
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6 Press AUTO MEAS to locate and display the laser’s response automatically.

Auto Meas locates the largest signal in the full 600 nm to 1700 nm wavelength 
range, then reduces the span to display the signal properly. The reference level 
is set automatically to the signal’s peak and the sensitivity is adjusted as 
needed. 

The source tests provide the highest level of measurement automation 
possible thereby minimizing user interaction for batch source testing. For the 
first device under test (DUT), Auto Meas is used to locate and display the 
largest input signal, and automatically adjust all parameters (center 
wavelength, reference level, and display span) as required by the test. Auto 
Meas functionality is modified during source tests to not turn the marker on at 
the end of the Auto Meas operation. Normally, the Marker automatically marks 
the peak wavelength. Repeat Sweep may be disabled and Single Sweep may be 
selected to test subsequent devices.

At the end of the sweep, the Source Test Results panel (located at the top of 
the display) displays the measurement results. For Repeat Sweeps, the results 
are automatically updated at the end of each sweep. In Single Sweep mode, a 
sweep must be initiated in order for any setting changes to take effect and for 
the source test results to be updated.

N O T E When you change an LED source, you need to ensure that the trace is centered on the 
screen. Press MARKERS > PEAK SEARCH > MARKER TO CENTER > MARKER TO REF LEVEL. 
Press APPL’S to return to the Source Test application.

7 Press PRINT to print the results to the target printer.

Tip: To select either the internal or an external printer as the target destination, 
press SYSTEM > PRINTER SETUP.

8 To save the measurement and trace data, press SAVE/RECALL > SAVE MENU to open 
the Save Setup panel.

Select the desired Save options and then press CLOSE PANEL.

For more information on saving and printing results, refer to the Agilent 86140B 
Series Optical Spectrum Analyzer User’s Guide sections on Save/Recall and 
System menus.
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LED Measurement Techniques

This section explains how to customize and use some of the OSA functions to 
assist you in accurately characterizing LEDs.

Using line markers

When Line Markers are enabled and the Integrate Limit is on, the source test 
calculations are performed within the Line Marker limits. Note that Search 
Limit and Sweep Limit do not limit the source test calculation to within the Line 
Marker limits. The Line Marker limits may be adjusted to include only the 
desired portion of the trace in the source test calculations. The Line Marker 
limit range is shared with total power integration. Trace Integration need not be 
on to use the source test with Line Marker limits. To use Line Marker limits:

1 Press MARKERS > MORE MARKER FUNCTIONS > LINE MARKER MENU.

2 Press WAVELENGTH LINE MKR 1 and WAVELENGTH LINE MKR 2 to adjust the Line Marker 
Limits.

3 Press ADVANCED LINE MKR FUNCTIONS > INTEGRATE LIMIT ON.

4 Press APPL’S to return to the Source Test application.
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Source Test Application Remote Commands

The CALC: section of the Agilent 86140B Series Optical Spectrum Analyzer 
User’s Guide provides detailed information on remote programming of the 
instrument. Only commands unique to the Source Test application are included 
in this chapter with the following exceptions:

Center of Mass, Sigma, and FWHM calculations are supported via remote 
commands without entering the Source Test application. These commands are 
documented below and also in the Remote Operation chapter in the Agilent 
86140B Series Optical Spectrum Analyzer User’s Guide.

N O T E Launching another OSA application remotely, such as Passive Component Test, will 
automatically disable any active source test. Initiating a source test from within another 
application is not supported.
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Command Conventions

Table 1

Convention  Description 

< > Angle brackets indicate text strings entered by the developer.

[ ] Square brackets indicate that the keyword DEFAULT can be used instead 
of a value or a variable for that parameter. Refer to the actual command 
description for the behavior when the DEFAULT keyword is used for a 
parameter.

| Indicates a choice of one element from a list.

{ } Braces indicate a group of constants to select from. Each constant is 
separated by the | character.

name Indicates the variable for which you provide a descriptive name. Any letter 
(Aa-Zz) followed by letters, digits (0-9) and underscore (_). Only the first 32 
characters are significant.

spec_min –infinity. The parameter spec_min cannot be a variable, only a constant or 
DEFAULT.

spec_max +infinity. The parameter spec_max cannot be a variable, only a constant or 
DEFAULT.

from  Start wavelength or frequency of trace in nm (default) or THz.

to  Stop wavelength or frequency of trace in nm (default) or THz.

excursion +excursion: means excursion dBs up (for example, from a pit). 
-excursion: means excursion dBs down (for example, from a peak).

ref_pt The reference point to be used for a measurement keyword.
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CALCulate Subsystem Commands 

The CALCulate subsystem performs post-acquisition data processing. The 
CALCulate subsystem operates on data acquired by a SENSe function.

Trace A corresponds to CALC 1, Trace B corresponds to CALC 2, and so on. Only 
one of each calculation (that is, Source Test, Center of Mass, or FWHM) may be 
on. For example, if FWHM is on for Trace A, turning FWHM on for Trace B will 
disable the FWHM for Trace A.

CALCulate[1|2|3|4|5|6]:SOURce:TEST DFB | FP | LED | OFF

CALCulate[1|2|3|4|5|6]:SOURce:TEST?

Initiates a source test measurement or disables the active suite. Only a single 
measurement suite may be on at a time (also operates exclusively with 
applications: Passive Component Test (PCT), Wavelength Division Multiplexing 
(WDM), and Amplifier Test applications). off disables all suites. Calculations 
are performed at the end of each sweep.

CALCulate[1|2|3|4|5|6]:SOURce:[DATA]?

Retrieves the results of the currently active source test measurement suite. 
The data is returned in either ASCII or binary form as determined by the 
FORMat:DATA command. Requesting results from a trace not selected in the 
CALCulate[1|2|3|4|5|6]:SOURce:TEST command returns a “Settings 
conflict” error.

Error values are indicated by returning the number: 9.91e+37. This value is 
defined by the SCPI standard to represent NaN (not a number). This indicates 
that the source test was unable to perform the particular measurement. 
Results will be returned in the order as shown below.
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Table 2 Source Test Measurement Parameters

Source Test Measurement Parameter Units

DFB Test Peak Wavelength Meters

Mode Offset Meters

Stop Band Meters

Center Offset Meters

SMSR dB

Peak Amplitude dBm

Bandwidth Meters

Bandwidth Amplitude dB

FP Test Mean Wavelength Meters

Peak Wavelength Meters

Mode Spacing (M) Meters

Mode Spacing (Hz) Hertz

FWHM Meters

Peak Amplitude dBm

Total Power dBm

Sigma Meters

LED Test Mean (FWHM) Wavelength Meters

Mean Wavelength (3 dB down) Meters

Peak Wavelength Meters

Sigma Meters

FWHM Meters

Width at 3 dB down Meters

Total Power dBm

Peak Spectral Density (1.0 nm or 0.1 nm) 
depending on Noise Marker Reference 
Bandwidth

dBm
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CALCulate:SOURce:FUNCtion:BWIDth | BANDwidth:NDB <numeric_value> 

CALCulate:SOURce:FUNCtion:BWIDth | BANDwidth:NDB?

Sets the desired vertical offset from the peak wavelength for the DFB source 
test bandwidth calculation. The default value is -3 dB. The parameter units are 
as specified in the UNIT:RATio command. This value can be set or queried 
anytime. The DFB source test does not need to be on. The new bandwidth 
value will be used on the next sweep. The offset value applies to all DFB source 
test bandwidth calculations.

CALCulate[1|2|3|4|5|6]:CENTermass:STATe OFF | ON | 0 | 1

Turns the Center of Mass (Mean Wavelength) calculation on. Trace A 
corresponds to CALC 1, Trace B corresponds to CALC 2, and so on. Only one 
Center of Mass calculation may be on. For instance, if Center of Mass is on for 
Trace A, turning Center of Mass on for Trace B will disable the Center of Mass 
calculation for Trace A. The data is returned in either ASCII or binary form as 
determined by the FORMat:DATA command.

The Center of Mass of the trace points is normalized by the ratio of the trace 
point spacing and the resolution bandwidth. The power and wavelength of 
each trace point are used to calculate the Center of Mass. The formula used is:

where:

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined below

Center of Mass
Pi

Po
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trace point spacing

resolution bandwidth
----------------------------------------------------------------------
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Total Power is the summation of the power at each trace point, normalized by 
the ratio of the trace point spacing and the resolution bandwidth. The formula 
used is:

where:

 is the power of a single trace point

CALCulate[1|2|3|4|5|6]:CENTermass:[DATA]?

Returns the Center of Mass calculation results in meters. Trace A corresponds 
to CALC 1, Trace B corresponds to CALC 2, and so on. Corrections to all 
calculations are made for the slope and variation of the resolution bandwidth 
filter over the wavelength range of the trace. When 
CALCulate:TPOWer:IRANge is on, the calculation is performed over the upper 
and lower range limits. All calculations (that is, SOURce, CENTermass, FWHM, 
SIGMA, and TPOWer) share the same line marker limits. Sending this query 
when the CALCulate:CENTermass:STATe is off will generate a “Settings 
conflict” error. If the Center of Mass calculation cannot be performed, the 
number 9.91e+37 is returned. This value is defined by the SCPI standard to 
represent NaN (not a number).

CALCulate[1|2|3|4|5|6]:FWHM:STATe OFF | ON | 0 | 1

Turns the Full Width Half Maximum (FWHM) calculation on. Trace A 
corresponds to CALC 1, Trace B corresponds to CALC 2, and so on. Only one of 
each calculation may be on. For instance if FWHM is on for Trace A, turning 
FWHM on for Trace B will disable the FWHM calculation for Trace A. The data 
is returned in either ASCII or binary form as determined by the FORMat:DATA 
command.

FWHM (Full Width at Half Maximum) describes the spectral width of the half-
power (-3 dB) points of the trace, assuming a continuous, Gaussian power 
distribution. The half-power points are those where the power spectral density 
is one-half that of the peak amplitude. The formula used is:

where:  is sigma as defined in CALCulate:SIGMa

Total Power Pi

trace point spacing

resolution bandwidth
----------------------------------------------------------------------
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CALCulate[1|2|3|4|5|6]:FWHM: [DATA]?

Returns the FWHM calculation results in meters. Trace A corresponds to CALC 
1, Trace B corresponds to CALC 2, and so on. Corrections to all calculations are 
made for the slope and variation of the resolution bandwidth filter over the 
wavelength range of the trace. When CALCulate:TPOWer:IRANge is on, the 
calculation is performed over the upper and lower range limits. All calculations 
(that is, SOURce, CENTermass, FWHM, SIGMA, and TPOWer) share the same 
line marker limits. Sending this query when the CALCulate:FWHM:STATe is off 
will generate a “Settings conflict” error. If the FWHM calculation cannot be 
performed, the number 9.91e+37 is returned. This value is defined by the SCPI 
standard to represent NaN (not a number).

CALCulate[1|2|3|4|5|6]:SIGMa: [DATA]?

Returns the sigma calculation results in meters. 

Sigma is the rms value of the spectral width of the trace points based on a 
Gaussian distribution. The power and wavelength of each spectral component 
is used to calculate mean wavelength.

where:

 is mean wavelength (Center of Mass) as defined in CALC:CENT

 is the wavelength of a single trace point

 is the power of a single trace point

 is total power as defined in CALC:CENT

sigma
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CALCulate:FWHM:STATe must be on for this query. Trace A corresponds to 
CALC 1, Trace B corresponds to CALC 2, and so on. Corrections to all 
calculations are made for the slope and variation of the resolution bandwidth 
filter over the wavelength range of the trace. When 
CALCulate:TPOWer:IRANge is on, the calculation is performed over the upper 
and lower range limits. All five common calculation ranges (that is, SOURce, 
CENTermass, FWHM, SIGMA, and TPOWer) share the same limits. Sending a 
CALCulate:SIGMa? query when the CALCulate:FWHM:STATe is off will 
generate a “Settings conflict” error. If the Sigma calculation cannot be 
performed, the number 9.91e+37 is returned. This value is defined by the SCPI 
standard to represent NaN (not a number).

CALCulate[1|2|3|4|5|6]:TPOWer:IRANge:LOWer 
<numeric_value>[M|UM|NM|A|HZ|KHZ|MHZ|GHZ|THZ]

CALCulate[1|2|3|4|5|6]:TPOWer:IRANge:LOWer?

Sets the lower X-axis limit range for the TPOWer, SOURce, CENTermass, 
FWHM, and SIGMa calculations for all traces. Setting this value when the 
CALCulate:TPOWer:IRANge[:STATe] is off will automatically turn the 
CALCulate:TPOWer:IRANge[:STATe] on. The range used for the total power 
integration is the same range used for the marker search range, the trace mean 
range, and the wavelength range. Changing the range with this command will 
change all four ranges. 

Default units for the parameter are meters. Sending the command when the 
instrument is in a zero span will generate a “Settings conflict” error.

CALCulate[1|2|3|4|5|6]:TPOWer:IRANge:UPPer 
<numeric_value>[M|UM|NM|A|HZ|KHZ|MHZ|GHZ|THZ]

CALCulate[1|2|3|4|5|6]:TPOWer:IRANge:UPPer? 

Sets the upper X-axis limit range for the TPOWer, SOURce, CENTermass, 
FWHM, and SIGMa calculations for all traces. Setting this value when the 
CALCulate:TPOWer:IRANge[:STATe] is off will automatically turn the 
CALCulate:TPOWer:IRANge[:STATe] on. The range used for the total power 
calculation is the same range used for the marker search range, the trace mean 
range and the wavelength range. Changing the range with this command will 
change all four ranges. 
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Default units for the parameter are meters. Sending the command when the 
instrument is in a zero span will generate a “Settings conflict” error.

CALCulate:MARKer:FUNCtion:NOISe:BWIDth|BANDwidth <numeric_value>

CALCulate:MARKer:FUNCtion:NOISe:BWIDth|BANDwidth?

Sets the normalization bandwidth for the marker noise result query and the 
LED source test peak density calculation. The default units for the parameter 
are meters. There are only two allowable settings: 1.0 nm and 0.1 nm. Sending 
any value outside this range will generate a "Data out of range" error. Sending 
a value within this range will set the bandwidth to whichever of the two 
possible settings is closest to the specified value.
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CALibration Subsystem Commands

This subsystem has the function of performing system calibration. 

CALibration Alignment

Performs an automatic alignment of the instrument at the wavelength of the 
largest signal found in full span. This aligns the monochromator output with 
the photodetector for improved amplitude accuracy. Sending this command 
with a marker on screen will generate a Settings conflict error.

Syntax CAL:ALIG

Related Key Auto Align
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Equivalent Commands from the 71450 to the 86140B

The following table provides a list of the Agilent 71450 series commands and 
the SCPI equivalent commands for the Agilent 86140B series analyzers. The 
results are returned in the same order as Table 2 on page 2-34.

NOTE: For the 86140B series OSA, any space(s) or characters between a token 
(_) and the query (?) symbol are not supported. For example:

FP_ ? will not work on the 86140B series OSA, but will work for the 
71450 series OSA. FP_? will work on the 86140B series OSA.

N O T E All legacy source test commands operate on the currently active trace.
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Table 3 Equivalent Commands from the 71450 to the 86140B

71450 Series 
Command

86140B Series Command Description

DFB Command

DFB_ CALCulate:SOURce:TEST DFB Start DFB laser source 
test

DFB_? CALCulate:SOURce:[DATA]? Return DFB 
measurement suite 
results

DFB_B Not supported Turn stop band peaks 
view ON or OFF

DFB_C Not supported Turn SMSR view ON 
or OFF 

DFB_O Not supported, use 
CALCulate:SOURce:TEST OFF

Turn calculation ON or 
OFF

DFB_Q CALCulate:SOURce:TEST OFF Exit DFB laser source 
test

DFB_Z DISP:WIND:TRAC:ALL:SCALE:
AUTO:OPT prior to Auto Meas

Enable Sensitivity 
Optimization function

FP Command

FP_ CALCulate:SOURce:TEST FP Start FP laser source 
test

FP_? CALCulate:SOURce:[DATA]? Return FP 
measurement suite 
results

FP_B Not supported Turn peaks view ON or 
OFF

FP_C Not supported Turn distribution view 
ON or OFF

FP_G Not supported Select envelope 
distribution

FP_K Default Select Gaussian 
distribution

FP_L Not supported Select Lorenzian 
distribution
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Sample Programs

The following are sample programs for the Source Test measurement, DFB, FP 
and LED remote control commands.

FP_MKBW Not supported Set envelope 
bandwidth amplitude

FP_O Not supported, use 
CALCulate:SOURce:TEST OFF

Turn calculation ON or 
OFF

FP_Q CALCulate:SOURce:TEST OFF Exit FP laser source 
test

FP_TH Not supported Set Peak Threshold
LED Command

LED_ CALCulate:SOURce:TEST LED Start LED laser source 
test

LED_? CALCulate:SOURce:[DATA]? Return LED 
measurement suite 
results

LED_B Not supported Turn integration 
window trace ON or 
OFF

LED_C Not supported Turn distribution view 
ON or OFF

LED_K Default Select Gaussian 
distribution

LED_L Not supported Select Lorenzian 
distribution

LED_O Not supported, use 
CALCulate:SOURce:TEST OFF

Turn calculation ON or 
OFF

LED_Q CALCulate:SOURce:TEST OFF Exit LED laser source 
test

71450 Series 
Command

86140B Series Command Description
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Source Test measurements sample commands

10    ! Program to demonstrate the new commands for source measurements.
20    ! The center of mass and FWHM routines are used to measure LED source.
30    !
40    ! re-store "newcommands"
50    !
60    ASSIGN @Osa TO 723;EOL CHR$(12) END ! Set command terminator to LF & EOI
70    !
80    PRINTER IS "results.txt"
90    !
100   !   ***   Setup OSA for measurement   ***
110   !
120   OUTPUT @Osa;"*rst" ! Preset OSA
130   !
140   OUTPUT @Osa;"sens:wav:star 1440nm" ! Set start wavelength
150   OUTPUT @Osa;"sens:wav:stop 1660nm" ! Set stop wavelength
160   !
170   OUTPUT @Osa;"disp:wind:trac:y1:scal:rlev -20.0dbm" ! Set reference level
180   OUTPUT @Osa;"sens:pow:dc:rang:low -60dbm" ! Set sensitivity required
190   OUTPUT @Osa;"sens:bwid:res 5nm" ! Set resolution bandwidth
200   !
210   OUTPUT @Osa;"calc:cent:stat on" !Enable center of mass measurement
220   OUTPUT @Osa;"calc:fwhm:stat on" ! Enable FWHM measurement
230   !
240   !   ***   Initiate measurement   ***
250   !
260   OUTPUT @Osa;"init:imm" ! Take sweep to update display
270   !
280   OUTPUT @Osa;"calc:cent? ! Request mean WL
290   ENTER @Osa;Meanwl
300   OUTPUT @Osa;"calc:fwhm?" ! Request FWHM
310   ENTER @Osa;Fwhm
320   OUTPUT @Osa;"calc:sigma?" ! Request sigma
330   ENTER @Osa;Sigma
340   !
350   !   ***   Print measurement results   ***
360   !
370   PRINT
380   PRINT "Command Measurement results"
390   PRINT
400   PRINT "Mean Wavelength (m)",Meanwl
410   PRINT "FWHM (m)",Fwhm
420   PRINT "Sigma (m)",Sigma
430   !
440   OUTPUT @Osa;"calc:cent:stat off" ! Turn off measurement
450   OUTPUT @Osa;"calc:Fwhm:stat off" ! Turn off measurement
460   !
470   LOCAL @Osa ! Release OSA to local control
480   !
490  END

Command Measurement results

Mean Wavelength (m)  1.55280884E-6 
FWHM (m)   5.41096035E-8 
Sigma (m)  2.29764771E-8
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DFB Sample Remote Control Commands:

10    ! Program to demonstrate remote control of the source application.
20    ! The measurement is completed and the data returned.
30    !
40    ! re-store "DFBsource"
50    !
60    ASSIGN @Osa TO 723;EOL CHR$(12) END ! Set command terminator to LF & EOI
70    !
80  ! PRINTER IS "results.txt"
90    !
100   !   ***   Setup OSA for measurement   ***
110   !
120   OUTPUT @Osa;"*rst" ! Preset OSA
130   OUTPUT @Osa;"calc:sour:test dfb" ! Select DFB source measurement
140   !
150   OUTPUT @Osa;"sens:wav:cent 1562nm" ! Set center frequency and span
160   OUTPUT @Osa;"sens:wav:span 20nm"

! for typical measurement
170   !
180   OUTPUT @Osa;"disp:wind:trac:y1:scal:rlev 0dbm" ! Set reference level
190   OUTPUT @Osa;"sens:pow:dc:rang:low -60dbm" ! Set sensitivity required
200   OUTPUT @Osa;"sens:bwid:res 0.1nm" ! Set resolution bandwidth
210   !
220   OUTPUT @Osa;"calc:mark:pexc:peak 3.0db" ! Set peak excursion
230   OUTPUT @Osa;"calc:sour:func:bwid:ndb -6.0db" ! Set vertical offset for BW
240   !
250   !   ***   Initiate measurement   ***
260   !
270   OUTPUT @Osa;"init:imm" ! Take sweep to update display
280   !
290   OUTPUT @Osa;"calc:sour?" ! Request measurement data
300   ENTER @Osa;Peakwl,Moffs,Stopb,Coffs,Smsr,Peaka,Bw,Bwamp
310   !
320   !   ***   Print measurement results   ***
330   !
340   PRINT
350   PRINT "DFB Measurement results"
360   PRINT
370   PRINT "Peak Wavelength (m)",Peakwl
380   PRINT "Mode Offset (m)",Moffs
390   PRINT "Stop Band (m)",Stopb
400   PRINT "Center Offset",Coffs
410   PRINT "SMSR (dB)",Smsr
420   PRINT "Peak Amplitude (dBm)",Peaka
430   PRINT "Bandwidth (m)",Bw
440   PRINT "Bandwidth Amplitude (dB)",Bwamp
450   !
460   OUTPUT @Osa;"calc:sour:test off" ! Turn off source measurement
470   !
480   LOCAL @Osa ! Release OSA to local control
490   !
500  END
2-45



Source Test Application

Source Test Application Remote Commands
DFB Measurement results

Peak Wavelength (m)  1.56194E-6 
Mode Offset (m)     -9.4E-10 
Stop Band (m)        2.26E-9 
Center Offset       -1.9E-10 
SMSR (dB)  39.7615558 
Peak Amplitude (dBm)-.538451274 
Bandwidth (m)        1.4E-10 
Bandwidth Amplitude (dB)      -6
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FP Sample Remote Control Commands

10    ! Program to demonstrate remote control of the source application.
20    ! The measurement is completed and the data returned.
30    !
40    ! re-store "FPsource"
50    !
60    ASSIGN @Osa TO 723;EOL CHR$(12) END ! Set command terminator to LF & EOI
70
80    PRINTER IS "results.txt"
90    !
100   !   ***   Setup OSA for measurement   ***
110   !
120   OUTPUT @Osa;"*rst" ! Preset OSA
130   OUTPUT @Osa;"calc:sour:test fp" ! Select FP source measurement
140   !
150   OUTPUT @Osa;"sens:wav:star 1540nm" ! Set start wavelength
160   OUTPUT @Osa;"sens:wav:stop 1560nm" ! Set stop wavelength
170   !
180   OUTPUT @Osa;"disp:wind:trac:y1:scal:rlev -10.0dbm"! Set reference level
190   OUTPUT @Osa;"sens:pow:dc:rang:low -60dbm" ! Set sensitivity required
200   OUTPUT @Osa;"sens:bwid:res 0.2nm" ! Set resolution bandwidth
210   !
220   !   ***   Initiate measurement   ***
230   !
240   OUTPUT @Osa;"init:imm" ! Take sweep to update display
250   !
260   OUTPUT @Osa;"calc:sour? ! Request measurement data
270   ENTER @Osa;Meanwl,Peakwl,Modespm,Modesph,Fwhm,Peaka,Tpow,Sigma
280   !
290   !   ***   Print measurement results   ***
300   !
310   PRINT
320   PRINT "FP Measurement results"
330   PRINT
340   PRINT "Mean Wavelength (m)",Meanwl
350   PRINT "Peak Wavelength (m)",Peakwl
360   PRINT "Mode Spacing (m)",Modespm
370   PRINT "Mode Spacing (Hz)",Modesph
380   PRINT "FWHM (m)",Fwhm
390   PRINT "Peak Amplitude (dBm)",Peaka
400   PRINT "Total Power (dBm)",Tpow
410   PRINT "Sigma (m)",Sigma
420   !
430   OUTPUT @Osa;"calc:sour:test off" ! Turn off source measurement
440   !
450   LOCAL @Osa ! Release OSA to local control
460   !
470  END
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FP Measurement results

Mean Wavelength (m)  1.54976934E-6 
Peak Wavelength (m)  1.55002E-6 
Mode Spacing (m)     1.13777778E-9 
Mode Spacing (Hz)    1.42018207E+11 
FWHM (m)   2.86935505E-9 
3 dB Width (m)       0 
Peak Amplitude (dBm)-9.93317222 
Total Power (dBm)   -9.12593026 
Sigma (m)  1.21840979E-9
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LED Sample Remote Control Commands

10    ! Program to demonstrate remote control of the source application.
20    ! The measurement is completed and the data returned.
30    !
40    ! re-store "LEDsource"
50    !
60    ASSIGN @Osa TO 723;EOL CHR$(12) END ! Set command terminator to LF & EOI
70    !
80    PRINTER IS "results.txt"
90    !
100   !   ***   Setup OSA for measurement   ***
110   !
120   OUTPUT @Osa;"*rst" ! Preset OSA
130   OUTPUT @Osa;"calc:sour:test led" ! Select LED source measurement
140   !
150   OUTPUT @Osa;"sens:wav:star 1440nm" ! Set start wavelength
160   OUTPUT @Osa;"sens:wav:stop 1660nm" ! Set stop wavelength
170   !
180   OUTPUT @Osa;"disp:wind:trac:y1:scal:rlev -20.0dbm" ! Set reference level
190   OUTPUT @Osa;"sens:pow:dc:rang:low -60dbm" ! Set sensitivity required
200   OUTPUT @Osa;"sens:bwid:res 5nm" ! Set resolution bandwidth
210   OUTPUT @Osa;"calc:mark:func:nois:band 1nm" ! Set noise reference to 1 nm
220   !
230   !   ***   Initiate measurement   ***
240   !
250   OUTPUT @Osa;"init:imm" ! Take sweep to update display
260   !
270   OUTPUT @Osa;"calc:sour?" ! Request measurement data
280   ENTER @Osa;Meanwlf,Meanwl,Peakwl,Sigma,Fwhm,Bwidth,Tpow,Peaksd
290   !
300   !   ***   Print measurement results   ***
310   !
320   PRINT
330   PRINT "LED Measurement results"
340   PRINT
350   PRINT "Mean (FWHM) Wavelength (m)",Meanwlf
360   PRINT "Mean Wavelength (m)",Meanwl
370   PRINT "Peak Wavelength (m)",Peakwl
380   PRINT "Sigma (m)",Sigma
390   PRINT "FWHM (m)",Fwhm
400   PRINT "3 dB Width (m)",Bwidth
410   PRINT "Total Power (dBm)",Tpow
420   PRINT "Peak Spectral Density (dBm)",Peaksd
430   !
440   OUTPUT @Osa;"calc:sour:test off" ! Turn off source measurement
450   !
460   LOCAL @Osa ! Release OSA to local control
470   !
480  END
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LED Measurement results

Mean (FWHM) Wavelength (m)     1.55273635E-6 
Mean Wavelength (m)  1.55099E-6 
Peak Wavelength (m)  1.55E-6 
Sigma (m)  2.29537883E-8 
FWHM (m)   5.40561714E-8 
3 dB Width (m)       4.862E-8 
Total Power (dBm)   -10.333219 
Peak Spectral Density (dBm)   -27.5968118
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About the Application
About the Application

The Passive Component Test application simplifies the complex 
characterization and testing of passive components. The application includes 
guided setups to prompt you through the measurement procedure. When the 
setup is complete the application performs an automatic pass/fail check 
against your custom specifications.

The application can easily be customized for your particular devices by 
modifying the specification files using either a text editor or a Microsoft®1 
Excel spreadsheet template wizard. The template wizard can be downloaded 
from the web. For more information, refer to “Excel Template Wizard for the 
PCT Application” on page 3-23.

To perform a measurement, you must run a specification file. Specification files 
configure the settings of the instrument, describe measurements, and direct 
the printing or saving of the measurement results. Specification files can be 
stored and loaded from the internal memory of the optical spectrum analyzer, or 
imported from a disk.

Because specification sets are stored in the internal memory of the optical 
spectrum analyzer, you can easily switch between tests. Refer to “Designing 
Specification Sets” on page 3-22 to learn how to design your own specification 
files.

It is easy to learn how to design and write specification files. Anyone with a 
basic understanding of how to operate the optical spectrum analyzer can learn 
how to design specification sets in approximately one hour. This is a small 
investment considering the time you’ll save testing your devices.

Figure 1 and Figure 2 on page 3-4 show the measurement screen and the table 
of results displayed after a measurement has been taken.

1. Microsoft® is a U.S. registered trademark of Microsoft Corp. 
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Figure 1 The Measurement screen
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Figure 2 A table of results
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The Passive Component Test Menus

The application softkeys are accessed using the front-panel APPL’S key or the 
Applications menu, Launch an Installed Application selection on the menu bar.
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Performing Measurements

This section explains how to load and use the Passive Components Test 
application. 

Measurements are performed using either the instrument’s internal broadband 
EELED or white-light source, or an external broadband source. You can test 
passive devices having any number of light paths, such as filters and couplers 
and WDM multiplexers. 

To use the Passive Components Test application you must:

1 Start the application, see “To start the Passive Components Test application” on page 
3-7.

2 Load a specification set from internal memory, see “To load an existing specification 
set” on page 3-11, or import a specification set from a floppy disk, see “To import a 
specification set” on page 3-9.

3 Perform a normalization if required, see “To run the source normalization routines” 
on page 3-13. The application automatically detects whether normalization is 
required.

4 Measure the device under test, see “To measure the device under test” on page 3-14.

You can then:

• Save the results, see “To save the results to floppy” on page 3-15.

• Print the results, see “To print the results” on page 3-15.

• View the results in a table, see “To display a table of the results” on page 3-16.
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To start the Passive Components Test application

1 Press the front-panel APPL’S key or the Applications menu Launch an Installed 
Application selection.

2 The following screen is displayed.

Figure 3 Applications Panel and Menu

The panel and the menu change whenever an application is installed or 
uninstalled. Each installed application has an icon on the panel and a 
corresponding softkey. 

3 Press the PASSIVE COMPONENTS softkey. The loading of the application is indicated by 
the on-screen message, “Loading Passive Component Application, Please Wait...”. 
When the application is loaded, the name of the selected set appears on the SPEC 
SET.... softkey. The application is now ready for use. 

The following functions assume the application is loaded.
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To select a specification set

1 Press the SPEC SET.... <SPEC SET> softkey.

You can now load an existing specification set, import a new specification set 
from a floppy disk, or delete an existing specification set from the internal 
memory of the OSA. If no specification sets are available, the default 
specification set is loaded.
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To import a specification set

1 Insert the floppy disk containing the specification set into the internal floppy disk 
drive of the OSA.

2 Press the SPEC SET.... <SPEC SET> softkey.

N O T E Specification set file names must conform to the MS-DOS 8.3 file name convention, a 
maximum of 8 characters.

3 Press the IMPORT SPEC SET.... softkey.

A list of the externally stored specification sets is displayed. 

4 Use the navigation keys to select the desired specification set.

5 Press the IMPORT SET softkey.

The selected specification set is imported into the internal memory of the OSA. 
When a specification set is imported it is checked for errors and “compiled” 
before being copied into internal storage. 
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If errors are detected in the specification set being imported, the SHOW 
WARNINGS.... softkey appears. Press the SHOW WARNINGS.... softkey, then the PREV 
and NEXT softkeys to display a detailed description of the error.

If no errors are detected, the file is automatically copied to internal memory, 
loaded, and the application returns to the previous menu. 
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Performing Measurements
To load an existing specification set

1 Press the SPEC SET.... <SPEC SET> softkey.

2 Press the LOAD SPEC SET.... softkey.

A list of the internally stored specification sets is displayed. A specification set 
must be imported from a floppy disk into the internal memory of the OSA before 
it can be loaded. For information on importing specification sets, see “To import 
a specification set” on page 3-9. 

If no specification sets have been previously imported, the Load Spec Set list 
will contain the Default specification set. 

3 Use the navigation keys to select the desired specification set.

4 Press the LOAD SET softkey.

The currently selected specification set is loaded and you are returned to the 
previous softkey menu. While the specification set is being loaded, the 
message “Loading Spec Set <spec set name>, Please Wait...” is displayed. 
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Performing Measurements
To export a specification set

1 Press the SPEC SET.... <SPEC SET> softkey.

2 Press the EXPORT SPEC SET.... softkey. A list of the internally stored specification sets 
is displayed. 

3 Use the navigation keys to select the desired specification set and then press the 
EXPORT SET softkey. The CSV specification set file from internal memory is output to 
the floppy disk.

To delete a specification set

1 Press the SPEC SET.... <SPEC SET> softkey.

2 Press the DELETE SPEC SET.... softkey. A list of the internally stored specification sets 
is displayed. 

3 Use the navigation keys to select the specification set to be deleted and then press 
the DELETE SPEC SET softkey. The currently selected specification set is deleted from 
internal memory. After the file is deleted, the application returns to the previous 
menu.
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To run the source normalization routines

N O T E The application will automatically detect if a normalization is required and will run the 
routine before the next measurement is made. The time interval between 
normalizations is specified in the specification set.

1 Load the desired specification set. See “To select a specification set” on page 3-8.

2 Press the PREVIOUS MENU softkey.

3 Press the NORMALIZE REFERENCE softkey. 

4 Follow the on-screen instructions to perform the source normalization.
After the source normalization is successfully completed, press Continue to return to 
the previous menu. The device under test can be measured. See “To measure the 
device under test” on page 3-14.
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Performing Measurements
To measure the device under test

1 Load the desired specification set. See “To select a specification set” on page 3-8.

2 Press the MEASURE <SPEC SET> softkey. The application will detect and automatically 
run the normalization routine if required. See “To run the source normalization 
routines” on page 3-13.

3 The measurement will automatically continue when the normalization routine is 
completed.

The results can now be viewed as a waveform, as shown in the figure, or in a 
table, see “To display a table of the results” on page 3-16. The data can also be 
saved, see “To save the results to floppy” on page 3-15, and printed, see “To 
print the results” on page 3-15.
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Performing Measurements
To save the results to floppy 

The results can be saved automatically by using the STORE, AUTO keyword in 
the specification set, refer to “STORE, AUTO” on page 3-68. 

To save the results manually after completing a measurement, press the 
DOCUMENT RESULTS softkey. Then press the SAVE RESULTS TO FLOPPY softkey. The 
results of the test are saved to the floppy disk. The data can be saved as either 
graphical data in CGM format or as tabular data in CSV. For information on 
selecting the type of data to be saved, see “To change the default application 
settings” on page 3-19.

To print the results

The results can be printed automatically by using the PRINT keyword in the 
specification set, refer to “PRINT” on page 3-66. 

To print the results manually after completing a measurement, press the 
DOCUMENT RESULTS softkey. Then press the PRINT RESULTS softkey. The results can 
be printed out as a graph, a table, or as both on either the internal printer or on 
an external printer. See “To change the default application settings” on 
page 3-19 for information on making these selections.
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To display a table of the results

After a measurement has been completed, press the DISPLAY TABLE.... softkey.
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To edit the ID of the device under test 

N O T E Based on the specification set selected, you are usually prompted for the Device ID and 
Comments at the beginning of the measurement. However, if you were not prompted, or 
you wish to edit the Device ID or Comment fields, the following procedure can be used.

1 After completing a measurement, press the DOCUMENT RESULTS.... softkey.

2 Press the EDIT ID.... softkey. 

To enter the ID using the arrow keys

1 Use the front-panel step keys (
 and ⇓) and the arrow softkeys (→ and ←) to 
highlight each letter of the ID string. 

2 When the desired letter or function is selected, press the SELECT softkey.

3 Select the BACKSPACE softkey to delete individual letters.

4 When you finish entering the string, press the CONTINUE softkey.

To enter the ID using a trackball or mouse

1 Use the pointing device to place the cursor on a letter of the filename. Click on the 
character to select it.

2 Click the BACKSPACE softkey to delete individual letters.

3 When you finish entering the string, click the CONTINUE softkey. The new device ID is 
displayed on-screen in the ID field.

N O T E The new Device ID is saved only for the current session. Each time a new device is 
measured, the comment and ID strings are reset to the values specified in the 
specification set.
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Performing Measurements
To edit the comments for the device under test

N O T E Based on the specification set selected, you are usually prompted for the Device ID and 
Comments at the beginning of the measurement. However, if you were not prompted, or 
you wish to edit the Device ID or Comment fields, the following procedure can be used.

1 After completing a measurement, press the DOCUMENT RESULTS.... softkey.

2 Press the EDIT COMMENTS.... softkey.

3 Use the navigation keys to enter your comments. See “To enter the ID using the arrow 
keys” on page 3-17 and To enter the ID using a trackball or mouse 17 for 
information on entering the comment string.

4 When you finish entering the string, click the CONTINUE softkey. The new comment is 
displayed on-screen in the Comment field.

N O T E The new comment is saved only for the current session. Each time a new device is 
measured, the comment and ID strings are reset to the values specified in the 
specification set.
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To change the default application settings

1 After completing a measurement, press the DOCUMENT RESULTS.... softkey.

2 Press the APPLICATION SETUP.... softkey. 

3 Refer to To Fill In a Setup Panel 20 for information on changing and selecting items 
in the setup panel.

Setup panel selections Printout Type

The results can be printed out as a graph, a table, or as both.

Printer Location

Selects either the internal printer or an external printer as the print destination.

Save File Type

The data can be saved as either graphical data in CGM format or as tabular 
data in CSV.
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To Fill In a Setup Panel

Any of the instrument settings can be changed by using either the front-panel 
keys or the menu bar selections. Many of the menu selections and front-panel 
keys display a softkey panel. Settings in softkey panels are changed using the 
softkeys, data-entry keys, mouse, and trackball.

Setup panels allow you to adjust setup conditions which are not frequently 
changed.

Using the softkeys

The arrow softkeys

Allows the user to navigate from field to field in the dialog box. The highlighted 
parameter can be changed.

The Select softkey

Selects or deselects the highlighted parameter.

The Defaults softkey

Resets the parameters to their default condition.

Close Panel.... softkey

Saves the current setup and returns the user to the previous menu.

The front-panel number keys, step keys, and knob

Allows the user to enter a numeric value in the highlighted field. 
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Performing Measurements
To use the navigation softkeys

1 Use the arrow softkeys to highlight the settings on the setup panel. 

2 Use the SELECT softkey to toggle the selection boxes on and off.

3 Enter values in the numeric fields using the front-panel knob or numeric entry pad.

4 To return the setup values to the instrument’s preset settings, press the DEFAULTS 
softkey.

5 When you are satisfied with your selections, press the CLOSE PANEL.... softkey to enter 
your selections and close the setup panel.
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Designing Specification Sets

What is a specification set?

Specification sets are files that program the Passive Component Test 
application to perform a measurement. Each specification set defines one test. 
Specification sets are comma-separated-value (CSV) ASCII files that you can 
write using any text editor or spreadsheet program. The file name must comply 
with the MS-DOS 8.3 file name convention, a maximum of 8 characters, and the 
file name extension must be .csv.

How can I write specification sets?

You can use any ASCII editor to create your specification sets. Refer to “Using 
an ASCII Editor” on page 3-43 for more information.

You can also simplify the writing of specification sets by using an Excel 
template. Refer to “Excel Template Wizard for the PCT Application” on 
page 3-23 for more information.

If you use a spreadsheet program to develop your specification sets, configure 
the spreadsheet to automatically insert the commas for you when you save 
your file. 

To learn the details about each specification set keyword, refer to 
“Specification Set Keywords” on page 3-57.
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Excel Template Wizard for the PCT Application

Writing specification sets can be simplified by using the Microsoft® Excel 
template. The Excel template wizard can be downloaded from the web at 
http://www.agilent.com. In the Quick Search box, type “pct wizard”. Click on 
“Agilent 86140A Series OSA Passive Component Test Application and then 
click on “Download pct wizard.exe”. The template features a pull-down menu 
and setup wizard to automate the generation of specification sets.
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Installing the PCT Wizard

The Microsoft® Excel spreadsheet wizard, pct_wizard.xlt, contains a powerful 
macro that prompts you for measurement statements and builds a valid 
specification set file for your measurement. 

Before using the template for the first time, make a backup copy and store it in 
a safe place. When working with the template in Excel, use the SAVE CSV button 
to prevent writing over the original, unmodified template. To prevent modifying 
the original template, on the File menu do not select Save. 

To download and install the wizard

The PCT Wizard download is for Microsoft Windows systems only. To 
download the PCT Wizard:

1 Create a folder c:\osa\pct\ on your local PC.

2 On the web, go to http://www.agilent.com/comms/osa then click on:

Agilent 86140B Benchtop Standard Performance Optical Spectrum Analyzer
Application Notes and Technical Papers
Passive Component Test Application
Passive Component Test Application
pct_wizard.exe.

3 Download and save the pct_wizard.exe to the c:\osa\pct directory. This is a self 
extracting archive. 

4 To extract the files, from Windows Explorer, double-click on pct_wizard.exe.

Four files are extracted:

Table 1

readme.txt A text file of the instructions shown on this web page.

pct_wizard.xlt The Excel Wizard used to write specification sets. 

pct_wizard.dll The driver file required to run the PCT Wizard.

pct_help.pdf Instructions for using the PCT Wizard and a brief tutorial. This file can 
be viewed and printed using Adobe Acrobat. If you do not have Adobe 
Acrobat Reader necessary for viewing PDF documentation, download 
your free Acrobat Reader now. (Button)
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5 Move the pct_wizard.dll to the c:\windows\system directory.

6 Make a backup copy of pct_wizard.xlt and store it in a safe place.

To view the help file

N O T E You must have Adobe Acrobat reader installed. 

• To view the help file and tutorial, from Windows Explorer, double click on pct_help.pdf.

To start the PCT Wizard

N O T E You must have Microsoft Excel installed. 

• To open Excel and start the Wizard, from Windows Explorer, double-click on 
pct_wizard.xlt.

N O T E Never save your work from the file menu. This creates a modified template file which 
generates an improper specification set (CSV) file that will not run in the Passive 
Component Test application. Always click the SAVE CSV button to save your 
specification set.

To remove the PCT Wizard from your PC

1 To remove all files and the PCT Wizard from your PC, delete the folder c:\osa\pct and 
all its contents. 

2 Delete the file pct_wizard.dll from the c:\windows\system directory.
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The PCT Wizard at a Glance

The spreadsheet template

Device Information area

This section is used to enter information about the device, such as the 
identification and comments. The ID and COMMENT statements allow you to 
specify the device you are testing and to label the test. Both of these values 
will be shown on the instrument screen. Each time a device is tested, the user 
can be prompted to enter the device’s serial number. 

APPLICATION statement line 
with measurement description

Open an existing specification set

Save the current specification set

Begin writing a new specification set

Results Documentation 

 Device Measurement area

Measurement Setup area

Device Information area

Check the syntax of the specification 

Apply color to the specification set

Clear the specification set
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Measurement Setup area

This section is used to enter measurement setup information, such as the 
resolution, span, center wavelength and sensitivity. This area will contain the 
required NORMALIZE and SETUP keywords and the optional STIMULUS 
keyword to set up the optical spectrum analyzer for measurement.

The SETUP statement configures the settings of the optical spectrum analyzer. 
Only one SETUP statement should be used. The NORMALIZE keyword 
performs a trace normalization. The STIMULUS statement is used to specify 
the internal or external broadband light source of the instrument. 

Device Measurement area

This section is used to enter the test sequence and specification limits, such 
as, center wavelength and insertion loss. This area of the spreadsheet will 
contain the required PATH keyword, and the keywords and parameters for the 
chosen measurements.

For a full list of keywords and parameters, refer to “Specification Set 
Keywords” on page 3-57.

Results Documentation area

Use this area to specify where and how the measurement results are stored 
and printed.

Use PRINT_SETUP to determine whether the summary is printed to the 
internal or external printer, and whether to print the results table or both the 
table and the graphics.

STORE_SETUP is used to determine what results information is saved to the 
floppy disk.
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To begin the specification set

Every specification set begins with a required APPLICATION statement which 
identifies the specification set with the Passive Component Test application. It 
also provides an identification string which is displayed when the file is 
cataloged. You must edit this string manually in cell C4.

N O T E Do not modify or delete title rows, such as the “Device Information” row. If these rows 
are deleted, the PCT Wizard will not run properly.

After entering the identification string, you can create the specification set 
using the PCT Automation wizard.

All specification sets also require entries for SETUP, NORMALIZE, and PATH 
keywords. A default path is created whenever the CLEAR SHEET button is 
pressed. These will be entered using the wizard. Other keywords are optional. 
For a full list of keywords and parameters, refer to “Specification Set 
Keywords” on page 3-57.
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To Use the PCT Wizard

1 Click the START button to display the PCT Automation dialog box. 

PCT Automation dialog box

2 There are four types of specification set statements: Device Information, 
Measurement Setup, Device Measurement, and Results Documentation. For a 
complete description of these statements refer to Filling in the Device Information 
area 32, Filling in the Measurement Setup area 35, Filling in the Device 
Measurement area 37, Filling in the Results Documentation area 39, 
Specification Set Keywords 57.

For each type of specification set statement, click the radio button next to the 
statement in the dialog box, then use the menu at the right to select a keyword. 
Enter the required information, then click OK to go on to the next item or to 
return to the first dialog box.

The UNDO LAST INSERT button allows you to delete the last entry made. If you 
need to modify any other entry, close the wizard and then edit the spreadsheet 
cell directly.

Click to select type of statement to enter Drop-down list of available statements

Delete last 
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3 When finished, click the EXIT button to close the PCT Automation dialog box. Any 
modifications necessary to the spreadsheet entries may be made directly to the 
spreadsheet cells after the dialog box is closed.

4 To save the specification set, click the SAVE CVS button. On the File menu, do not 
select the Save command. If you do the specification set will not be saved properly.

Select statement from drop-down listSpecify measurement value is reported in 

Description of highlighted 
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Example of a specification set

Name of specification set listed in the 
“Load Spec Set” file listing of the 
Passive Component Test application

Required statement identifying 
application to run specification 

One of two optional statements 
for identifying the device being 

Required NORMALIZE and 
SETUP statements

Instructions for performing 
measurements

Variable name for measured 
value listed in the measurement 

Measurement results sent to the 
internal printer
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Tutorial

In this tutorial you will create a specification set for measuring the peak 
wavelength of a WDM filter. The passband of the filter is from 1540 nm to 1560 
nm.

To start the PCT Wizard

1 To open Excel and start the Wizard, from Windows Explorer, double-click on 
pct_wizard.xlt.

2 Click the START button.

Filling in the Device Information area

1 In the PCT Automation dialog box, click on the drop-down list and select COMMENT. 
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2 In the Comments dialog box text box, type PCT Test Program and then click OK.

3 In the Enter Additional Text During Test? dialog box select the None option button 
and then click OK.

4 In the PCT Automation dialog box on the drop-down list select ID.
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5 In the Serial Number dialog box text box type, HB001 and click OK.

6 In the Enter Additional Text During Test? dialog box, click OK to select the default text.

N O T E The default text of “ENTER” will cause the optical spectrum analyzer to prompt the user 
to input a device ID number
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Filling in the Measurement Setup area

To enter the normalize information

1 In the PCT Automation dialog box, select the Measurement Setup option button.

2 In the PCT Automation dialog box select NORMALIZE on the drop-down list.

3 In the Minimum Power Range dialog box enter -40 in the text box. Click OK.

4 In the Maximum Power Range dialog box enter 0 in the text box. Click OK.

5 To set the time between normalizations to two hours, in the Interval between 
normalizations dialog box enter 2. Click OK.
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To enter the setup information

1 In the PCT Automation dialog box, select SETUP on the drop-down list.

2 In the Start Wavelength dialog box, type 1540. Click OK.

3 In the Stop Wavelength dialog box, type 1560. Click OK.

4 In the Trace Points dialog box, type 1001. Click OK.

5 In the Averages dialog box, type 1. Click OK.

6 In the Resolution Bandwidth dialog box select the 0.1 nm option button. Click OK.

7 In the Reference Level dialog box, type 0. Click OK.

8 In the Scale (dB per division - optional) dialog box, type 10. Click OK.

9 In the Sensitivity dialog box type, -85. Click OK.

10 In the Video Bandwidth (3kHz max…) dialog box click OK to keep the DEFAULT text.

11 In the PCT Automation dialog box select STIMULUS on the drop-down list.

12 In the Stimulus dialog box click OK to keep the INTERNAL_BBLS text.
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Filling in the Device Measurement area

1 In the PCT Automation dialog box select the Device Measurement option button.

2 In the PCT Automation dialog box select PEAK_WAVELENGTH from the drop-down 
list.

N O T E Use the front-panel up and down arrow keys to cycle through the list of keywords and 
display a description of the highlighted keyword.

3 In the Name dialog box type Pk_Wl. Click OK. 

N O T E The name you just entered, Pk_Wl, is now a variable name you can reference later.

4 In the Minimum Spec dialog box, type 1545. Make sure the nm option button is 
selected. Click OK.

5 In the Maximum Spec dialog box, type 1555. Click OK.
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6 In the Search From dialog box, type 1540. Click OK.

7 In the Search To dialog box, type 1560.Click OK.

8 In the PCT Automation dialog box select BANDWIDTH_WAVELENGTH on the drop-
down list.

9 In the Name dialog box type BW_3dB. Click OK.

N O T E The name you just entered, BW_3dB, is now a variable name you can reference later.

10 In the Minimum Spec dialog box type 0.1. Click OK.

11 In the Maximum Spec dialog box type 2. Click OK.

12 In the Reference Point dialog box type, Pk_Wl. Select the Name option button. Click 
OK.
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N O T E This command uses the variable Pk_Wl you defined in Step 3 as its reference point. For 
this reason it is necessary to click on the Name bullet and not the nm option button. If 
an actual known wavelength value is entered, leave the nm option button selected. 

13 In the Excursion dialog box, type -3. Click OK.

Filling in the Results Documentation area

1 In the PCT Automation dialog box select the Results Documentation option button.

2 In the PCT Automation dialog box select PRINT_SETUP from the drop-down list.

3 In the Printout Style dialog box select the GRAPHICS_AND_TABLE option button. 
Click Ok.

4 In the Printer dialog box click OK to select the default text, INTERNAL.

5 In the PCT Automation dialog box select PRINT on the drop-down list. 

6 In the PCT Automation dialog box, click on the Exit button 
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Saving your specification set

1 Use the slide bar to go to the top of the template. Click on the SAVE CSV button.

C A U T I O N Always click the SAVE CSV button to save your specification set. If you save 
your work from the File menu an Excel spreadsheet file ( *.xls) will be saved. 
Although you can modify or change this spreadsheet file in the future.an Excel 
spreadsheet file will not run in the Passive Component Test application. To 
create a file that will run in the Passive Component Test application click on the 
SAVE CSV button.

2 Enter the file name and directory of your choice. Note that to port the specification 
set to the OSA it must be saved on a floppy disk in the root directory.

C A U T I O N When you close the PCT template, Excel will ask you “Do you want to save the 
changes you made to 'PCT Template, v1.11'?” Always answer “NO” to this question. 

If you answer “YES” the original PCT Template will be changed. If you want to save your work as 

an Excel spreadsheet template enter a new filename, such as my_test.xls.

A picture of the completed specification sheet is shown on the following page.
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Export Spec Set

Displays a list of internally stored specification sets. Use the navigation keys to 
select the desired specification set and then press the Export Set softkey. The 
comma-separated-value (CSV) specification set file from internal memory is 
output to the floppy disk.

Key Path Appl’s > Passive Components > Spec Set DEFAULT > Export Spec Set

Related Functions Load Spec Set, Import Spec Set, Delete Spec Set

Remote Commands MMEMory:SSET:DATA?<file_name>

Import New Spec Set

Imports a specification set <file_name>, where <data_block> is a definite 
length block containing the specification set. Refer to the Agilent 86140B 
Series Measurement Applications User’s Guide (Part Number: 86140-90083)

Key Path Appl’s >Passive Components > Spec Set Default > Import New Spec Set

Related Functions Load Spec Set, Export Spec Set, Delete Spec Set

Remote Commands MMEMory:SSET:DATA <file_name>,<data_block>
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Load Spec Set

Loads an imported specification set as the current set of specs.

Key Path Appl’s > Passive Components > Load Spec Set

Related Functions Import New Spec Set, Export Spec Set, Delete Spec Set

Remote Commands MMEMory:SSET:LOAD<file_name>
MMEMory:SSET:LOAD?

Using an ASCII Editor

There are four types of specification set keywords: System Commands, 
Measurement Setup, Device Measurement, and Results Documentation. All 
specification sets require the APPLICATION, SETUP, NORMALIZE, and PATH 
keywords.

Every specification set begins with the APPLICATION keyword which identifies 
the specification set with the Passive Component Test application. It also 
provides a label that will be displayed when the specifications set is cataloged 
by the Passive Component Test application. Try to make the label descriptive of 
the test or device that you are measuring.

After the APPLICATION keyword, use the optional ID and COMMENT keywords 
to label the test and device being tested. The entered strings appear on the 
instrument’s display as shown in Example 3-2. Add the STIMULUS keyword to 
select the broadband light source. Next, use the SETUP and NORMALIZE 
keywords to configure the instrument’s settings and perform a trace 
normalization, see Example 5-4 on page 3-49.

Follow the PATH keyword with any keywords that are required for your 
measurement, followed by keywords to print or store the measurement results. 
Only one SETUP keyword should be used. If additional SETUP keywords are 
included, only the last keyword is used. Use the SWEEP and ZOOM commands 
to sweep a subset of the wavelength range and zoom to the screen.
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Example 3-2.
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Keywords, such as PEAK_WAVELENGTH for example, must use all uppercase 
letters. Comments are preceded by a semicolon (;) character. Everything after a 
semicolon on a line is ignored. You can also insert blank lines to make your files 
easier to read. Keywords can be separated by either spaces or a comma (,) 
character. Notice that no flow control keywords, such as branching or looping, 
are provided.

Measurement paths require a PATH keyword

Include the PATH keyword before any group of measurement keywords listed 
for a specific measurement path. Devices with multiple paths, such as WDM 
multiplexers, require one PATH keyword for each path. Example 5-4 on 
page 3-49 has one PATH keyword. Example 3-3 on page 3-46 has two PATH 
keywords, one for device loss and one for device isolation. All measurement 
keywords between two PATH keywords apply to the first PATH keyword. Each 
PATH is measured in the order listed in the specification file. The name specified 
for each PATH appears in the final result table and on the MEASURE softkey.
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Example 3-3.

Notice the use of the INSTRUCTION keyword to convey instructions to the 
user. Each PATH can have one or more INSTRUCTION keywords. The dialog 
boxes are displayed in the order of the INSTRUCTION keywords. If no 
INSTRUCTION keyword is given for a particular PATH, a default instruction 
prompt is displayed. The measurement pauses until the CONTINUE softkey is 
clicked. In the displayed string, use the escape sequence \n to enter a newline 
character and force a line break.

Pressing the MEASURE DUT softkey brings up an instruction panel.

When the measurement is complete, the results can be viewed both 
graphically and in table form, as shown in Figure 4 and Figure 5.
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Figure 4 Measurement results displayed graphically.

Figure 5 Measurement results displayed in tabular format.

Use variables to identify measured values

The first parameter for most measurement keywords is a variable name. 
Variables are automatically initialized and allocated the first time that they are 
assigned a value by the application. Variables “hold” the measured value for 
the keyword. Variable values and names are displayed in the measurement 
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results table. To prevent a variable from being displayed in the measurement 
results table, begin the corresponding keyword line with a pound sign (#) 
character.

The following PEAK_WAVELENGTH keyword defines the variable 
PEAK_WAVELENGTH. Notice that the MARKER_LEVEL keyword uses 
PEAK_WAVELENGTH, which is measured in the previous step, to define the 
wavelength for placing the marker.
PEAK_WAVELENGTH,Peak_wavelength,1545 nm,1555 nm,DEFAULT,DEFAULT
MARKER_LEVEL,Peak_power,-3 dB,3 dB,Peak_wavelength

Variable names can include both upper and lowercase letters but cannot 
include spaces; use the underscore character (_) instead. The first character of 
a variable must be a letter. Only the first 32 characters of the variable name are 
significant. For names to be considered different, the first 32 characters must 
not be identical.

Results documentation area

Use this area to specify where and how the measurement results are stored 
and printed.

Use PRINT_SETUP to determine whether the summary is printed to the 
internal or external printer and whether to print the results table or both the 
table and graphics.

STORE_SETUP is used in a similar way to determine what results information 
is saved to the floppy disk.
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Example 5-4. Specification set for characterizing a WDM filter.
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Example 5-4 on page 3-49 shows a specification set written to characterize a 
WDM filter. The specification set measures the insertion loss, the 3 dB, 6 dB, 
and 10 dB bandwidths, the peak wavelength and the crosstalk.

Figure 6 shows the results summary table for a device measured using the 
specification set shown in Example 5-4. The device passes the specifications in 
this example.

Figure 6 Results summary table for a WDM filter.

Example 6-5 on page 3-51 shows a specification set for characterizing an 
optical isolator. Note that it uses two paths, one for the insertion loss and one 
for the isolation.
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Example 6-5. Specification set for characterizing an optical isolator.
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Figure 7 shows an example of the results summary table for an optical isolator 
characterized using the specification set shown in Example 6-5.

Figure 7 Measurement summary table for an isolator
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Specification Set Flowchart
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Quick List of Keywords

Table 6 List of Keywords (1 of 3)

Command Description

SYSTEM COMMANDS

APPLICATION, COMPONENTS Designates the specification set for use with the Passive Component Test 
application. Also identifies test in catalog.

COMMENT Prints comment in comment section of the instrument’s display.

ID Prints an identification string in ID section of the instrument’s display.

MEASUREMENT SETUP COMMANDS

NORMALIZE Specifies the minimum and maximum peak power range (in dBm) for the reference 
signal for a valid normalization. 

SETUP Configures the optical spectrum analyzer settings.

STIMULUS Specifies the source that is used to take a reference trace as well as the actual 
measurement.

MEASUREMENT COMMANDS

ABS_FREQUENCY_LEFT Measures the absolute frequency of a trace point.

ABS_FREQUENCY_RIGHT Measures the absolute frequency of a trace point.

ABS_WAVELENGTH_LEFT Measures the absolute wavelength of a trace point.

ABS_WAVELENGTH_RIGHT Measures the absolute wavelength of a trace point.

BANDWIDTH_FREQUENCY Calculates the bandwidth (in THz).

BANDWIDTH_WAVELENGTH Calculates the bandwidth (in nm).

CENTER_FREQUENCY Locates the center frequency (THz).

CENTER_OF_MASS_FREQUENCY Calculates the mean frequency (THz) representing the center of mass.

CENTER_OF_MASS_WAVELENGTH Calculates the mean wavelength (nm) representing the center of mass.

CENTER_WAVELENGTH Locates the center wavelength (nm).

DELTA_FREQUENCY_LEFT Determines the frequency separation between a measurement point and reference 
point.

DELTA_FREQUENCY_RIGHT Determines the frequency separation between a measurement point and reference 
point.

DELTA_WAVELENGTH_LEFT Determines the wavelength separation between a measurement point and 
reference point.
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DELTA_WAVELENGTH_RIGHT Determines the wavelength separation between a measurement point and 
reference point.

INSTRUCTION Displays a prompt for the user for a measurement path.

LIN_ADD Calculates the sum of two, or more, linear power, wavelength, frequency, or 
constant values.

LIN_AVG Calculates the average of two or more values.

LIN_DIV Calculates the ratio of two, or more, linear power, wavelength, frequency, or 
constant values.

LIN_MUL Calculates the product of two, or more, linear power, wavelength, frequency, or 
constant values.

LIN_SUB Calculates the difference between two, or more, linear power, wavelength, 
frequency, or constant values.

LOG_ADD Calculates the sum of two, or more, logarithmic power, wavelength, frequency, or 
constant values.

LOG_SUB Calculates the difference between two, or more, logarithmic power, wavelength, 
frequency, or constant values.

MARKER_LEVEL Measures the power at the location specified.

MARKER_LOSS Measures the power loss at the location specified referenced to the normalized 
response.

MAX Calculates the maximum of two or more values.

MIN Calculates the minimum of two or more values.

PATH Specifies which set of measurement keywords should be grouped together and 
performed on the same trace measurement.

PEAK_FREQUENCY Measures the frequency (THz) of the maximum power trace point in a wavelength 
range. 

PEAK_WAVELENGTH Measures the wavelength (nm) of the maximum power trace point in a wavelength 
range.

PIT_FREQUENCY Measures the frequency (THz) of the minimum power trace point in a wavelength 
range.

PIT_WAVELENGTH Measures the wavelength (nm) of the minimum power trace point in a wavelength 
range.

SWEEP Specifies that the following data should be taken from a partial sweep.

ZOOM Display the trace over the specified wavelength range on the screen.

RESULTS COMMANDS

PRINT Prints the measurement results with the settings defined in the PRINT_SETUP 
keyword.

PRINT_SETUP Configures the hardcopy output of the measurement results.

Table 6 List of Keywords (2 of 3)

Command Description
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PRINT_SUMMARY Prints the final summary of the results.

STORE,AUTO Saves the measurement results as defined by the STORE_SETUP keyword.

STORE_SETUP Configures the output of the measurement results that is stored on a disk in the 
front-panel disk drive.

Table 6 List of Keywords (3 of 3)

Command Description
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Specification Set Keywords

ABS_FREQUENCY_LEFT, name, [spec_min], [spec_max], ref_pt, [excursion]

Measures the absolute frequency of a trace point and loads the value into the 
name variable. The value returned by this function is in THz. The point is located 
excursion dB away from the amplitude of the reference point (ref_pt). The search 
is made on frequencies higher than the reference. Arguments are spec_min and 

Table 7

Convention  Description 

< > Angle brackets indicate text strings entered by the developer.

[ ] Square brackets indicate that the keyword DEFAULT can be used instead 
of a value or a variable for that parameter. Refer to the actual command 
description for the behavior when the DEFAULT keyword is used for a 
parameter.

| Indicates a choice of one element from a list.

{ } Braces indicate a group of constants to select from. Each constant is 
separated by the | character.

name Indicates the variable for which you provide a descriptive name. Any letter 
(Aa-Zz) followed by letters, digits (0-9) and underscore (_). Only the first 32 
characters are significant.

spec_min –infinity. The parameter spec_min cannot be a variable, only a constant or 
DEFAULT.

spec_max +infinity. The parameter spec_max cannot be a variable, only a constant or 
DEFAULT.

from  Start wavelength or frequency of trace in nm (default) or THz.

to  Stop wavelength or frequency of trace in nm (default) or THz.

excursion +excursion: means excursion dBs up (for example, from a pit). 
-excursion: means excursion dBs down (for example, from a peak).

ref_pt The reference point to be used for a measurement keyword.
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spec_max, which are absolute frequency values, or DEFAULT. The ref_pt can be a 
constant or a variable. To return the relative frequency, refer to the DELTA 
keywords. If no point on the trace meets the excursion criterion, the keyword is 
considered to have failed, and the left endpoint (highest frequency) of the trace 
is returned.

ABS_FREQUENCY_RIGHT, name, [spec_min], [spec_max], ref_pt, [excursion]

Measures the absolute frequency of a trace point and loads the value into the 
name variable. The value returned by this function is in THz. The point is located 
excursion dB away from the amplitude of the reference point (ref_pt). The search 
is made on frequencies lower than the reference. Arguments spec_min and 
spec_max are absolute frequency values or DEFAULT. The ref_pt can be a 
constant or a variable. To return the relative frequency, refer to the DELTA 
keywords. If no point on the trace meets the excursion criterion, the keyword is 
considered to have failed, and the right endpoint (lowest frequency) of the 
trace is returned.

ABS_WAVELENGTH_LEFT, name, [spec_min], [spec_max], ref_pt, [excursion]

Measures the absolute wavelength of a trace point and loads the value into the 
name variable. The value returned by this function is in nm. The point is located 
excursion dB away from the amplitude of the reference point (ref_pt). The search 
is made on wavelengths shorter than the reference. Arguments spec_min and 
spec_max are absolute wavelength values or DEFAULT. The ref_pt can be a 
constant or a variable. To return the relative wavelength, refer to the DELTA 
keywords. If no point on the trace meets the excursion criterion, the keyword is 
considered to have failed, and the left endpoint (shortest wavelength) of the 
trace is returned.

ABS_WAVELENGTH_RIGHT, name, [spec_min], [spec_max], ref_pt, [excursion]

Measures the absolute wavelength of a trace point and loads the value into the 
name variable. The value returned by this function is in nm. The point is located 
excursion dB away from the amplitude of the reference point (ref_pt). The search 
is made on wavelengths longer than the reference. Arguments spec_min and 
spec_max are absolute wavelength values or DEFAULT. The ref_pt can be a 
constant or a variable. To return the relative wavelength, refer to the DELTA 
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keywords. If no point on the trace meets the excursion criterion, the keyword is 
considered to have failed, and the right endpoint (longest wavelength) of the 
trace is returned.

APPLICATION, COMPONENTS, “label string”

Designates the specification set for use with the Passive Component Test 
application. This keyword must be the first keyword in the specification set. 
The label string is used as a description when cataloging the imported 
specification sets in the instrument.

BANDWIDTH_FREQUENCY, name, [spec_min], [spec_max], ref_pt, [excursion]

Calculates the bandwidth (in THz) and loads the value into the name variable. 
The value returned by this function is in THz. The bandwidth is determined 
excursion dB to the left and to the right of the reference point. Negative 
excursion values specify a lower amplitude from the reference point, and 
positive excursion values specify a higher amplitude. If either the left or right 
trace point fails to meet the excursion criterion, the keyword is considered to 
have failed. If the left trace point fails, the left endpoint is used for the 
bandwidth calculation. If the right trace point fails, the right endpoint is used 
for the bandwidth calculation.

BANDWIDTH_WAVELENGTH, name, [spec_min], [spec_max], ref_pt, [excursion]

Calculates the bandwidth (in nm) and loads the value into the name variable. 
The value returned by this function is in nm. The bandwidth is determined 
excursion dB to the left and to the right of the reference point. Negative 
excursion values specify a lower amplitude from the reference point, and 
positive excursion values specify a higher amplitude. If either the left or right 
trace point fails to meet the excursion criterion, the keyword is considered to 
have failed. If the left trace point fails, the left endpoint is used for the 
bandwidth calculation. If the right trace point fails, the right endpoint is used 
for the bandwidth calculation.
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CENTER_FREQUENCY, name, [spec_min], [spec_max], ref, [excursion]

Locates the center frequency (THz) and loads the value into the name variable. 
The value returned by this function is in THz. It represents the mean value of 
the two frequencies found excursion dB down (for negative excursion value) or 
up (for positive excursion value) to the left and right of the reference point. The 
reference parameter can be a variable or a constant. If either the left or right 
trace point fails to meet the excursion criterion, the keyword is considered to 
have failed. If the left trace point fails, the left endpoint is used for the 
bandwidth calculation. If the right trace point fails, the right endpoint is used 
for the bandwidth calculation.

CENTER_OF_MASS_FREQUENCY, name, [spec_min], [spec_max], [from], [to]

Calculates the mean frequency (THz) and loads the value into the name variable. 
The value returned by this function is in THz. The mean value represents the 
center of mass of the trace over the range from–to.

CENTER_OF_MASS_WAVELENGTH, name, [spec_min], [spec_max], [from], [to]

Calculates the mean wavelength (nm) and loads the value into the name 

variable. The value returned by this function is in nm. The mean value 
represents the center of mass of the trace over the range from–to.

CENTER_WAVELENGTH, name, [spec_min], [spec_max], ref, [excursion] 

Locates the center wavelength (nm) and loads the value into the name variable. 
The value returned by this function is in nm. It represents the mean value of the 
two wavelengths found excursion dB down (for negative excursion value) or up 
(for positive excursion value) to the left and right of the reference point. The 
reference parameter can be a variable or a constant. If either the left or right 
trace point fails to meet the excursion criterion, the keyword is considered to 
have failed. If the left trace point fails, the left endpoint is used for the 
bandwidth calculation. If the right trace point fails, the right endpoint is used 
for the bandwidth calculation.
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COMMENT, “<any text>”, ENTER

Allows the application user to enter a comment for the device being tested. 
The optional ENTER parameter causes a dialog box to appear before the 
measurement of the first path, prompting the operator to enter a comment. The 
maximum number of characters that can be displayed on the screen is 56.

DELTA_FREQUENCY_LEFT, name, [spec_min], [spec_max], ref_pt, [excursion]

Determines the frequency separation between a measurement point and 
reference point and loads the value into the name variable. The value returned 
by this function is in THz. The measurement point is located excursion dB away 
from the amplitude of the reference point (ref_pt). The search is made on 
frequencies higher than the reference. The value of the frequency returned is 
positive. Arguments spec_min and spec_max are absolute frequency values or 
DEFAULT. The ref_pt can be a constant or a variable. To return the absolute 
frequency, refer to the ABS keywords. If no point on the trace meets the 
excursion criterion, the keyword is considered to have failed, and the 
separation between the left endpoint of the trace and the reference point is 
returned.

DELTA_FREQUENCY_RIGHT, name, [spec_min], [spec_max], ref_pt, [excursion]

Determines the frequency separation between a measurement point and 
reference point and loads the value into the name variable. The value returned 
by this function is in THz. The measurement point is located excursion dB away 
from the amplitude of the reference point (ref_pt). The search is made on 
frequencies lower than the reference. The value of the frequency returned is 
negative. Arguments spec_min and spec_max are absolute frequency values or 
DEFAULT. The ref_pt can be a constant or a variable. To return the absolute 
frequency, refer to the ABS keywords. If no point on the trace meets the 
excursion criterion, the keyword is considered to have failed, and the right 
endpoint of the trace is returned.
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DELTA_WAVELENGTH_LEFT, name, [spec_min], [spec_max], ref_pt, [excursion]

Determines the wavelength separation between a measurement point and 
reference point and loads the value into the name variable. The value returned 
by this function is in nm. The measurement point is located excursion dB away 
from the amplitude of the reference point (ref_pt). The search is made on 
wavelengths shorter than the reference. The value of the wavelength returned 
is negative. Arguments spec_min and spec_max are absolute wavelength values 
or DEFAULT. The ref_pt can be a constant or a variable. To return the absolute 
wavelength, refer to the ABS keywords. If no point on the trace meets the 
excursion criterion, the keyword is considered to have failed, and the left 
endpoint of the trace is returned.

DELTA_WAVELENGTH_RIGHT, name, [spec_min], [spec_max], ref_pt, [excursion] 

Determines the wavelength separation between a measurement point and 
reference point and loads the value into the name variable. The value returned 
by this function is in nm. The measurement point is located excursion dB away 
from the amplitude of the reference point (ref_pt). The search is made on 
wavelengths longer than the reference. The value of the wavelength returned 
is positive. Arguments spec_min and spec_max are absolute wavelength values or 
DEFAULT. The ref_pt can be a constant or a variable. To return the absolute 
wavelength, refer to the ABS keywords. If no point on the trace meets the 
excursion criterion, the keyword is considered to have failed, and the left 
endpoint of the trace is returned.

ID, “<serial number>”, ENTER

Allows the application user to enter an identification number for the device 
being tested. The optional ENTER parameter causes a dialog box to appear 
before the measurement of the first path, prompting the operator to enter the 
identification number. The ID keyword is not required in a specification set.
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INSTRUCTION, “<prompt string>”

Displays a prompt for the user in a dialog box. Each PATH can have one or more 
INSTRUCTION keywords. The dialog boxes are displayed in the order of the 
INSTRUCTION keywords. If no INSTRUCTION keyword is given for a particular 
PATH, a default instruction prompt is displayed. The measurement pauses until 
the CONTINUE softkey is clicked. 

Use the escape sequence \n to enter a newline character and force a line 
break. Use the escape sequence \” to enter a double quote character. 

LIN_ADD, name, [spec_min], [spec_max], value1, value2, ... , valueN

Calculates the sum of two or more linear power, wavelength, frequency, or 
constant values. The value returned by this function is in nm, THz, or dB, 
depending on the inputs. The sum is loaded into the name variable.

LIN_AVG, name, [spec_min], [spec_max], value1, value2, ... , valueN

Calculates the average of two or more values and loads the value into the name 

variable. The values are converted to linear and the linear average is calculated.

LIN_DIV, name, [spec_min], [spec_max], value1, value2, ... , valueN

Calculates the ratio of two or more linear power, wavelength, frequency, or 
constant values. The value returned by this function is in nm, THz, dB, or 
unitless, depending on the inputs. The ratio is loaded into the name variable.

LIN_MUL name, [spec_min], [spec_max], value1, value2, ... , valueN 

Calculates the product of two or more linear power, wavelength, frequency, or 
constant values. The value returned by this function is in nm, GHz, or dB. The 
product is loaded into the name variable.

LIN_SUB, name, [spec_min], [spec_max], value1, value2, ... , valueN 

Calculates the difference between two or more linear power, wavelength, 
frequency, or constant values. The value returned by this function is in nm, 
GHz, or dB. The difference is loaded into the name variable.
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LOG_ADD, name, [spec_min], [spec_max], value1, value2, ... , valueN

Calculates the sum of two or more logarithmic power, wavelength, frequency, 
or constant values. The value returned by this function is in dB. The sum is 
loaded into the name variable.

LOG_SUB, name, [spec_min], [spec_max], value1, value2, ... , valueN

Calculates the difference between two or more logarithmic power, wavelength, 
frequency, or constant values. The value returned by this function is in dB. The 
difference is loaded into the name variable.

MARKER_LEVEL, name, [spec_min], [spec_max], ref_pt

Measures the power at the reference point specified and loads the value into 
the name variable. The value returned by this function is in dB. The power (dBm) 
or loss (dB) is dependent on the trace at a given wavelength. The ref_pt 
parameter can be a wavelength, frequency, or a previously defined name. Log 
interpolation of the power level is used if ref_pt doesn’t fall exactly on a trace 
point. 

MARKER_LOSS, name, [spec_min], [spec_max], ref_pt

Measures the power loss at the reference point specified, and loads the value 
into the name variable. Although the marker measures a negative decibel value, 
the returned value is positive to represent loss. The ref_pt parameter can be a 
wavelength, frequency, or a previously defined name. Log interpolation of the 
power level is used if ref_pt doesn’t fall exactly on a trace point.

This keyword is provided as a convenience when measuring values, like 
insertion loss, which are typically specified with positive dB values but 
measured as negative dB values by the OSA.

MAX, name, [spec_min], [spec_max], value1, value2, .., valueN

Calculates the maximum of two or more values and loads the value into the 
name variable. All the values must have the same units. The spec_min and 
spec_max parameters must be either DEFAULT or constants with the same units 
as the values.
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MIN, name, [spec_min], [spec_max], value1, value2,..., valueN

Calculates the minimum of two or more values and loads the value into the 
name variable. All the values must have the same units. The spec_min and 
spec_max parameters must be either DEFAULT or constants with the same units 
as the values.

NORMALIZE, [spec_min], [spec_max], [interval]

Specifies the minimum and maximum peak power range (in dBm) for the 
reference signal for a valid normalization. Failures cause the message 
“Normalization failed, clean connector and try again” to be displayed. All buttons 
except NORMALIZE REFERENCE are disabled. Pushing NORMALIZE REFERENCE starts the 
sequence again. Interval specifies the time interval between calibrations in 
hours. For example, 0.5h corresponds to 30 minutes. The maximum and 
DEFAULT value for the interval is 24 hours.

PATH, name

Specifies which set of measurement keywords should be grouped together and 
performed on the same trace measurement. The name specified for each PATH 
appears in the final result table and on the MEASURE softkey. For example, a 
coupler would require two PATH keywords, one for each arm of the coupler. 
Each PATH uses its own trace. All measurement keywords between two PATH 
keywords apply to the first PATH keyword. Each PATH is measured in the order 
listed in the specification file. 

PEAK_FREQUENCY, name, [spec_min], [spec_max], [from], [to] 

Measures the frequency (THz) of the maximum power trace point in a 
wavelength range. The units returned by this function are in THz. The 
measured value is placed in the name variable.

PEAK_WAVELENGTH, name, [spec_min], [spec_max], [from], [to]

Measures the wavelength (nm) of the maximum power trace point in a 
wavelength range. The units returned by this function are in nm. The measured 
value is placed in the name variable.
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PIT_FREQUENCY, name, [spec_min], [spec_max], [from], [to] 

Measures the frequency (THz) of the minimum power trace point in a 
wavelength range. The units returned by this function are in THz. The 
measured value is placed in the name variable.

PIT_WAVELENGTH, name, [spec_min], [spec_max], [from], [to] 

Measures the wavelength (nm) of the minimum power trace point in a 
wavelength range. The units returned by this function are in nm. The measured 
value is placed in the name variable.

PRINT

Prints the results with the settings defined in the PRINT_SETUP keyword.

PRINT_SETUP, {TABLE | GRAPHICS | GRAPHICS_AND_TABLE}, {INTERNAL | EXTERNAL}

Configures the hardcopy output of the measurement results. Either the 
instrument’s internal printer or an external printer can be selected. As shown in 
the following table, the type of data printed is also selectable. Although 
application users can temporarily override these selections for the current 
measurement, when a new device is measured the print setup resets to the 
values defined by the PRINT_SETUP keyword.

Table 8

Constant  Description 

TABLE Prints the measurement data in a table.

GRAPHICS Prints the instrument’s display.

GRAPHICS_AND_TABL
E

Prints the measurement data in a table along with the 
instrument’s display.

INTERNAL Selects the instrument’s internal printer.

EXTERNAL Selects an external printer.
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PRINT_SUMMARY

Prints the final summary of the results.

SETUP, start_wvl, stop_wvl, [pts], [avgs], [rbw], [ref_lvl], [scale], [sens], [vbw]

This required keyword configures the following optical spectrum analyzer 
settings: 

start wavelength (nm)
stop wavelength (nm)
number of trace points
number of trace averages
resolution bandwidth (nm)
reference level (dBm)
amplitude scale (dB)
sensitivity (dBm)
video bandwidth (Hz)

The following line shows an example of this keyword:

SETUP 1500.00,nm,1600.00,nm,4001,1,0.10,nm,+10.00,dBm,10,dB,-
90.0,dBm,100,Hz

These settings are always used when performing a normalization. PATH 
measurements also use these settings unless changed by the SWEEP 
keyword. If a parameter other than avgs is set to DEFAULT, the optical spectrum 
analyzer keeps its current setting. For the avgs parameter the DEFAULT keyword 
will set the value to 1. Otherwise, the SETUP keyword changes the setting to 
whatever is specified for a parameter. This behavior has the potential 
consequence of allowing the SWEEP keyword to change the sensitivity from 
the first normalization for subsequent normalizations. 

For example, suppose that the instrument is currently at –70 dBm sensitivity 
and the SETUP keyword has DEFAULT for the sensitivity parameter. There is a 
SWEEP keyword with –80 dBm for sensitivity. This results in the first 
normalization being performed at –70 dBm sensitivity. After a path is measured 
which sets the instrument to –80 dBm sensitivity, subsequent normalizations 
will be made at –80 dBm. 
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There should be only one SETUP command in a specification set. Multiple 
SETUP commands generate a warning when the specification set is imported, 
but the specification set can still be imported. The settings of the last SETUP 
command will be the ones used by the specification set.

The start and stop wavelength values can only be constants. DEFAULT is not 
allowed for these values. All other parameter values must be either constants 
with units or the keyword DEFAULT. Variables are not allowed as parameters 
for this keyword.

STIMULUS, {INTERNAL_BBLS | EXTERNAL_BBLS}

Specifies the source that is used to take a reference trace, as well as the actual 
measurement.

STORE, AUTO

Saves the measurement results as defined by the STORE_SETUP keyword. A 
filename is automatically generated from the last 8 characters of the 
identification string entered using the ID keyword. The only legal characters for 
the filename are letters, numbers, and the underscore (_) character. If the ID 
string contains any other characters, those characters will be replaced with the 
underscore character. If a file already exists on the disk with the same 
filename, the file will be overwritten. There is no prompt for overwrite.

Table 9

Constant  Description 

INTERNAL_BBLS Selects the instrument’s internal white-light or EELED broadband 
light source.

EXTERNAL_BBLS Selects an external unmodulated broadband light source.
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STORE_SETUP, {TABLE | GRAPHICS}

Configures the output of the measurement results that is stored on a disk in the 
front-panel disk drive. Although application users can temporarily override 
these selections for the current measurement, when a new device is 
measured, the storage setup resets to the values defined by the STORE_SETUP 
keyword. Use the STORE, AUTO keyword to actually store the data.

SWEEP, start_wvl, stop_wvl, [avgs], [sens]

Specifies that the following data should be taken from a partial sweep. 
Normalization traces are always made using the conditions specified by 
SETUP. You can use this keyword to decrease measurement time by setting the 
instrument to sweep over a smaller wavelength range or with different trace 
averaging or sensitivity. The wavelength range specified here must fall within 
the one given in SETUP. In order to maintain integrity with the reference trace, 
the SWEEP function does not change the absolute wavelength position of 
trace points nor does it change the hardware reference level.

The start and stop wavelength values can only be constants. DEFAULT is not 
allowed for these values. All other parameter values must be either constants 
with units or the keyword DEFAULT for the optional parameters. Variables are 
not allowed as parameters for this keyword.

ZOOM, start_wvl, stop_wvl, [ref_lvl], [scale] 

Displays the trace over the specified wavelength range on the screen. The 
zoom is performed after the path measurement is completed. If multiple ZOOM 
keywords are used for a PATH, only the last ZOOM keyword is used. Variables 

Table 10

Constant  Description 

TABLE Stores the measurement data in a table, as well as all of the 
traces used for the measurements, in comma-separated-value 
(CSV) format.

GRAPHICS Stores the measurement data in a CGM graphic file.
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are not allowed as parameters for this keyword. The start and stop wavelength 
values can only be constants. DEFAULT is not allowed for these values. 
Reference level and scale values must be either constants with units or the 
keyword DEFAULT. DEFAULT reference level or the scale parameters specify 
that those settings will not change when zooming in the display. 
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Passive Component Test Remote Commands

The Agilent 86140B Series Optical Spectrum Analyzer User’s Guide for the 
mainframe provides detailed information on remote programming of the 
instrument. Only commands unique to the Passive Component Test application 
are included in this section.

Passive Component Test application specific commands 

These remote commands are specific to the Passive Component Test 
application and allow you to control the application remotely. They are grouped 
under the following subsystems:

• CALCulate Subsystem Commands

• DISPlay Subsystem Commands

• FORMat Subsystem Commands

• HCOPy Subsystem Commands

• INITiate Subsystem Commands

• MMEMory Subsystem Commands

• SENSe Subsystem Commands

• TRACe Subsystem Commands

For more information, refer to the Remote Operation section in the Agilent 
86140B Series Optical Spectrum Analyzer User’s Guide, or to the following 
book:

SCPI Consortium. SCPI–Standard Commands for Programming Instruments, 1997
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Command Conventions

Table 11

Convention  Description 

< > Angle brackets indicate text strings entered by the developer.

[] Square brackets indicate that the keyword DEFAULT can be used instead 
of a value or a variable for that parameter. Refer to the actual command 
description for the behavior when the DEFAULT keyword is used for a 
parameter.

| Indicates a choice of one element from a list.

{} Braces indicate a group of constants to select from. Each constant is 
separated by the | character.

name Indicates the variable for which you provide a descriptive name. Any letter 
(Aa-Zz) followed by letters, digits (0-9) and underscore (_). Only the first 32 
characters are significant.

spec_min –infinity. The parameter spec_min cannot be a variable, only a constant or 
DEFAULT.

spec_max +infinity. The parameter spec_max cannot be a variable, only a constant or 
DEFAULT.

from  Start wavelength or frequency of trace in nm (default) or THz.

to  Stop wavelength or frequency of trace in nm (default) or THz.

excursion +excursion: means excursion dBs up (for example, from a pit). 
-excursion: means excursion dBs down (for example, from a peak).

ref_pt The reference point to be used for a measurement keyword.
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CALCulate Subsystem Commands 

The CALCulate subsystem performs post-acquisition data processing. The 
CALCulate subsystem operates on data acquired by a SENSe function. 

CALCulate:DATA:GRAPh?

Returns the trace plot as an indefinite length block. After removing the #0 
prefix and newline suffix, the data can be saved as a cgm format file. 

CALCulate:DATA:RESults?

Returns a comma separated list of measurement results. The results are 
returned in the order defined by the specification set file. The results are the 
same as the results table.

CALCulate:DATA:TABLe?

Returns the measurement data in tabular format as an indefinite length block. 
The measurement data contains the table of results, instrument settings, and 
trace points. After removing the #0 prefix and newline suffix, the data can be 
saved as a csv format file.

CALCulate:PATH[:NAME]?

Returns the name of the device path to be tested as defined in the specification 
set.

CALCulate:PATH:RESult?

Returns the result of the device path measurement.

• -1 = No measurement made

• 0 = Device path failed specs

• 1 = Device path passed specs
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CALibration Subsystem Commands

This subsystem has the function of performing system calibration. 

CALibration Alignment

Performs an automatic alignment of the instrument at the wavelength of the 
largest signal found in full span. This aligns the monochromator output with 
the photodetector for improved amplitude accuracy. Sending this command 
with a marker on screen will generate a Settings conflict error.

Syntax CAL:ALIG

Related Key Auto Align
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DISPlay Subsystem Commands

The DISPlay subsystem controls the selection and presentation of textual, 
graphical, and TRACe information.

DISPlay[:WINDow]:DUT:COMMent<string>

Enters a new comment string for the device under test.

DISPlay[:WINDow]:DUT:COMMent?

Returns the comment string for the device under test. 

DISPlay[:WINDow]:DUT[:ID]<string>

Enters a new identification string for the device under test.

DISPlay[:WINDow]:DUT[:ID]?

Returns the identification string for the device under test.
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FORMat Subsystem Commands

The FORMat subsystem sets a data format for transferring numeric and array 
information.

FORMat[:DATA] REAL[64]|ASCII

FORMat[:DATA]?

Specifies the trace data format used during data transfer via GPIB. This 
command effects data transfers for the CALCulate[:DATA] subsystem.

The ASCII format is a comma-separated list of numbers.

The REAL format is a definite-length block of 64-bit floating-point binary 
numbers. The definite-length block is defined by IEEE 488.2: a “#” character, 
followed by one digit (in ASCII) specifying the number of length bytes to follow, 
followed by the length (in ASCII), followed by length bytes of binary data. The 
binary data is a sequence of 8-byte, 64-bit floating point numbers.
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HCOPy Subsystem Commands

The HCOPy subsystem controls the setup of and printing to an external device.

HCOPy:DESTination”SYSTem:COMMunicate:INTernal”|”SYSTem:COMMunicate:
CENTronics”

HCOPy:DESTination?

Selects the I/O port for hardcopy output. This effects subsequent use of the 
PRINT key and the HCOPy[:IMMediate] command.

HCOPy:DEVice:MODE TABLe|GRAPh|ALL

Determines the hardcopy output of the measurement results. The data can be 
printed as a table, a graph, or both.

HCOPy:IMMediate

Prints out the test results to the port defined by the HCOPy:DESTination 
command. The data printed is affected by the HCOPy:DEVice:MODE command.
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INITiate Subsystem Commands

The INITiate subsystem is used to control the initiation of the TRIGger 
subsystem.

INITiate:IMMediate[:SEQuence [1|2]]

Initiates the normalization routine (sequence 1) or the measurement routine 
(sequence 2) based on the sequence number. Measures only one path at a 
time.

INITiate:ABORt

Aborts the measurement of a device under test.
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INSTrument Subsystem Commands

The INSTrument subsystem provides a mechanism to identify and select 
logical instruments by either name or number. Arguments and responses are 
case sensitive.

INSTrument:CATalog?

{OSA,PassiveComponent,WDM_AutoScan<null>}

Comma-separated list of strings representing the Modes and Applications 
supported in the instrument.

INSTrument:CATalog:FULL?

{OSA,0,PassiveComponent,1,WDM_AutoScan,2}

Comma-separated list of string-numeric pairs representing the Modes and 
Applications supported in the instrument.

INSTrument:SELect <identifier> identifier - string

INSTrument:NSELect <numeric_value>

INSTrument:NSELect?

Loads the application or instrument mode specified. 

Example INSTrument:SELect ”WDM_AutoScan”

INSTrument:NSELect 2
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MMEMory Subsystem Commands

The MMEMory subsystem provides mass storage capabilities for instruments. 
The mass storage may be either internal or external to the instrument.

MMEMory:SSET:CATalog?

Returns a comma separated list of imported specification sets from the 
instrument’s internal memory.

MMEMory:SSET:DATA<file_name>,<data_block>

MMEMory:SSET:DATA? <file_name>

Imports a specification set <file_name>, where <data_block> is a definite 
length block containing the specification set. Refer to “Designing Specification 
Sets” on page 3-22 for additional designing information.

Returns a specification set file <file_name> as an indefinite length block. After 
removing the #0 prefix and newline suffix, the data can be saved as a csv 
format file.

MMEMory:SSET:DELete<file_name>

Deletes a specification set from the instruments internal memory.

MMEMory:SSET:LOAD<file_name>

MMEMory:SSET:LOAD?

Loads an imported specification set as the current set of specs.
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SENSe Subsystem Commands

The SENSe setup commands control the specific settings of the device.

[SENSe]:SWEep:POINts?

Returns the number of data points acquired during a sweep. This command is 
used in conjunction with the TRACe:POINts? query when downloading a trace.
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TRACe Subsystem Commands

A TRACe area is a named entity stored in instrument memory.

TRACe[:DATA]?TRA|TRB|TRC|TRD|TRE|TRF

Returns the data points for the trace. The trace data format is determined by 
the FORMat subsystem.
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Sample Program

10    ! Program to demonstrate selecting a spec set
20    ! and then reading the results
30    !
40    ! The spec set for this program is example 3-15.
50    !
60    ! re-store “pctbfg”
70    !
80    ASSIGN @Osa TO 723;EOL CHR$(12) END ! Set command terminator to LF 
& EOI
90    !
100   PRINTER IS “results.txt”
110   !
120   OUTPUT @Osa;”inst:sel ‘PassiveComponent’”     ! Loads PCT application
130   ! Note that a name must be in delimiters, ‘ or “
140   !
150   !
160   OUTPUT @Osa;”mmem:sset:load ‘PASS100’”   ! Load spec set from memory
170   !
180   OUTPUT @Osa;”disp:dut:comm ‘Remote measurement control’” ! Send comment line
190   OUTPUT @Osa;”disp:dut:comm?”
200   ENTER @Osa;Comment$
210   PRINT Comment$
220   !
230   OUTPUT @Osa;”disp:dut:id ‘DUT 12678’”     ! Send a new DUT ID
240   OUTPUT @Osa;”disp:dut:id?”
250   ENTER @Osa;Id$
260   PRINT Id$
270   !
280   PRINT “Make connections for normalization”
290   INPUT “Ready? Press Enter”,A$
300   OUTPUT @Osa;”init:imm:seq 1”        ! Execute normalization routine
310   !
390   !
400   PRINT “Make connections for measurement”
410   INPUT “Ready? Press Enter”,A$
420   OUTPUT @Osa;”init:imm:seq 2” ! Execute measurement routine
430   !
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440   OUTPUT @Osa;”calc:path:res?” ! Query measurement results
450   ENTER @Osa;Results
460   IF Results=1 THEN 500        ! Test for 1 as measurement passed
470   PRINT “Measurement failed “;Results
480   BEEP
490   STOP
500   PRINT “Measurement Passed”
510   !
520   !   ***   Read measurement table results   ***
530   !
540   OUTPUT @Osa;”calc:data:res?”      ! Read results column in table
550   ENTER @Osa;Peak_wl,Ins_loss,Bwidth_3db,Bwidth_6db,Bwidth_10db,Xtalk
560   !
570   PRINT “Peak Wavelength”,Peak_wl
580   PRINT “Insertion Loss”,Ins_loss
590   PRINT “3 dB Bandwidth”,Bwidth_3db
600   PRINT “6 dB Bandwidth”,Bwidth_6db
610   PRINT “10 dB Bandwidth”,Bwidth_10db
620   PRINT “Cross talk”,Xtalk
630   !
640   !   ***   Print out table   ***
650   !
660   OUTPUT @Osa;”hcop:dev:mode tabl”    ! Select table for printout
670   OUTPUT @Osa;”hcop:imm”      ! print
680   !
700  END

Remote measurement

DUT 12678

Make connections for normalization

Make connections for measurement

Measurement Passed

Peak Wavelength      1553.794 

Insertion Loss       8.47 

3 dB Bandwidth       .585 

6 dB Bandwidth       .703 

10 dB Bandwidth      .891 
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Sample Program
Cross talk      21 

Model# / Serial# 86142A / US38380189

FW Rev / App Rev P.03.00

Sens / Measured in -85.11 dBm / In Vacuum

Parameter Actual Spec Min Spec Max

Passband

Peak._WL 1553.794
nm

1540.00 1560.00

Insertion_Loss 8.47 dB -- 10.00

BandWidth_3dB 0.585 nm 0.500 1.700

BandWidth_6dB 0.703 nm 0.500 1.700

BandWidth_10dB 0.891 nm 0.500 2.00

XTalk 21.00 dB 12.00 --
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About the Application
About the Application

The WDM channel analysis application gives accurate wavelength, power and 
optical signal-to-noise ratio measurements. The results are displayed in an 
easy-to-read table. The WDM channel analysis application calculates the 
following attributes and display the results in the table:
• Channel number for the channel with the maximum power
• Maximum channel power (dBm)
• Channel number for the channel with the minimum power
• Minimum channel power (dBm)
• Channel number for the channel with the maximum optical signal-to-noise ratio
• Maximum optical signal-to-noise ratio (dB)
• Channel number for the channel with the minimum optical signal-to-noise ratio
• Minimum optical signal-to-noise ratio (dB)
• Span tilt (dB/nm)
• Span tilt (dB)
• Peak-to-peak deviation, defined as: 

maximum channel power – minimum channel power

Using a noise sweep resolution bandwidth of 0.06 nm, the maximum 
wavelength span that can be measured is 75 nm. The maximum number of 
WDM channels that can be measured is 187.

The WDM channel analysis application uses a unique dual-sweep 
measurement technique. The first sweep uses a slightly broader filter to 
accurately measure signal power. The other sweep uses a very narrow band 
filter to measure the power density of the noise floor. The noise markers, which 
are corrected for filter shape, provide improved accuracy for the noise floor 
power density measurement which results in increased measurement 
accuracy of the optical signal-to-noise ratio. 

This section provides a description of the user interface for this application. 
The behavior of the “Applications” menu of the OSA is also described. 
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The  Measurement  Applications Menus
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About the Application
The application softkeys are accessed using the front-panel APPL’S key or the 
Applications menu, Launch an Installed Application selection on the menu bar.
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Performing Measurements

This section provides procedures for performing the following functions:
To start the WDM channel analysis application 4-7
To perform an autoscan 4-8
To set up a measurement 4-9
To start a measurement 4-14
To stop a measurement 4-14
To display the results in a table 4-16
To change the wavelength units in the table 4-18
To document measurement results 4-19
To save the results to floppy 4-20
To print the results 4-21
To enter a device ID 4-22
To enter comments 4-23
To set up the printer 4-24
To exit the application 4-24

Note

The following functions assume the lightwave component analyzer is loaded.
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Starting the Application

This section explains how to start and use the WDM channel analysis 
application. 

With the WDM channel analysis application you can test WDM sources, WDM 
multiplexers and other WDM components, such as filters and couplers.

To use the WDM channel analysis application you must:

1 Start the application, refer to “To start the WDM channel analysis application” on 
page 4-7.

2 Set up the measurement, refer to “To set up a measurement” on page 4-9.

3 Measure the device under test.

You can then:

• View the results in a table, refer to “To display the results in a table” on page 4-16.

• Save the results, refer to “To save the results to floppy” on page 4-20.

• Print the results, refer to “To print the results” on page 4-21.

4 Examine one channel or wavelength range in filter mode.
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To start the WDM channel analysis application

1 Press the front-panel APPL’S key or on the Applications menu select Launch an 
Installed Application.

2 The following screen is displayed.

Figure 1 Applications Panel and Menu

The panel and the menu change whenever an application is installed or un-
installed. Each installed application has an icon on the panel and a 
corresponding softkey. 

3 Press the WDM SPECTRUM softkey to launch the channel analysis application.
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Performing Measurements
To perform an autoscan

Press the START AUTOSCAN.... softkey.

An automated channel scan is performed. The channel power, wavelength, 
optical signal-to-noise ratio, spectral gain tilt, and other statistics can be 
displayed either graphically or in a tabular format.
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Performing Measurements
To set up a measurement

Press the MEASUREMENT SETUP... softkey to open the Measurement setup menu 
and panel. This softkey is enabled whenever the system is not actively 
measuring. 

The Measurement Setup panel opens.
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Performing Measurements
WDM Measurement Setup panel 

Setup panel selections Start Wavelength

Default: 1530 nm

Sets the start wavelength for the Auto Scan function. Units are fixed in nm.

Stop Wavelength

Default: 1570 nm

Sets the stop wavelength for the Auto Scan function. Units are fixed in nm.

Wavelength Units

Default: nm

Selects the wavelength units, either nm or THz. These units are used in the 
display table only.

Peak Excursion

Default: 10 dB
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Sets the peak excursion value in dB. This is the amount of amplitude the trace 
must rise and fall to considered a peak. Lower values lead to more signals 
being discerned, but if the peak excursion is set too low, peaks in the noise 
floor may be discerned as signals. If excursion is set too high, legitimate peaks 
may not be discerned as signals.

Peak Threshold

Default: -55 dBm

Sets the peak threshold value in dBm. Power levels below this threshold are 
not considered for peak search.

Noise Method

Default: Pit

Selects the noise method used: You can choose BETWEEN CHANNELS, PIT, or 
OFFSET.

When Between Channels is selected, the Noise marker is placed half-way 
between channels when making a noise power density measurement. The 
Noise power density used in the OSNR calculation is linearly interpolated 
between the noise marker to the left and to the right of the channel. If the 
channel is the leftmost or rightmost channel in the measurement range, the 
noise would then be measured using the offset value for the side without an 
adjacent channel.

When Pit is selected, the noise marker is placed at the lowest point between 
adjacent channels. The Noise power density used in the OSNR calculation is 
linearly interpolated between the noise marker to the left and to the right of the 
channel. If a pit is not detected for the left and right side, the offset value 
specified for the noise measurement is used.

When Offset is selected, the noise marker ‘noise offset’ is placed to the left and 
to the right of the channel when making a noise power density measurement. 
The Noise power density used in the OSNR calculation is linearly interpolated 
between the noise marker to the left and to the right of the channel. The noise 
is always measured at the offset value specified.
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Channel Spacing

Default: 100 GHz

Sets the channel spacing value in GHz. This value is the spacing between 
adjacent channels on the input signal. This value is used to calculate the noise 
offset value to use (noise offset = 1/2 channel spacing). The calculated noise 
offset value is displayed to the right of the channel spacing.

Sensitivity

Default: –65 dBm

Sets31 the sensitivity value in dBm. Increasing sensitivity results in a more 
precise scan but increases the scan time.

Peak Sweep Res BW

Default: 0.2 nm

Sets the resolution bandwidth value to be used during peak sweep. This 
determines the analyzer’s ability to display two closely spaced signals as two 
distinct responses. Decreasing the resolution bandwidth provides a more 
detailed sweep but increases the scan time. The resolution bandwidth can be 
set to one of the following values: 0.07, 0.09, 0.1, 0.2, 0.5, 1, 2, 3, 4, 5, 6, 7, 8, 9, 
or 10 nm. For model 86142B, the minimum setting is 0.06 nm.

Noise Sweep Res BW

Default: 0.1 nm

Sets the resolution bandwidth value to use during noise sweep. This 
determines the analyzer’s ability to display two closely spaced signals as two 
distinct responses. Decreasing the resolution bandwidth provides a more 
detailed sweep but increases the scan time. The resolution bandwidth can be 
set to one of the following values: 0.06, 0.09, 0.1, 0.2, 0.5, 1, 2, 3, 4, 5, 6, 7, 8, 9, 
or 10 nm. For model 86141B and 86140B Option 025, the minimum setting is 
0.07 nm.

Measurement Trigger Mode

Default: Single Trigger mode
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Select either single or continuous trigger mode.

The navigation key operation is explained in To fill in a setup panel 25.
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Performing Measurements
To start a measurement

• Press the START AUTOSCAN softkey to start the measurement process. 

A 2-sweep measurement is initiated. After the measurement is completed, the 
system either stops (Measurement Trigger Mode = Single), or initiates another 
2-sweep measurement (Measurement Trigger Mode = Continuous).

During the measurement, the button label changes to STOP MEASUREMENT. Once 
the measurement is complete, the button label changes back to START AUTO 
SCAN.

To stop a measurement

• Press STOP MEASUREMENT to stop a measurement in progress.

Selecting this softkey will stop the 2-sweep measurement cycle mid-sweep. 
Once the measurement is stopped, the button label changes to START AUTOSCAN.

To select the external 9 µm fiber filter path

For Agilent 86144B/86146B only

The 9µm external optical path is used to increase dynamic range and resolution 
bandwidth of the OSA. 

1 Connect a 9 µm fiber between the Monochromator Output and the Photodetector 
Input.

2 Connect a light source to the Optical Input.

3 Press Select Path > Path External > Switch Path Auto Align Now. 

An auto align is performed on the 9 µm filter path mode. This aligns the output 
of the monochromator with the photodetector input for improved amplitude 
accuracy.

Once Auto Align is completed, the OSA will return to the previous 
measurement state.

4 Press Start AutoScan to activate the external path and to update the measurement 
data. 
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Tip: If you want to proceed directly to using an external filter mode (Filter Mode 
On), then the step above is not required.

To analyze a channel or wavelength

For Agilent 86144B/86146B only

The Agilent 86144B and 86146B filter mode allows a single channel or 
wavelength from a dense wavelength division multiplex (DWDM) to be isolated 
and routed to another measurement instrument. The filtering is accurate and 
flexible. It has low polarization dependent loss (PDL), adjustable filter 
bandwidth, and a wide tuning range. 

1 Perform the procedure To select the external 9 µm fiber filter path 14. 

The auto scan will identify and number the WDM channels. Using filter mode, 
you can easily filter out any of the channels by number, to the front panel 
Monochromator Output port.

2 Press Filter Mode On Off so that On is underlined. 

3 Press Filter by WVL CH# to select the desired mode. 

a Select WVL > Filter Wavelength to tune to a particular wavelength for further 
analysis. For example, you can take the noise floor near a channel and route it to 
a DCA plug-in module. 

A triangle marker will appear at the selected wavelength.

b Select CH# > Filter Channel Number to select a particular channel to be filtered 
out and routed to a DCA plug-in module to measure the power, or a bit error rate 
tester to measure the Q factor. 

A triangle marker will appear at the selected channel.

N o t e If the input signal is changing, you may periodically want to update your measurement. 
To do this, exit filter mode (Filter Mode Off) and then proceed in one of the two ways: 1. 
Connect the OSA Monochromator Output to the Photodetector Input and Press Start 
AutoScan. 2. Switch to the internal filter path (Filter Path Int) and press Start AutoScan.
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To display the results in a table

• Press the DISPLAY TABLE.... softkey. The results are displayed in a table similar to the one 
shown below.

PAGE UP display the previous page of results, if possible. 

PAGE DOWN display the next page of results, if possible. 

DONE exit the tabular display and return to the Auto Scan main menu.
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The WDM channel analysis application calculates the following statistics and 
display the results at the bottom of the table:
• Channel number for the channel with the maximum power
• Maximum channel power (dBm)
• Channel number for the channel with the minimum power
• Minimum channel power (dBm)
• Channel number for the channel with the maximum optical signal-to-noise ratio
• Maximum optical signal-to-noise ratio (dB)
• Channel number for the channel with the minimum optical signal-to-noise ratio
• Minimum optical signal-to-noise ratio (dB)
• Span tilt (dB/nm)
• Span tilt (dB)
• Peak-to-peak deviation, defined as: 

maximum channel power – minimum channel power

Using a noise sweep resolution bandwidth of 0.06 nm, the maximum 
wavelength span that can be measured is 75 nm. The maximum number of 
WDM channels that can be measured is 187.
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To change the wavelength units in the table

1 Press the MEASUREMENT SETUP.... softkey. The following window opens.

Measurement Setup panel

2 Select the desired units for the table. You can select either nanometers or terahertz.

3 Press the CLOSE PANEL.... softkey when you are finished making your selections.
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To document measurement results 

There are two ways to document results in the WDM Application. You can 
either print them to a printer (specified under printer setup) or you can save 
them to a floppy disk.

When the instrument is not sweeping, the DOCUMENT RESULTS... key of the WDM 
Application Main Menu is enabled. 

• Press the DOCUMENT RESULTS... softkey. The following window opens.

Document Results Menu
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To save the results to floppy

• Press the SAVE RESULTS TO FLOPPY softkey to save the current results to a file on the flop-
py drive. 

The name of the file is defined as the last 8 characters of the ID. If no ID exists, 
a message prompts the user to “Enter a Device ID as filename”. See “To enter a 
device ID” on page 4-22 for additional information. 

Save Dialog Panel and Menu

If the ID already exists, the warning “Overwrite File?” is displayed.

The current file is saved in .csv spreadsheet format. 
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To print the results

1 Press the PRINT RESULTS softkey to print the results to the target printer. 

The target printer is as set by factory default, otherwise it retains the previous 
setting from the last time the application was started. 

2 To change the target printer, press the PRINTER SETUP softkey. 

3 The print operation is confirmed by a progress message displayed in the standard 
progress panel used in the base instrument.
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To enter a device ID

• Press the ENTER ID... softkey to access the Device Identification panel 

Device Identification panel

Entering characters and navigating this panel is explained in To use the 
alphanumeric panel softkeys 27.
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To enter comments

• Press the ENTER COMMENTS... softkey to access the Enter Comments panel. 

Enter Comments panel

Entering characters and navigating this panel is explained in To use the 
alphanumeric panel softkeys 27.
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To set up the printer

1 Press the PRINTER SETUP softkey to access the Printer Setup panel. 

The default setting is the internal printer and the default printout type is table 
only. 

2 Use the check boxes to select the target printer, either external or internal, and the 
printout type. This setting is reset when the front-panel PRESET key is pressed, 
otherwise the previous setting from the last time the application was started is 
retained.

Printer Setup panel 

Navigating and filling in the setup panel is explained in To fill in a setup panel
25.
PREVIOUS MENU... Returns to the Auto Scan Menu.

To exit the application

• Press the EXIT APPLICATION softkey to exit the application.
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To fill in a setup panel

Any of the instrument settings can be changed by using either the front-panel 
keys or the menu bar selections. Many of the menu selections and front-panel 
keys display a softkey panel. Settings in softkey panels are changed using the 
softkeys, data-entry keys, mouse, and trackball.

Setup panels, such as the Measurement Setup panel, allow you to adjust setup 
conditions which are not frequently changed.

An example of a setup panel
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Using the softkeys

The arrow softkeys

Allow you to navigate from field to field in the dialog box. The highlighted 
parameter can be changed.

The Select softkey

Selects or deselects the highlighted parameter.

The Defaults softkey

Resets the parameters to their default condition.

Close Panel.... softkey

Saves the current setup and returns you to the previous menu.

The front-panel number keys, step keys, and knob

Allow you to enter a numeric value in the highlighted field. 
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Performing Measurements
To use the alphanumeric panel softkeys

Alphanumeric panels, such as the Device Identification panel, allow you to 
enter identification and comment labels for the devices you test.

An example of an alphanumeric panel
4-27



WDM Channel Analysis Application

Performing Measurements
Using the softkeys

The Select softkey

Selects the highlighted character.

The arrow softkeys

Allow you to navigate from character to character in the dialog box.

The Backspace softkey

Removes a previously selected character.

Continue.... softkey

Saves the current entry and returns you to the previous menu.
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WDM Channel Analysis Remote Commands

The Agilent 86140B Series Optical Spectrum Analyzer Programming Guide for 
the mainframe provides detailed information on remote programming of the 
instrument. Only commands unique to the lightwave component analyzer are 
included in this section.

The WDM channel analysis application remote command set is comprised of 
two types of commands:

General Application support commands 

These are part of the base firmware and support applications in general. These 
commands allow the user to obtain a list of installed applications, load/unload 
an application, and so on. 

WDM channel analysis application specific commands 

These remote commands are specific to the WDM channel analysis application 
and allow you to control the WDM channel analysis application remotely. They 
are grouped under the following subsystems:

• CALCulate Subsystem Commands

• CALibration Subsystem Commands

• FORMat Subsystem Commands

• INITiate Subsystem Commands

• INPut Subsystem Commands

• ROUTe Subsystem Commands

• SENSe Subsystem Commands

For more information, refer to the Remote Operation section in the Agilent 
86140B Series Optical Spectrum Analyzer Programming Guide, or to the 
following book:
4-29



WDM Channel Analysis Application

WDM Channel Analysis Remote Commands
SCPI Consortium. SCPI–Standard Commands for Programming Instruments, 1997
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Command Conventions

Table 1

Convention  Description 

< > Angle brackets indicate text strings entered by the developer.

[ ] Square brackets indicate that the keyword DEFAULT can be used instead 
of a value or a variable for that parameter. Refer to the actual command 
description for the behavior when the DEFAULT keyword is used for a 
parameter.

| Indicates a choice of one element from a list.

{ } Braces indicate a group of constants to select from. Each constant is 
separated by the | character.

name Indicates the variable for which you provide a descriptive name. Any letter 
(Aa-Zz) followed by letters, digits (0-9) and underscore (_). Only the first 32 
characters are significant.

spec_min –infinity. The parameter spec_min cannot be a variable, only a constant or 
DEFAULT.

spec_max +infinity. The parameter spec_max cannot be a variable, only a constant or 
DEFAULT.

from  Start wavelength or frequency of trace in nm (default) or THz.

to  Stop wavelength or frequency of trace in nm (default) or THz.

excursion +excursion: means excursion dBs up (for example, from a pit). 
-excursion: means excursion dBs down (for example, from a peak).

ref_pt The reference point to be used for a measurement keyword.
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CALCulate Subsystem Commands 

The CALCulate subsystem performs post-acquisition data processing. The 
CALCulate subsystem operates on data acquired by a SENSe function. For 
more information, refer to page 4-1 of the 1997 SCPI Command Reference.

CALCulate:DATA:CPOWers?

This command allows the user to download the array of channel powers 
measured. The data is returned in either an ASCII or binary form as determined 
by the FORMat:DATA command. The number of data points in this array is 
determined by the CALCulate:DATA:NCHannels? query.

CALCulate:DATA:CSNR?

This command allows the user to download the array of channel OSNR values 
measured. The data is returned in either an ASCII or binary form as determined 
by the FORMat:DATA command. The number of data points in this array is 
determined by the CALCulate:DATA:NCHannels? query.
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CALCulate:DATA:CSTats?

This command allows the user to download the following statistics using a 
single query:
• Channel number for the channel with the maximum power
• Maximum channel power (dBm)
• Channel number for the channel with the minimum power
• Minimum channel power (dBm)
• Channel number for the channel with the maximum optical signal-to-noise ratio
• Maximum optical signal-to-noise ratio (dB)
• Channel number for the channel with the minimum optical signal-to-noise ratio
• Minimum optical signal-to-noise ratio (dB)
• Span tilt (dB/nm)
• Span tilt (dB)
• Peak-to-peak deviation, defined as: 

maximum channel power – minimum channel power

Using a noise sweep resolution bandwidth of 0.06 nm, the maximum 
wavelength span that can be measured is 75 nm. The maximum number of 
WDM channels that can be measured is 187.

The data is returned in either an ASCII or binary form as determined by the 
FORMAT:DATA command. 

CALCulate:DATA:CWAVelengths?

This command allows the user to download the array of channel wavelengths 
measured. The data is returned in either an ASCII or binary form as determined 
by the FORMat:DATA command. The number of data points in this array is 
determined by the CALCulate:DATA:NCHannels? query. The units are either 
nanometers or terahertz and can be changed using the 
CALCulate:DATA:TABLe:WAVe command.

CALCulate:DATA:NCHannels?

This command allows the user to query the number of channels detected in the 
last measurement. The data is returned as an ASCII integer. 
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CALCulate:DATA:TABLe:WAVe NM|THZ

CALCulate:DATA:TABLe:WAVe?

Sets the wavelength units used for the tabular display and for the 
CALCulate:DATA:CWAVelengths remote query. The instrument x-axis display 
always displays wavelength in nanometers and is not affected by this 
command.

CALCulate:PEXCursion[:PEAK] <numeric_value> 

CALCulate:PEXCursion[:PEAK]? 

Sets the peak excursion value for the marker search routines. The peak 
excursion value is used to determine whether or not a local maximum in the 
trace is to be considered a peak. To qualify as a peak, both sides of the local 
maximum must fall by at least the peak excursion value.

CALCulate:THReshold <numeric_value> [W|MW|UW|DBM]

CALCulate:THReshold? 

Specifies the value for the peak search threshold. Peaks with amplitudes below 
this value will not be included in the channel count. 

Default units are DBM.
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CALibration Subsystem Commands

This subsystem has the function of performing system calibration. 

CALibration Alignment

Performs an automatic alignment of the instrument at the wavelength of the 
largest signal found in full span. This aligns the monochromator output with 
the photodetector for improved amplitude accuracy. Sending this command 
with a marker on screen will generate a Settings conflict error.

Syntax CAL:ALIG

Related Key Auto Align
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DISPlay Subsystem Commands

The DISPlay subsystem controls the selection and presentation of textual, 
graphical, and TRACe information.

DISPlay[:WINDow]:DUT:COMMent<string>

Enters a new comment string for the device under test.

DISPlay[:WINDow]:DUT:COMMent?

Returns the comment string for the device under test. 

DISPlay[:WINDow]:DUT[:ID]<string>

Enters a new identification string for the device under test.

DISPlay[:WINDow]:DUT[:ID]?

Returns the identification string for the device under test.

DISPlay[:WINDow[1]]:TRACe:Y[:SCALe]:RLEVel <numeric_value>[W|MW|UW|DBM]

DISPlay[:WINDow[1]]:TRACe:Y[:SCALe]:RLEVel?

Specifies the value of the reference level. Default units are DBM. Starting a 
measurement from the front panel sets the reference level automatically based 
on the maximum channel power. The reference level needs to be set manually 
when using the instrument remotely.
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FORMat Subsystem Commands

The FORMat subsystem sets a data format for transferring numeric and array 
information.

FORMat[:DATA] REAL[32,64]|ASCII

FORMat[:DATA]?

Specifies the trace data format used during data transfer via HP-IB. This 
command affects data transfers for the CALCulate[:DATA] subsystem. The 
ASCII format is a comma-separated list of numbers. The REAL format is a 
definite-length block of 64-bit floating-point binary numbers. The definite-
length block is defined by IEEE 488.2: a "#" character, followed by one digit (in 
ASCII) specifying the number of length bytes to follow, followed by the length 
(in ASCII), followed by length bytes of binary data. The binary data is a 
sequence of 8-byte (64-bit) floating point numbers. 
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INITiate Subsystem Commands

The INITiate subsystem is used to control the initiation of the TRIGger 
subsystem.

INITiate:IMMediate

Initiates a new 2-sweep WDM measurement. This command is disabled when 
in when INPut:FILTer[STATe] is ON.
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INPut Subsystem Commands

The INPut subsystem is used to control the filter mode function. You must be in 
filter mode to use the INPut:FILTer commands.

N o t e The INPut subsystem commands are only available on the 86144B and 86146B.

INPut:FILTer:BANDwidth|BWIDth[:RESolution] <value>[wvl units]

INPut:FILTer:BANDwidth|BWIDth[:RESolution]?

Sets the resolution bandwidth of the filter. The query returns the filter’s 
resolution bandwidth.

INPut:FILTer:BANDwidth|RESolution|AUTOmatic <ON|OFF>

INPut:FILTer:BANDwidth|RESolution|AUTOmatic? 

Sets resolution bandwidth of the filter to automatic or manual mode. The query 
returns the automatic or manual status.

INPut:CHANnel <channel number>

Sets the filter to the wavelength of the specified channel. The channel number 
must be >0 and <=NUM_CHANNELS. There is no query associated with this 
command. Instead you should use INPut:FILTer:WAVelength?.

INPut:FILTer[:STATe] <ON|OFF>

INPut:FILTer[:STATe]?

Turns the filter mode on/off. If the external path has not been selected, a 
“Settings Conflict” error will be returned. IMITiate:IMMediate (sweeps) will be 
disabled while in filter mode.

The query returns the status of the filter mode. The query returns a 1 if the filter 
mode is on or returns a 0 if the filter mode is off.
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INPute:FILTerWAVelength <value>

INPute:FILTerWAVelength?

Sets the filter to the specified wavelength. The query returns the wavelength 
where the filter is currently set.
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INSTrument Subsystem Commands

The INSTrument subsystem provides a mechanism to identify and select 
logical instruments by either name or number. Arguments and responses are 
case sensitive.

INSTrument:CATalog?

{OSA,PassiveComponent,WDM_AutoScan<null>}

Comma-separated list of strings representing the Modes and Applications 
supported in the instrument.

INSTrument:CATalog:FULL?

{OSA,0,PassiveComponent,1,WDM_AutoScan,2}

Comma-separated list of string-numeric pairs representing the Modes and 
Applications supported in the instrument.

INSTrument:SELect <identifier> identifier - string

INSTrument:NSELect <numeric_value>

INSTrument:NSELect?

Loads the application or instrument mode specified. 

Example INSTrument:SELect ”WDM_AutoScan”

INSTrument:NSELect 2
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ROUTe Subsystem Commands

The ROUTe subsystem provides a mechanism to select the internal 50 µm or 
external 9 µm path.

ROUTe:PATH <INTernal|EXTernal>

ROUTe:PATH?

Available for the 86144B and 86146B only.

Selects the internal 50 µm or external 9 µm path. This command is disabled 
when in filter mode. The query will return the current path.
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SENSe Subsystem Commands

The SENSe setup commands control the specific settings of the device.

SENSe:BANDwidth|BWIDth[:RESolution]:NOISe <numeric_value> [M|NM|UM|A]

SENSe:BANDwidth|BWIDth[:RESolution]:NOISe? 

Specifies the resolution bandwidth value used for the ‘noise’ sweep in the 2-
sweep measurement mode. Default units are m.

SENSe:BANDwidth|BWIDth[:RESolution]:PEAK <numeric_value> [M|NM|UM|A] 

SENSe:BANDwidth|BWIDth[:RESolution]:PEAK? 

Specifies the resolution bandwidth value used for the ‘peaks’ sweep in the 2-
sweep measurement mode. Default units are m.

SENSe:CHANnel:SPACing <numeric_value> [HZ|KHZ|MHZ|GHZ]

SENSe:CHANnel:SPACing?

Specifies the value for channel spacing. Default units are GHz.

SENSe:NOISe [PIT|FIXED|HD]

SENSe:NOISe?

Specifies how the noise measurement locations are determined (pit, fixed 
offset, or half-distance between channels).
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SENSe:POWer[:DC]:RANGe:LOWer <numeric_value> [W|MW|UW|DBM] 

SENSe:POWer[:DC]:RANGe:LOWer? 

Specifies the sensitivity value used for the WDM channel analysis application 
measurements. Default units are dBm. 

N O T E The maximum value for sensitivity is +300 dBm. The minimum value is the value that 
causes the sweep time to become 1000 seconds, and is an attribute of each individual 
optical spectrum analyzer. The minimum value will always be less than the values for 
sensitivity shown in the Specifications section of the User’s Guide

SENSe:[WAVelength:]STARt <numeric_value> [M|NM|UM|A|HZ|KHZ|MHZ|GHZ]

SENSe:[WAVelength:]STARt?

Specifies the start wavelength for the WDM channel analysis application. 
Default units are M.

SENSe:[WAVelength:]STOP <numeric_value> [M|NM|UM|A|HZ|KHZ|MHZ|GHZ] 

SENSe:[WAVelength:]STOP?

Specifies the stop wavelength for the WDM channel analysis application. 
Default units are M.
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Contacting Agilent
Contacting Agilent

To learn more about your optical spectrum analyzer and other lightwave optical 
communication test solutions, visit our Internet web site. Before returning an 
instrument for service, call the Agilent Technologies Instrument Support Center 
at (800) 403-0801, or visit the Agilent Lightwave web site at www.agilent.com/
find/assist. See “Agilent Technologies Service Offices” on page 5-3 for a list of 
service centers.
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Before returning an instrument for service, call the Agilent Technologies 
Instrument Support Center at (800) 403-0801, or call one of the numbers listed 
below.

Agilent Technologies Service Numbers

Austria (43 1) 25125-7000

Belgium + Luxemburg (02) 404.93.03

Brazil (55 11) 7297-3700

Canada 888-447-7378

China 800-810-0508

France 01.69.82.66.69

Germany 01805 24 6337

Hong Kong 800-93-3229

India 91-80-343-5755

Ireland 01205 4500

Japan 0120-32-0119

Malaysia 1-800-880-399

Philippines 1-800-1651-0135

Singapore 1-800-275-0880

Spain (34-91) 631 3300 

Sweden (08) 506 487 00

Switzerland (+41 1) 735 9501

Taiwan 66 862 661 5900

United Kingdom 07004 123123

United States (800) 403-0801
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Cleaning Connections for Accurate Measurements 

Today, advances in measurement capabilities make connectors and connection 
techniques more important than ever. Damage to the connectors on calibration 
and verification devices, test ports, cables, and other devices can degrade 
measurement accuracy and damage instruments. Replacing a damaged 
connector can cost thousands of dollars, not to mention lost time! This 
expense can be avoided by observing the simple precautions presented in this 
book. This book also contains a brief list of tips for caring for electrical 
connectors.
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Choosing the Right Connector

A critical but often overlooked factor in making a good lightwave measurement 
is the selection of the fiber-optic connector. The differences in connector types 
are mainly in the mechanical assembly that holds the ferrule in position against 
another identical ferrule. Connectors also vary in the polish, curve, and 
concentricity of the core within the cladding. Mating one style of cable to 
another requires an adapter. Agilent Technologies offers adapters for most 
instruments to allow testing with many different cables. Figure 1 on page 5-6 
shows the basic components of a typical connectors.

The system tolerance for reflection and insertion loss must be known when 
selecting a connector from the wide variety of currently available connectors. 
Some items to consider when selecting a connector are: 

• How much insertion loss can be allowed? 

• Will the connector need to make multiple connections? Some connectors are better 
than others, and some are very poor for making repeated connections. 

• What is the reflection tolerance? Can the system take reflection degradation? 

• Is an instrument-grade connector with a precision core alignment required? 

• Is repeatability tolerance for reflection and loss important? Do your specifications take 
repeatability uncertainty into account? 

• Will a connector degrade the return loss too much, or will a fusion splice be required? 
For example, many DFB lasers cannot operate with reflections from connectors. Often 
as much as 90 dB isolation is needed.
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Figure 1 Basic components of a connector.

Over the last few years, the FC/PC style connector has emerged as the most 
popular connector for fiber-optic applications. While not the highest 
performing connector, it represents a good compromise between performance, 
reliability, and cost. If properly maintained and cleaned, this connector can 
withstand many repeated connections.

However, many instrument specifications require tighter tolerances than most 
connectors, including the FC/PC style, can deliver. These instruments cannot 
tolerate connectors with the large non-concentricities of the fiber common 
with ceramic style ferrules. When tighter alignment is required, Agilent 
Technologies instruments typically use a connector such as the Diamond HMS-
10, which has concentric tolerances within a few tenths of a micron. Agilent 
Technologies then uses a special universal adapter, which allows other cable 
types to mate with this precision connector. See Figure 2.

Figure 2 Universal adapters to Diamond HMS-10.
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The HMS-10 encases the fiber within a soft nickel silver (Cu/Ni/Zn) center 
which is surrounded by a tough tungsten carbide casing, as shown in Figure 3.

Figure 3 Cross-section of the Diamond HMS-10 connector.

The nickel silver allows an active centering process that permits the glass fiber 
to be moved to the desired position. This process first stakes the soft nickel 
silver to fix the fiber in a near-center location, then uses a post-active staking 
to shift the fiber into the desired position within 0.2 µm. This process, plus the 
keyed axis, allows very precise core-to-core alignments. This connector is 
found on most Agilent Technologies lightwave instruments.

The soft core, while allowing precise centering, is also the chief liability of the 
connector. The soft material is easily damaged. Care must be taken to minimize 
excessive scratching and wear. While minor wear is not a problem if the glass 
face is not affected, scratches or grit can cause the glass fiber to move out of 
alignment. Also, if unkeyed connectors are used, the nickel silver can be 
pushed onto the glass surface. Scratches, fiber movement, or glass 
contamination will cause loss of signal and increased reflections, resulting in 
poor return loss.
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Inspecting Connectors

Because fiber-optic connectors are susceptible to damage that is not 
immediately obvious to the naked eye, poor measurements result without the 
user being aware. Microscopic examination and return loss measurements are 
the best way to ensure good measurements. Good cleaning practices can help 
ensure that optimum connector performance is maintained. With glass-to-
glass interfaces, any degradation of a ferrule or the end of the fiber, any stray 
particles, or finger oil can have a significant effect on connector performance. 
Where many repeat connections are required, use of a connector saver or 
patch cable is recommended.

Figure 4 shows the end of a clean fiber-optic cable. The dark circle in the center 
of the micrograph is the fiber’s 125 µm core and cladding which carries the 
light. The surrounding area is the soft nickel-silver ferrule. Figure 5 shows a 
dirty fiber end from neglect or perhaps improper cleaning. Material is smeared 
and ground into the end of the fiber causing light scattering and poor reflection. 
Not only is the precision polish lost, but this action can grind off the glass face 
and destroy the connector.

Figure 6 shows physical damage to the glass fiber end caused by either 
repeated connections made without removing loose particles or using 
improper cleaning tools. When severe, the damage of one connector end can 
be transferred to another good connector end face that comes in contact with 
the damaged one. Periodic checks of fiber ends, and replacing connecting 
cables after many connections is a wise practice.

The cure for these problems is disciplined connector care as described in the 
following list and in Cleaning Connectors 12. 

Use the following guidelines to achieve the best possible performance when 
making measurements on a fiber-optic system: 

• Never use metal or sharp objects to clean a connector and never scrape the connector.

• Avoid matching gel and oils. 
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Figure 4 Clean, problem-free fiber end and ferrule.

Figure 5 Dirty fiber end and ferrule from poor cleaning.

Figure 6 Damage from improper cleaning.

While these often work well on first insertion, they are great dirt magnets. The 
oil or gel grabs and holds grit that is then ground into the end of the fiber. Also, 
some early gels were designed for use with the FC, non-contacting connectors, 
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using small glass spheres. When used with contacting connectors, these glass 
balls can scratch and pit the fiber. If an index matching gel or oil must be used, 
apply it to a freshly cleaned connector, make the measurement, and then 
immediately clean it off. Never use a gel for longer-term connections and never 
use it to improve a damaged connector. The gel can mask the extent of damage 
and continued use of a damaged fiber can transfer damage to the instrument.

• When inserting a fiber-optic cable into a connector, gently insert it in as straight a line 
as possible. Tipping and inserting at an angle can scrape material off the inside of the 
connector or even break the inside sleeve of connectors made with ceramic material.

• When inserting a fiber-optic connector into a connector, make sure that the fiber end 
does not touch the outside of the mating connector or adapter. 

• Avoid over tightening connections. 

Unlike common electrical connections, tighter is not better. The purpose of the 
connector is to bring two fiber ends together. Once they touch, tightening only 
causes a greater force to be applied to the delicate fibers. With connectors that 
have a convex fiber end, the end can be pushed off-axis resulting in 
misalignment and excessive return loss. Many measurements are actually 
improved by backing off the connector pressure. Also, if a piece of grit does 
happen to get by the cleaning procedure, the tighter connection is more likely 
to damage the glass. Tighten the connectors just until the two fibers touch.

• Keep connectors covered when not in use. 

• Use fusion splices on the more permanent critical nodes. Choose the best connector 
possible. Replace connecting cables regularly. Frequently measure the return loss of the 
connector to check for degradation, and clean every connector, every time.

All connectors should be treated like the high-quality lens of a good camera. 
The weak link in instrument and system reliability is often the inappropriate 
use and care of the connector. Because current connectors are so easy to use, 
there tends to be reduced vigilance in connector care and cleaning. It takes 
only one missed cleaning for a piece of grit to permanently damage the glass 
and ruin the connector.
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Measuring insertion loss and return loss

Consistent measurements with your lightwave equipment are a good 
indication that you have good connections. Since return loss and insertion loss 
are key factors in determining optical connector performance they can be used 
to determine connector degradation. A smooth, polished fiber end should 
produce a good return-loss measurement. The quality of the polish establishes 
the difference between the “PC” (physical contact) and the “Super PC” 
connectors. Most connectors today are physical contact which make glass-to-
glass connections, therefore it is critical that the area around the glass core be 
clean and free of scratches. Although the major area of a connector, excluding 
the glass, may show scratches and wear, if the glass has maintained its 
polished smoothness, the connector can still provide a good low level return 
loss connection.

If you test your cables and accessories for insertion loss and return loss upon 
receipt, and retain the measured data for comparison, you will be able to tell in 
the future if any degradation has occurred. Typical values are less than 0.5 dB 
of loss, and sometimes as little as 0.1 dB of loss with high performance 
connectors. Return loss is a measure of reflection: the less reflection the better 
(the larger the return loss, the smaller the reflection). The best physically 
contacting connectors have return losses better than 50 dB, although 30 to 
40 dB is more common.

Visual inspection of fiber ends

Visual inspection of fiber ends can be helpful. Contamination or imperfections 
on the cable end face can be detected as well as cracks or chips in the fiber 
itself. Use a microscope (100X to 200X magnification) to inspect the entire end 
face for contamination, raised metal, or dents in the metal as well as any other 
imperfections. Inspect the fiber for cracks and chips. Visible imperfections not 
touching the fiber core may not affect performance (unless the imperfections 
keep the fibers from contacting).

W A R N I N G Always remove both ends of fiber-optic cables from any instrument, 
system, or device before visually inspecting the fiber ends. Disable all 
optical sources before disconnecting fiber-optic cables. Failure to do 
so may result in permanent injury to your eyes.
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Cleaning Connectors

The procedures in this section provide the proper steps for cleaning fiber-optic 
cables and Agilent Technologies universal adapters. The initial cleaning, using 
the alcohol as a solvent, gently removes any grit and oil. If a caked-on layer of 
material is still present, (this can happen if the beryllium-copper sides of the 
ferrule retainer get scraped and deposited on the end of the fiber during 
insertion of the cable), a second cleaning should be performed. It is not 
uncommon for a cable or connector to require more than one cleaning.

C A U T I O N Agilent Technologies strongly recommends that index matching compounds not 
be applied to their instruments and accessories. Some compounds, such as 
gels, may be difficult to remove and can contain damaging particulates. If you 
think the use of such compounds is necessary, refer to the compound 
manufacturer for information on application and cleaning procedures.

Table 1 Cleaning Accessories 

Item  Agilent Part Number

Cotton swabs 8520-0023

Small foam swabs 9300-1223

Table 2 Dust Caps Provided with Lightwave Instruments 

Item  Agilent Part Number

Laser shutter cap 08145-64521

FC/PC dust cap 08154-44102

Biconic dust cap 08154-44105
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To clean a non-lensed connector 

C A U T I O N Do not use any type of foam swab to clean optical fiber ends. Foam swabs can 
leave filmy deposits on fiber ends that can degrade performance. 
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1 Apply pure isopropyl alcohol to a clean lint-free cotton swab or lens paper. 

Cotton swabs can be used as long as no cotton fibers remain on the fiber end after 
cleaning. 

2 Clean the ferrules and other parts of the connector while avoiding the end of the fiber.

3 Apply isopropyl alcohol to a new clean lint-free cotton swab or lens paper. 

4 Clean the fiber end with the swab or lens paper. 

Do not scrub during this initial cleaning because grit can be caught in the swab 
and become a gouging element. 

5 Immediately dry the fiber end with a clean, dry, lint-free cotton swab or lens paper. 

6 Blow across the connector end face from a distance of 6 to 8 inches using filtered, 
dry, compressed air. Aim the compressed air at a shallow angle to the fiber end face. 

Nitrogen gas or compressed dust remover can also be used. 

C A U T I O N Do not shake, tip, or invert compressed air canisters, because this releases 
particles in the can into the air. Refer to instructions provided on the 
compressed air canister. 

7 As soon as the connector is dry, connect or cover it for later use. 

If the performance, after the initial cleaning seems poor, try cleaning the 
connector again. Often a second cleaning will restore proper performance. The 
second cleaning should be more arduous with a scrubbing action.

To clean an adapter 

The fiber-optic input and output connectors on many Agilent Technologies 
instruments employ a universal adapter such as those shown in the following 
picture. These adapters allow you to connect the instrument to different types 
of fiber-optic cables.

Figure 7 Universal adapters.
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1 Apply isopropyl alcohol to a clean foam swab. 

Cotton swabs can be used as long as no cotton fibers remain after cleaning. The foam 
swabs listed in this section’s introduction are small enough to fit into adapters. 

Although foam swabs can leave filmy deposits, these deposits are very thin, and the risk 
of other contamination buildup on the inside of adapters greatly outweighs the risk of 
contamination by foam swabs. 

2 Clean the adapter with the foam swab. 

3 Dry the inside of the adapter with a clean, dry, foam swab. 

4 Blow through the adapter using filtered, dry, compressed air. 

Nitrogen gas or compressed dust remover can also be used. Do not shake, tip, or invert 
compressed air canisters, because this releases particles in the can into the air. Refer 
to instructions provided on the compressed air canister.
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